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Release Notes - January 2016

New features in Analysis Workspace (undo actions, “Save As” in segmentation, project linking, new
visualizations, and more). Cumulative Average Advanced function in Calculated Metrics (Analytics). Marketing
Cloud SSO (Report Builder). Admin notifications for property publishes (DTM). Private, un-branded data feeds
for Audience Marketplace (Audience Manager). General fixes and improvements in solutions.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date and is subject to change. Please check back at release time for
updates.

Release month: January 2016

Marketing Cloud 16.1

New features and fixes in the Adobe Marketing Cloud interface.

Feature Description

Audience Library messages We improved Audience Library to include helpful
messages when building audiences or when a
time-out occurs. For example, when adding more
than five rules, a message displays indicating you
exceeded maximum allowable rules. (MAC-27376,
MAC-27375)

® NOTE
Microsoft isending support for Internet Explorer 8, 9, and 10. As such, we will not fix issues
reported against these specific versions of Internet Explorer.

See Marketing Cloud Product Documentation for product help.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  1/21
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Adobe Mobile Services
Release date: January 21,2016

Feature Description

Overview page The Overview page now displays each user’s most
recently viewed apps instead of every app for your
Analytics company.

List variable support List variable management and reporting are now
supported in Mobile Services .

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

Dynamic Tag Management

The January 14, 2016 dynamic tag management release includes the following changes:

New Features

Feature Description

Admin natifications for property publishes Administrators can now receive an email
notification when one of their web properties is
published. The email contains the time and name
of the property.

Relative hostnames You can specify relative hostnames for staging and
production library hosting.

Nielsen tool You can enable Nielsen tracking using dynamic tag
management by creating the Nielsen tool and
configuring the page code either automatically or
manually. The automatic method is recommended
for most users.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar....
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Fixes and Improvements:

« Fixed an issue when using multiple custom event rules that caused only the first rule to fire. (DTM-7026)
 Fixed an issue that prevented the main library from loading for certain customers. (DTM-7130)

e Fixed an issue with Internet Explorer 9 that caused the Nielsen time-spent-on-page counter to remained
paused after the browser or browser tab loses and then regains focus. (DTM-7033)

¢ In Internet Explorer 8, the non-human detection mechanism in forms malfunctions. Because IE8 is no
longer supported this issue will not be fixed. Please upgrade your browser if this is an issue for you. (DTM-
7101)

See What's New in Dynamic Tag Management for current and cumulative release notes, help, and
documentation updates.

Marketing Cloud ID Service

Not updated in this release.

e New Features in Analytics

e Analytics Fixes

@® NOTE
With the July 2016 Maintenance Release, Ad Hoc Analysis will no longer support Java 6.

Analytics

New Features in Analytics
Release date: January 21,2016

Reports & Analytics Features Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  3/21
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Reports & Analytics Features Description
Update to the prodView event Update effective January 18

We updated the logic that sets the prodView event
automatically, which happens when there is a
product but no event . This update may cause an
increase in prodView events. prodViews will
increase only when:

1. The events variable contains nothing but an
unrecognized event, such as shoppingCart or
cart, which are not valid events.

2. The products variable is not empty.

A possible side effect is that merchandising eVars
triggered by prodView events could be associated
with an empty product, but only if the product list
contains only an invalid product (such as a
semicolon with no product listed). (AN-114143)

Report Suite ID Prefixes Report Suite ID prefixes are no longer changeable.
Customer Care or Account Managers can no longer
change prefixes or create report suites without
prefixes. More...

Calculated Metric Builder The Cumulative Average Advanced Function is now
available in the Calculated Metric Builder. More...

Create Segment/Create Metric Permissions If 3 user does not have Create Segment or Create
Metric permissions, they can no longer access the
Segment Builder or the Calculated Metric Builder.
More...

Estimate server calls and schedule spikes Lets you get last year's daily server call average
during a specific time frame, plus an expected
increase in server call volume for this year. You can
then schedule a traffic spike based on this
multiplication factor. More...
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https://experienceleague.adobe.com/docs/analytics/admin/manage-report-suites/new-report-suite/new-report-suite.html?lang=en
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Analysis Workspace Features

Undo Actions

Link to This Project

New Visualizations

Save As option in Analysis Workspace segments,
metrics, and dates.

Conditional Formatting

Release Notes - January 2016

Description

You can now undo most actions you take in
Analysis Workspace . More...

In a project, click More > Link to This Project to
email a saved project's URL to other users. (Some
exceptions apply.) More...

New visualizations include:

e Bullet Graph
e Scatterplot

e Treemap

More...

When editing an existing (saved) segment the
Analysis Workspace Segment Builder, click Save As
to make a copy. The new segment displays in the
Segments group in the Components panel. More...

In Column Settings , the new Conditional
Formatting option applies colors to cells, based on
data values:

e Green: high values

¢ Yellow: midpoint values

¢ Red: low values

More...

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  5/21
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Analysis Workspace Features

Dimension Preview

Legend Visible

Anchor Y Axis at Zero

Project Name on tab title

Add New Segment

Transfer projects in Admin Tools

Release Notes - January 2016

Description

In the Dimensions component panel, you can
hover over the information icon next to a
dimension and see a top-five dimensions preview.

More...

Added the Legend Visible option in Visualization
Settings , which shows or hides a visualization's
legend. More...

Depending on what the numbers are for Line and
Area charts, the bottom of the Y-axis might not be
zero. Enabling Anchor Y Axis at Zero in
Visualization Settings forces the Y-axis to zero, for a
more accurate view of trends. More...

When saving a project, the title on the browser tab
will be displayed as "&lt;Project Name&gt; -
Analysis Workspace". This enhancement is helpful if
you open multiple projects in multiple browser
tabs.

The Add New Segment button has been added to
the location where you drag-and-drop segments
onto a project. This enhancement is helpful if you
prefer to directly create segments when working in
a project, rather than using the Segment panel to
create segments.

Administrators can transfer Analysis Workspace
projects from one user to another.

Navigate to Admin Tools > User Management >
Transfer to transfer projects.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  6/21
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For more information about these features, see New Features in Analysis Workspace - January 2016.

For Analysis Workspace fixes, see Analytics Fixes.

Report Builder Feature Description

Single-Sign On Added support for Marketing Cloud Single Sign-On.

Analytics Fixes

Fixes were applied to the following products and services:

Product Fixes

Reports & Analytics
o Referrer Instances was changed so that the

system uses the first hit of a visit instead of
visit_page_num . visit_page_num does not
change across month boundaries when new
months are merged. (AN-89779)

o (AN-116415) Changed the way Microsoft Edge
browser versions display in reports, so that
they follow the releases for the underlying
EdgeHTML engine rather than the Edge
application. For example, reports will display
the expected naming of Edge 12 and 13 rather
than Edge 20 or 25.

o (AN-114795) Fixed issues that occurred when
the "My Recommended Reports" page pulls
up widgets items that come from the same
classification.

o (AN-114982) Fixed a time-zone-related issue in
Real-Time reports.

e (AN-114146) Fixed an issue with non-Admin
permissions in the reporting UL.

o (AN-114745 +AN-116383) Fixed an issue with
classifications setup that resulted in not being

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  7/21
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Product Fixes

able to access certain Analytics for Target
reports.

o (AN-114920) Fixed an issue where the "last
week" line on the Rea-Time reports Details
page was the same in all views, even when
clicking down to an individual page.

e (AN-115519) Fixed an issue in Analytics for
Target that caused the confidence metric to
always show "0" for every test in the Target
Activities report.

o (AN-113792) Fixed an issue with graphs not
aligning with selected date ranges.

o (AN-112854) Fixed an issue with inconsistent
segment previews that was related to time
zone differences.

e (AN-114796) Fixed an issue with unreadable
charts in dashboards.

e (AN-103917) Fixed an issue that prevented the
Delete button from showing up on the
Marketing Channels edit page for processing
rules.

e (AN-116951 + AN-113917) Fixed an issue that
prevented access to Mobile App data.

e (AN-115159) Fixed an issue that limited the
Next Page report to displaying only 10 pages.
o (AN-102095) Fixed an issue where processing

rules could not be saved with multi-byte
character sets.

e (AN-116040) Fixed issues with search, columns
and date ranges in the report log.

o (AN-93186) Fixed an issue with breakdowns
by Browser Type or Operating System Type.

e (AN-115887) Fixed an issue with shared
segment settings getting overwritten when
trying to share to a new person.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  8/21
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Product Fixes

Analysis Workspace Fixes .

(AN-113559) Fixed an issue with reverse
sorting in reportlets.

(AN-101851) Fixed an issue where, in trended
and overtime reports, only the first segment of
multiple segments was applied to the data.

(AN-114643) Fixed an issue that prevented the
reordering of new processing rules.

(AN-114158) Fixed an issue where any alerts for
the Browser Type Report were actually run
against the Browser Report .

(AN-115952) Fixed an issue where unique
event recording settings for Success Events
were not retained.

(AN-107567) Fixed an issue with the color
coding of calculated metrics. The color of the
change column on comparison reports in
Reports & Analytics is now colored (green or
red) based on the polarity setting for the given
metric.

(AN-116521) Fixed an issue where the user
interface response time was slowed down
when editing a lot of report suites.

(AN-113889) Known Issue: You cannot use
report linking (URLs) if your company uses
legacy single sign-on or logs in via the
Marketing Cloud. Also applies to Analysis
Workspace projects.

(AN-113537) Improved the interface to allow
for 1/3 and 2/3 sized widths for panels and
visualizations (previously, the interface
allowed 1/4 and 1/2 widths).

(AN-115625) Improved the Manage Data
Source menu by adding tool tips, names, and
hiding auto-created data sources.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---januar...  9/21



11/6/2020 Release Notes - January 2016

Product Fixes

(AN-114881) Improved project load timing and
added the ability to open more panels and
visualizations without a performance
reduction. Visualizations that depend on panel
data do not display before the project data
finishes loading.

(AN-114551) Improved the curation experience
by adding custom date ranges and metrics to
the right-click breakdown menu.

(AN-108368) Custom date ranges now display
with preset dates.

(AN-116852) Fixed an issue that enabled the
Add New Segment button for users without
permission to create segments.

(AN-116269; 116261) Fixed an issue that
enabled the Normalization option (in
Visualization Settings ) to display even if
normalization was not available.

(AN-116022) Fixed an issue causing the list of
recipients to be blank when opening a shared
project and clicking Share .

(AN-116890; AN-116888; AN-116269) Fixed
various chart rendering errors caused when
selecting rows in a freeform table.

(AN-115757) Fixed a scroll issue occurring in a
visualization's Manage Data Source menu. This
issue prevented you from selecting an
available data source.

(AN115624) Fixed an issue in the Cohort
Analysis panel, which prevented segment
criteria from being included in a segment
created using the Create Segment from
Selection method.

(AN-115592) Fixed a visualization rendering
issue preventing custom date ranges from
displaying in line charts, similar to how preset

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...
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Product Fixes

time dimensions display. Previously, an error
was issued in the visualization for custom date
ranges.

o (AN-115672) Fixed an issue preventing some
shared projects from displaying on the Project
Manager page.

» (AN-116082) Fixed an issue causing the wrong
currency symbol to display in some graphs.

o (AN-115951) Fixed an issue causing an
unexpected error to display when a project is
open and a timeout occurs.

o (AN-115493) Fixed an issue preventing
sparklines from displaying after saving and
reloading a project.

e (AN-115029) Fixed an issue in the Safari
browser that prevented you from changing a
visualization title.

o (AN-114970) Fixed an issue preventing some
shared projects from displaying in the project
list.

e (AN-114957) Fixed the Curation coach mark
tips so that they display for the correct
interface element and for properly
permissioned users.

o (AN-114312) Fixed an issue preventing you
from resizing a data table after un-hiding it
from the Managed Data Sources menu.

o (AN-114253) Fixed an issue causing bar graphs
in multiple static rows to disappear if you
delete a row.

e (AN-107079) Fixed an issue where no data
returned caused an unexpected error to occur
when creating a project.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua... 11/21
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Product

Report Builder

Ad Hoc Analysis Fixes

Data Warehouse

Release Notes - January 2016

Fixes

(AN-116875) The location of the Test & Target
report menu and that of the Target report
menu were switched. (“Test and Target”
contains legacy Target reports from an earlier
integration with Adobe Analytics , whereas
Target contains current Analytics for Target
reports.)

(AN-114365) Fixed an issue with Count Repeat
Instances.

(AN-114802) Fixed a permissions issue that
prevented dimensions from being visible.

(AN-115127) Fixed an issue with duplicate
months in Ad Hoc Analysis graphs.

(AN-92628) Fixed an issue with Ad Hoc
Analysis not working properly with Java 8.

Fixed an issue with Total Seconds Spent
values. They will no longer be reported as
negative when time-stamped hits are received
out of order.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...
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Product Fixes
AppMeasurement (Legacy and Mobile SDKs) AppMeasurement for JavaScript
Version 1.5.3

o (AN-115381) Fixed handling of Audience
Manager module when POSTs are used for
tracking calls.

o (AN-114647) Moved the rest of the page URL
("-g") to the end of the tracking request query
string.

o (AN-117104) Fixed handling of HREF and
ClickMap data tracking for manually tagged
links using the "stl()" method.

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e i0OS

¢ Android

o Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua... 13/21
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Audience Manager

Feature

Private, un-branded data feeds for Audience
Marketplace

Data feed discounts for Audience Marketplace

Fixes, Enhancements, and Deprecations

Description

A private, un-branded data feed allows a data
provider to hide the name of the seller and number
of traits from buyers who have not been approved
to view the feed or have not subscribed to the feed.

See Private Data Feeds for more information.

Data providers can discount the price of a data feed
for selected buyers.

See Discounts for Data Providers for more
information.

e Fixed a rule validation error in Trait Builder. (AAM-21372)

e Fixed an issue in Destination Builder that prevented you from editing the segments sent to a destination.

(AAM-21845)

e Fixed an issue in Audience Marketplace that prevented it from using the latest impression data to

determine fees in the billing report. (AAM-22342)

e Fixed an issue in Audience Marketplace that generated an unexpected error message window in the My

Shared Data section. (AAM-22545)

 Fixed an issue in the DIL API (v6.3) that prevented some values from being encoded in an event call.

New and Revised Documentation
New:

¢ Understanding the Data Provider Billing Report

¢ Understanding the Plan Details Page in Audience Marketplace

Revised:

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...
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e Trait and Segment Size Data in Segment Builder
e Outbound Template Macros

e Outbound Macro Examples

Social

Fixes
The fixes highlighted below describe resolutions for the more important customer-reported issues.
¢ Fixed an issue that prevent posts from updating properly in the Social Buzz and Posts by Display Name

reports. (AS-35600)

 Fixed an issue that caused incorrect data for new posts to display in the Competitor Analytics report. (AS-
35396)

¢ Fixed an issue that prevented campaign and tag information from displaying in the downloaded Posts
report if the post contained shortened links. (AS-35150)

 Fixed an issue that caused tags to disappear from the Posts Details report for some YouTube videos. (AS-
35110)

e Enhanced the search function for tags to allow “fuzzy” searches. For example, to find a tag named “Adobe
Social,” a user could type “Adobe” or “Social." (AS-35219)

e Fixed an issue that prevented users from editing misspelled tag names by pressing Backspace while
moving a tag from one group to another group. (AS-35788)

 Fixed an issue that prevented users from moving or merging tags. (AS-35753, AS-35712)

¢ Fixed an issue that prevented users from moving a large number of tags from one group to another
group. (AS-35724)

¢ Fixed an issue with the exported Moderation Overview report that caused tag IDs to display instead of tag
names. (AS-35454)

e Fixed an issue that caused an erroneous email notification to be sent to a user indicating that the user had
approved a post. (AS-35783)

 Fixed an issue that sometimes caused an error when geo-targeting Facebook posts by city. (AS-35711)

e Fixed an issue that caused Social to repeatedly prompt users to re-authorize an inactive LinkedIn account.
(AS-35661)

e Fixed an issue that caused users to receive an erroneous email message indicating that campaign tracking
failed. (AS-35655)

 Fixed an issue that caused missing post content in moderation feeds. (AS-35648)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua... 15/21
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¢ Fixed an issue that caused the wrong auto-notification email message to be sent for Facebook private
messages. (AS-34376)

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic
Advertising Cloud
Advertising Management help is available in the product at Help > Help Contents.
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:

Adobe Campaign Standard Release Notes

Adobe Campaign Standard Documentation

Adobe Campaign v6 Release Notes

Adobe Campaign v6 Documentation

Experience Manager

Adobe Experience Manager is an enterprise web content management system that lets you author, manage,
develop, and publish your web sites.

For product documentation, see:

o Release notes: Adobe Experience Manager 6.1 Release Notes
e Help home: Adobe Experience Manager Help Home

e Scene7 Publishing System: Scene7 Publishing System Release Notes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua... 16/21


https://experienceleague.adobe.com/docs/target/using/release-notes/release-notes.html?lang=en
https://docs.campaign.adobe.com/doc/standard/en/RN.html
https://docs.campaign.adobe.com/doc/standard/en/home.html
https://support.neolane.net/doc/AC6.1/en/RN.html
https://support.neolane.net/doc/AC6.1/en/home.html
https://docs.adobe.com/docs/en/aem/6-1/release-notes.html
https://docs.adobe.com/
https://experienceleague.adobe.com/docs/dynamic-media-developer-resources/release-notes/s7rn2017.html?lang=en

11/6/2020

Release Notes - January 2016

¢ AEM Assets on Demand: Release Notes

Key Documentation Updates

Noteworthy documentation additions and updates in the Adobe Marketing Cloud.

Item

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...

Description

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

Date Published

January 21, 2016

September 17, 2015

September 17, 2015

September 17, 2015
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Item

Data Workbench 6.5 Update

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...
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Description

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

Date Published

September 17,2015

August 20, 2015

August 20, 2015

June 18, 2015
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Item

Freeform Analysis (public beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core
Services

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...

Release Notes - January 2016

Description

A feature in Analysis Workspace,
freeform analysis lets you built
data tables and drag-and-drop
metrics, dimensions, segments,
and multiple visualizations to a
project panel.

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for

core services.

Date Published

June 18, 2015

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015
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Item

Customer Attributes

Analytics Spring Release

Analytics Classification Rules -
overwrite existing values

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/01212016.html?lang=en#release-notes---janua...

Release Notes - January 2016

Description

If you capture enterprise
customer data in a customer
relationship management (CRM)
database, you can upload that
data into the Marketing Cloud.

See the New Features section in
Analytics for a round-up of new
documentation for the Spring
2015 Analytics release.

In Admin Tools > Classification
Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

Date Published

March 19, 2015

March 19, 2015

February 19, 2015
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Documentation > Release Notes Guide > Release Notes - February 2016

Release Notes - February 2016

Marketing Cloud: New features include improvements to Marketing Cloud Assets, and an improved workflow
for linking solution accounts to your Adobe ID. Adobe Mobile: Updates to Apteligent and appFigures
integrations. Analytics: New Real-Time Report permission configuration in Admin Tools. Audience Manager:
Deactivate Data Feeds in Audience Marketplace. Experience Manager: service packs and hotfixes. Plus, general

fixes and improvements for the February maintenance release.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date and is subject to change. Please check back at release time for
updates.

Release date: February 2016

Marketing Cloud 16.2

New features and fixes in the Adobe Marketing Cloud interface.

Release date: February 18, 2016

Feature Description

Marketing Cloud Assets improvements In Marketing Cloud Assets, you can store, share,
and synchronize your digital assets from one
central location. Marketing Cloud Assets leverages
some of the features available in Adobe Experience
Manager (AEM).

See Marketing Cloud Assets .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 1/22
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Feature Description

Account linking improvements Improved the interface workflow for linking
solution accounts with the Marketing Cloud (Adobe
ID). This new workflow locates all of the user's
accounts associated with an organization, and lets
you choose which account to link. We also
streamlined the account linking experience, so that
you no longer need to access the Manage
Organizations page to manually link accounts.

Fixes

¢ Fixed an issue preventing linking and SSO for Analytics. This issue displayed the “Notice: The error
message: ERROR IMS SSO Failed: Unable to find linked company.”

Known Issue

If you access Dynamic Tag Management via the Marketing Cloud > Activation interface, but your Dynamic Tag
Management account is not linked to the Marketing Cloud (Adobe ID), you will not be able to log in to
Dynamic Tag Management. To avoid this issue, navigate directly to https://dtm.adobe.com in a new browser
tab.

Adobe Mobile Services

The Mobile Services February 18, 2016 release includes the following changes:

New Features

Resource Description

Apteligent Integration: Crashes report You can view a Crashes report for apps that have
been integrated with Apteligent.

report

appFigures integration: App Store Overview The user interface for the App Store Overview

report report has been updated for apps that have been
integrated with appFigures.

report

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 2/22
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See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand

Previous Release Notes in the left pane.

The Android SDK version 4.8.3 (February 18, 2016) includes the following changes:

Feature Description

Opt-out and privacy settings Starting with Android SDK 4.8.3, privacy settings set
via the setPrivacyStatus method affect activity from

Analytics , Target, and Audience Manager .

The iOS SDK version 4.8.5 (February 18, 2016) includes the following changes:

Feature Description

Opt-out and privacy settings Starting with iOS SDK 4.8.5, privacy settings set via
the setPrivacyStatus method affect activity from
Analytics, Target , and Audience Manager .

Analytics

Important Notices about Analytics

A IMPORTANT
The following table provides Analytics notifications about issues that may affect data collection

and reporting, product end-of-life, and so on.

Notice Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 3/22
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Notice

Elimination of hashed values in Data Feeds

Web Services v 1.2 API end-of-life

Release Notes - February 2016

Description

In certain circumstances, hashed values (
::hash::&lt;hash value&gt; ) may appear in data
feeds for the following types of variables:

e Merchandising eVars in post_product_list

e List Vars (called post_mvvari-3, post_tnt, and
post_survey )

e Marketing Channel details. The tracking code
for the Marketing Channels reports (called
va_finder_detail and va_closer_detail )

A change is being implemented that eliminates
hashed values over time, and replaces them with
actual values.

Note: The max size of any particular value is 100
bytes or 255 bytes. For fields that support multiple
values, such as post_product_list and List Vars, the
max size of those fields is 64k. Therefore, if you are
passing in a large number of values, some of the
values may be lost as the field will be truncated at
64k.

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 API requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404 error. Customers have until the end-of-
life date to upgrade from the version 1.2 API to the
version 1.4 API to prevent an outage in their API
applications.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Notice

SSLv3

UK Postal Code

New Features in Analytics

Feature

February 24, 2016: Accelerated Mobile Pages

Release Notes - February 2016

Description

As of early Feb 2016, Adobe Analytics no longer
supports SSLv3. This change impacts Report
Builder, data collection requests, and requests to
the Analytics Web Services APIs.

Adobe's geo service provider is changing how we
receive UK postal codes. We will be switching from
providing truncated UK postal codes to full postal
codes on or around March 18th.

Description

Adobe is participating in the Accelerated Mobile
Pages (AMP) Project. AMP is an open source
project that lets you build web pages for static
content that renders quickly. This feature is ideal for
publishers who want to create mobile-optimized
content once, and have it load instantly
everywhere.

Note: This project does not affect reporting results.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Feature Description

Real-Time Report Configuration permission A new Admin Console permission has been added:
Real-Time Report Configuration.

To configure real-time reports, you must either a)
be an Admin, or b) belong to a group that has All
Access permission for Admin Tools, or ¢) have the
new Real-Time Report Configuration permission.

Other users, including those with the All Report
Access permission, cannot configure real-time
reports. For those users, the Configure button will
not be available in the Real-Time reporting
interface.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 6/22
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Feature Description
Alert: Data Processing change between February Sometime between the February and March
and March MRs Maintenance Releases, the following Analytics data

processing change will be implemented:

Previously, when using the Product variable
without having an event set, the event would
default to "ProdView", set early in processing
(before processing rules take effect). The event is
now set after the processing rules to avoid conflicts
with how mobile data processing works. This
change has the following downstream effects:

¢ ProdViews will no longer be inflated because
of hits where context data is generating events
(especially in Mobile). Going forward, an event
will be set at the time in data processing when
the ProdView would have been set (without a
set event.)

¢ Any VISTA rule that has logic depending on a
ProdView event being set on a hit might need
to be reviewed to see if changes to the VISTA
rule are needed. This is because ProdView
events might be set on fewer hits than they
previously were, because ProdView is set
earlier in the processing pipeline. This change
may or may not impact what is desired from

the VISTA rule.
Analytics Fixes
Fixes were applied to the following products and services:
Product Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 7122
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Product

Reports & Analytics Fixes

Release Notes - February 2016

Fixes

Fixed an issue in Real-Time reports: due to
time zone issues, the Today graph was
showing zeros despite there being a number
of instances. (AN-114982)

Fixed a user management/reset password
issue where the administrator logging in with
Marketing Cloud credentials resulted in an
error. (AN-108518)

Fixed a segmentation issue where the
“Browser Width - Granular” dimension was not
compatible with Data Warehouse . (AN-
115465)

Fixed an issue with deleted calculated metrics
showing up in a report suite download but not
in the Calculated Metric Manager . (AN-
116958)

Fixed an issue that caused the Pages Report to
show duplicate metrics. (AN-117793)

Fixed an issue that caused segment previews
to be inconsistent between the Segment
Builder and when viewing segment
information within reports. This happened in
the Firefox browser only, and after changing
the operating system's time zone. (AN-112854)

Fixed an issue that caused scheduled
dashboards to be delivered to the Junk email
folder. (AN-117157)

Fixed an issue that caused processing rules to
not be saved. (AN-115916)

Fixed an issue with custom traffic (prop)
reports that resulted in an error message
asking customers to upgrade their bookmarks.
(AN-104560)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Product Fixes

Analysis Workspace Fixes
e Improved the Undo feature so that it is

available for cell selections.

¢ Fixed an issue preventing projects from
opening. This issue might have occurred on
projects with more than ten columns in a data
table. (AN-118259)

 Fixed an issue that allowed users without
create segment permissions to edit a segment
that was created using Copy . (AN-117762)

¢ Fixed a panel size issue occurring when
deleted panels are restored using Undo . (AN-
117743)

¢ Fixed an issue preventing shared date ranges
from being available to other users. (AN-
117637)

e Fixed a issue occurring in Firefox, which
prevented you from manually entering the
report date. (AN-117595)

e Fixed an issue where deleting a breakdown on
a segment deleted the segment. (AN-115941)

¢ Fixed an issue preventing components from
being available or modified. This issue
occurred only after curating the components,
then re-authenticating. (AN-118499)

Ad Hoc Analysis Fixes ¢ Fixed an issue that prevented metrics,
dimensions, and segments from loading when
the locale was set to English (International). (
AN-118055)

¢ Fixed an issue with not being able to schedule
reports. (AN-116527)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 9/22
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Product

Data Warehouse Fixes

AppMeasurement (Legacy and Mobile SDKs)

Release Notes - February 2016

Fixes

e Fixed an issue with Data Warehouse
scheduled reports not getting delivered. (AN-
118182)

¢ Fixed an issue where Data Warehouse
reporting was not correctly classifying eVars
76+. (AN-118867)

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e iOS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

¢ Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 10/22
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Product Fixes

Analytics Web Services (SOAP and REST APIs) Note: Version 1.2 of the Web Services APl was
officially deprecated on February 20, 2014. It will
reach end-of-life on September 15, 2016. At that
time, Adobe will remove the ability of the API
servers to respond to version 1.2 API requests. Any
API requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404. Customers have until the end-of-life
date to upgrade from the version 1.2 API to the
version 1.4 API to prevent an outage in their API
applications.

Audience Manager

Feature Description

Deactivating Data Feeds in Audience Marketplace Audience Marketplace data providers can revoke
buyer access to a subscribed feed. For information
about how sellers revoke feeds and what happens
to buyers see:

¢ Deactivate a Subscriber's Data Feed

¢ What Happens After a Provider Deactivates
My Data Feed

Fixes, Enhancements, and Deprecations
Fixes:

 Fixed an API but that exposed provider IDs in unbranded data feeds. Affected source and trait APIs. (AAM-
22430)
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¢ Fixed a bug that prevented Tableau report accounts from being deleted when a user’s account was
removed. (AAM-16048)

« In Destinations ( Segment Mapping section), fixed a bug that prevented you from changing segment
priority. (AAM-22942)

« Fixed a bug that allowed users without Admin permissions to create a profile merge rule. (AAM-22433)
Enhancements:

 In Segment Builder ( Code View section), changed the trait list column label to Segment ID from Trait ID.
(AAM-15950)

« In Profile Merge, revised warning message to indicate that users can select Profile Link Device Graph with
the current and last authenticated options. (AAM-22521)

* In the Data Source Details, changed an ID Type option to Device Advertising ID from Mobile. (AAM-
22947)

New and Revised Documentation

Revised:

DCS Error Codes, Messages, and Examples

Name and Content Requirements for ID Synchronization Files

Amazon S3 Name Requirements for Inbound Data Files

FTP Name Requirements for Inbound Data Files

Social

New features and fixes in the Adobe Social16.2.1.0 release (2/18/2016).

New Features

Feature Description
Phase 2: LinkedIn rich media You can now attach images to LinkedIn posts using
Adobe Social .
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Fixes
The fixes highlighted below describe resolutions for the more important customer-reported issues.
 Fixed an issue in the Social Buzz report that prevented data from updating and displaying properly. (AS-

35600)

e Fixed an issue in the Post Analytics report that caused links and attachments to display in HTML format
rather than as text links as expected. (AS-35825)

e Fixed an issue that prevented the Property filter in the Post Analytics report from functioning properly.
(AS-35792)

¢ Fixed an issue in the Post Details report that displayed the incorrect number of comments for LinkedIn
posts. (AS-35791)

 Fixed an issue that caused the error message to not adequately explain the reason for a failed post. In
some cases, “#" was the only text in the error message. (AS-35576)

e Fixed an issue that caused tags for LinkedIn posts to not display in the Posts report.
 Fixed an issue in the Properties Overview report that caused Posts data to not display. (AS-35544)

 Fixed an issue that sometimes caused the Escalate button to not be visible during the moderation
escalation workflow. (AS-35876)

 Fixed an issue that prevented a Hide option from working properly during the moderation workflow. (AS-
35869)

e Fixed an issue that prevented Social moderation rules from removing posts that contain words in the Bad
Words list from Facebook pages. (AS-35461)

¢ Fixed an issue that caused moderation feeds to be delayed or to not pull in all relevant posts as defined in
the feed rules. (AS-35451)

e Fixed an issue that caused the incorrect sentiment scores to display in moderation feeds. (AS-35149)

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest recommended patches in
order to ensure higher stability, security and performance.
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Service Packs

Service Packs Description

AEM 6.1 Service Pack 1 AEM 6.1 Service Pack 1is an important update that
includes performance, stability, security and key
customer fixes and enhancements released since
the general availability of AEM 6.1 in May 2015. SP1
can be installed on AEM 6.1 GA.

The overview on this page lists the changes added
with SP1. Some of the key highlights of the service
pack are:

e The built-in repository (Apache Jackrabbit
0ak) is updated to version 1.2.7.

¢ Includes touch-optimized Ul update pack
(Feature Pack 6563) for AEM 6.1.

¢ Includes critical fixes for Adobe Target
Integration.

Release Notes

Package Share Download

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 14/22


https://docs.adobe.com/docs/en/aem/6-1/release-notes-sp1.html
https://www.adobeaemcloud.com/content/marketplace/marketplaceProxy.html?packagePath=/content/companies/public/adobe/packages/cq610/servicepack/AEM-6.1-Service-Pack-1

11/6/2020

Service Packs

AEM 6.0 Service Pack 3

Hotfixes

Hotfixes

AEM 6.1 hotfixes

AEM 6.0 hotfixes

AEM 5.6.1 hotfixes

Release Notes - February 2016

Description

AEM 6.0 Service Pack 3 (SP3) is an important
update that includes security, performance,
stability, and key customer fixes and enhancements
released since the general availability of AEM 6.0 in
May 2014. Service Pack 3 contains all changes
introduced with Service Pack 2. It can be installed
on AEM 6.0 GA, AEM 6.0 SP1 and AEM 6.0 SP2.

The overview section on this page lists the changes
added with SP3. The included changes from SP2
are listed in the Service Pack 2 release notes .

The following are some key highlights of the
service pack:

e The built-in repository (Apache Jackrabbit
Oak) updated to version 1.0.22.

e It replaces Sling JCR Classloader with File

System Classloader

Release Notes

Package Share Download

Description

List of recommended hotfixes for AEM 6.1.

List of recommended hotfixes for AEM 6.0.

List of recommended hotfixes for AEM 5.6.1.
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Latest Self-Help Content Updates

Self-Help Updates

CRX20AK migration tool

Integrating AEM with Adobe Campaign

Authoring Targeted Content

Touch Ul - Authoring FAQ

Touch Ul - Troubleshooting Guide

Touch Ul - Using custom xtypes

AEM with MongoDB

Best Practices for Queries and Indexing

Release Notes - February 2016

Description

CRX20ak is a tool designed to migrate data
between different repositories.

Adobe Campaign is a set of solutions that lets you
personalize and deliver campaigns across all of
your online and offline channels.

Author targeted content using Targeting mode of
the AEM touch-optimized UI.

Frequently asked questions for Touch Ul authoring.

Tips and tools that help troubleshooting Touch Ul
related issues.

Using custom xtypes in Adobe Experience Manager
6 Touch UL.

Improve your knowledge on tasks and
considerations needed to successfully deploy
Adobe Experience Manager with MongoDB.

When to create indexes as well as when they are
not needed, tricks to avoid using queries when they
are not necessary, and tips for optimizing your
indexes and queries to perform as optimally as
possible.
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Self-Help Updates Description

Multi Site Management Use Multi Site Manager (MSM) to use the same site
content in multiple locations.

For product documentation, see:

» Release notes: Adobe Experience Manager 6.1 Release Notes
e Help home: Adobe Experience Manager Help Home
e Scene7 Publishing System: Scene7 Publishing System Release Notes

e AEM Assets on Demand: Release Notes

Advertising Cloud

Advertising Management help is available in the product at Help > Help Contents.
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:

e Adobe Campaign Standard Release Notes
e Adobe Campaign Standard Documentation
¢ Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Recent Documentation Updates

Noteworthy documentation additions and updates in the Adobe Marketing Cloud from past releases.

Item Description Date Published

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 17/22


https://docs.adobe.com/docs/en/aem/6-1/administer/sites/msm.html
https://docs.adobe.com/docs/en/aem/6-1/release-notes.html
https://docs.adobe.com/
https://experienceleague.adobe.com/docs/dynamic-media-developer-resources/release-notes/s7rn2017.html?lang=en
https://docs.adobe.com/content/docs/en/aod/overview/release-notes.html
https://docs.campaign.adobe.com/doc/standard/en/RN.html
https://docs.campaign.adobe.com/doc/standard/en/home.html
https://support.neolane.net/doc/AC6.1/en/RN.html
https://support.neolane.net/doc/AC6.1/en/home.html

11/6/2020

Item

Accelerated Mobile Pages

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

(Updated) Users and Groups

Release Notes - February 2016

Description

Adobe is participating in the
Accelerated Mobile Pages (AMP)
Project. AMP is an open source
project that lets you build web
pages for static content that
renders quickly. This feature is
ideal for publishers who want to
create mobile-optimized content
once, and have it load instantly

everywhere.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Date Published

February 24, 2016

February 18, 2016

February 11,2016

January 21, 2016

September 17,2015
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Item

Analysis Workspace

Timestamps Optional

Data Workbench 6.5 Update

Select Report Suites and
Variables

Release Notes - February 2016

Description

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Date Published

September 17, 2015

September 17, 2015

September 17, 2015

August 20, 2015

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Item

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Freeform Analysis (public beta)

Data Workbench 6.4

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Description

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

A feature in Analysis Workspace,
freeform analysis lets you built
data tables and drag-and-drop
metrics, dimensions, segments,
and multiple visualizations to a
project panel.

Data Workbench 6.4 release
includes several new features
described here.

Date Published

August 20, 2015

June 18, 2015

June 18, 2015

June 18, 2015

20/22


https://marketing.adobe.com/resources/help/en_US/aam/profile-link-intro.html
https://experienceleague.adobe.com/docs/analytics/components/calculated-metrics/cm-overview.html?lang=en
https://experienceleague.adobe.com/docs/analytics/analyze/analysis-workspace/home.html?lang=en
https://marketing.adobe.com/resources/help/en_US/insight/whatsnew/
https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2015/06182015.html?lang=en#features_analytics_premium

11/6/2020

Item

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - February 2016

Description Date Published

Added Adobe Managed
Certificate Program to the

May 22, 2015

revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

May 22, 2015

A high-level round-up what you March 19, 2015
need to do to modernize your
solution implementations for

core services.

If you capture enterprise March 19, 2015
customer data in a customer

relationship management (CRM)

database, you can upload that

data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous
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Item Description Date Published
Analytics Classification Rules - In Admin Tools > Classification February 19, 2015
overwrite existing values Rule Builder > &lt;rule set

name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/02182016.html?lang=en#previous 22/22
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Documentation » Release Notes Guide » Release Notes - March 2016

Release Notes - March 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date and is subject to change. Please check back at release time for

updates.

Experience Cloud

Release notes for the Experience Cloud and core services.

Adobe Mobile Services (March 9, 2016)
The iOS SDK version 4.8.6 (March 9, 2016) includes the following changes:

Feature Description

Track app crashes The iOS SDK version 4.8.6 contains critical changes
that prevent false crashes from being reported. We
highly recommend that you update to version 4.8.6.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

Marketing Cloud ID Service
March 17,2016

Version 1.5.4 includes the following changes:

Feature Description

Opt-out support The Marketing Cloud ID service supports visitor
opt-out requests. (AAM-21725)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 1/20
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Feature Description

Change ID synchronization interval The Marketing Cloud ID service now makes ID
synchronization calls on every call to the data
collection servers. Previously, the ID service made
only 1 request on the first call to get a Marketing
Cloud ID. (AAM-22934)

Documentation

Revised ID service implementation procedures for Analytics customers. See Set Up the Marketing Cloud 1D

Service with Analytics.
March 17,2016

e Important Notices about Analytics

e Analytics Fixes

Analytics

Important Notices about Analytics

A IMPORTANT
The following table provides Analytics notifications about issues that may affect data collection

and reporting, product end-of-life, and so on.

Notice Date Added Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 2/20
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Notice Date Added Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 3/20
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Notice

Date Added

Release Notes - March 2016

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous
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Notice Date Added Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

e Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 5/20
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Notice Date Added Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

SSL v3 February 18, 2016 As of early Feb 2016, Adobe
Analytics data collection and
reporting APIs no longer
supports SSL v3.

UK Postal Code February 18, 2016 Adobe's geo service provider is
changing how we receive UK
postal codes. We will be
switching from providing
truncated UK postal codes to full
postal codes on or around March
18th.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 6/20
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Notice Date Added Description
Changes to backdating of October 15, 2015 For report suites with timestamp
session information data, backdating will no longer

create a visit, as described in
Compare Visits and Mobile App
Launches (published October
2015).

Analytics Fixes
Fixes were applied to the following products and services:

Product Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 7120
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Product Fixes

Reports & Analytics
¢ Fixed an issue that prevented the creation or

editing of processing rules. (AN-118939)

¢ Fixed an issue where the password could not
be reset for user names that are longer than
20 characters. (AN-115603)

¢ Fixed an issue with Contribution Analysis that
caused drill-down panel labels to be
duplicated. (AN-118627)

¢ Fixed an issue with dashboard reportlets that
were not showing data when daily granularity
was selected. (AN-117755)

¢ Fixed an issue with the Thousands separator
setting reverting back to the US format (from a
German format). (AN-117894)

¢ Fixed an issue that prevented the Visitor
Profile > Technology > Cookies report from
running. As a result of this fix, we removed the
Show Internet Average checkbox in User
settings and disabled the feature on traffic
reports.

Analysis Workspace Fixes
¢ Fixed an issue occurring when dragging and

dropping components one after another too
quickly. This issue caused the black drop
indicators to persist in the table if you dragged
a component while another request was still
processing. (AN-118836)

¢ Fixed localization for the Project Info window
name. (AN-118612)

¢ Fixed an issue causing visualizations to reset
their position when a project is refreshed, in
rare circumstances. (AN-115865)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 8/20
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Product Fixes

Ad Hoc Analysis Fixes
¢ Fixed an issue with not being able to open Ad

Hoc Analysis when launching it from the
Adobe Marketing Cloud with an Adobe ID.
(AN-102875)

AppMeasurement (Legacy and Mobile SDKs) JavaScript version 1.5.4

e Inclusion of Visitor APl 1.5.4 .

o Support for Visitor API 1.5.4+ opt-out.

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e iOS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET
e BlackBerry

e Java

e PHP

¢ Symbian

Fixes, Enhancements, and Deprecations

e Fixed a bug that cased Trend reports to show results a day off from the current date. Affects Eastern
European time zones only. (AAM-22321)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 9/20


https://marketing.adobe.com/resources/help/en_US/sc/appmeasurement/release/index.html

11/6/2020 Release Notes - March 2016

e Fixed a bug in Audience Marketplace that prevented data providers from activating a private, unbranded
data feed. (AAM-23377)

e Changed ID type option in the data source creation workflow to “Device Advertising ID" (from “Mobile”).
(AAM-22947)

e Added mathcesword , @ new named operator that helps build trait rules without the complexity of regular
expressions. (AAM-22368)

New Features

Feature Description

Publish Anywhere You can now expand the Publish Anywhere
interface to full-screen mode to allow yourself
more room to create, edit, and review your posts.

Fixes
The fixes highlighted below describe resolutions for the more important customer-reported issues:
e Fixed an issue that prevented some tweets from being collected and displayed in the Post Analytics
report.

¢ Fixed an issue that prevented some metrics from displaying in the Properties report.

¢ Fixed an issue that prevented the 1_documents.xlsx file from being included in the zip file after exporting
data from the Social Buzz report.

¢ Fixed an issue that caused Social to send repeated bulk email messages when using auto-moderation
rules.

e Fixed a Ul issue so that posts in moderation feeds with long links contain horizontal scroll bars.

¢ Fixed an issue that prevented some posts from displaying in escalation moderation feeds.

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Advertising Cloud

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 10/20
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Advertising Management help is available in the product at Help > Help Contents.
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:

Adobe Campaign Standard Release Notes

Adobe Campaign Standard Documentation

Adobe Campaign v6 Release Notes

Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest recommended patches in
order to ensure higher stability, security, and performance.

AEM Assets Forum Description

AEM Assets Forum Our new AEM Assets sub-forum is now live. This
forum covers: Assets (on premise), Assets on
Demand, Brand Portal, Dynamic Media and Scene7.
Anyone is free to login and post, just sign in with
your Adobe ID.

Conference Description

Adobe Immerse Immerse is a virtual Adobe Experience Manager
developer conference April 25-29. This event is a
“must attend” for anyone responsible for the
design, development, deployment or maintenance
of Adobe Experience Manager implementations.
For tickets & details please see the Adobe Immerse
website.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 11/20
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Dispatcher Description
Dispatcher 4112 A new Dispatcher release is available for download.
Hotfixes Description
AEM 6.1 hotfixes List of recommended hotfixes for AEM 6.1, including

OAK 1.2.11 hotfix.

AEM 6.0 hotfixes List of recommended hotfixes for AEM 6.0. OAK
1.0.27 is now available for download.

AEM 5.6.1 hotfixes List of recommended hotfixes for AEM 5.6.1.
Security bulletins Description

APSB16-05 Security bulletin for Adobe Experience Manager.
Service packs Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 12/20
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Service packs Description

AEM 6.1 Service Pack 1 AEM 6.1 Service Pack 1is an important update that
includes performance, stability, security and key
customer fixes and enhancements released since
the general availability of AEM 6.1 in May 2015. SP1
can be installed on AEM 6.1 GA.

The overview on this page lists the changes added
with SP1. Some of the key highlights of the service
pack are:

e The built-in repository (Apache Jackrabbit
0ak) is updated to version 1.2.7.

¢ Includes touch-optimized Ul update pack
(Feature Pack 6563) for AEM 6.1.

¢ Includes critical fixes for Adobe Target
Integration.

Release Notes

Package Share Download

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 13/20
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Service packs

AEM 6.0 Service Pack 3

Latest Self-Help Content Updates

Self-help updates

CRX20AK migration tool

Release Notes - March 2016

Description

AEM 6.0 Service Pack 3 (SP3) is an important
update that includes security, performance,
stability, and key customer fixes and enhancements
released since the general availability of AEM 6.0 in
May 2014. Service Pack 3 contains all changes
introduced with Service Pack 2. It can be installed
on AEM 6.0 GA, AEM 6.0 SP1 and AEM 6.0 SP2.

The overview section on this page lists the changes
added with SP3. The included changes from SP2
are listed in the Service Pack 2 release notes .

The following are some key highlights of the
service pack:

e The built-in repository (Apache Jackrabbit
Oak) updated to version 1.0.22.

e It replaces Sling JCR Classloader with File
System Classloader

Release Notes

Package Share Download

Description

CRX20ak is a tool designed to migrate data
between different repositories.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous 14/20
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Self-help updates

Integrating AEM with Adobe Campaign

Authoring Targeted Content

Touch Ul - Authoring FAQ

Touch Ul - Troubleshooting Guide

Touch Ul - Using custom xtypes

AEM with MongoDB

Best Practices for Queries and Indexing

Multi Site Management

For product documentation, see:

Release Notes - March 2016

Description

Adobe Campaign is a set of solutions that lets you
personalize and deliver campaigns across all of
your online and offline channels.

Author targeted content using Targeting mode of
the AEM touch-optimized Ul.

Frequently asked questions for Touch Ul authoring.

Tips and tools that help troubleshooting Touch Ul
related issues.

Using custom xtypes in Adobe Experience Manager
6 Touch UL.

Improve your knowledge on tasks and
considerations needed to successfully deploy
Adobe Experience Manager with MongoDB.

When to create indexes as well as when they are
not needed, tricks to avoid using queries when they
are not necessary, and tips for optimizing your
indexes and queries to perform as optimally as
possible.

Use Multi Site Manager (MSM) to use the same site
content in multiple locations.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous
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¢ Release notes: Adobe Experience Manager 6.1 Release Notes

* Help home: Adobe Experience Manager Help Home

e Scene7 Publishing System: Scene7 Publishing System Release Notes

e AEM Assets on Demand: Release Notes

Recent documentation updates

Item

Accelerated Mobile Pages

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

Description

Adobe is participating in the
Accelerated Mobile Pages (AMP)
Project. AMP is an open source
project that lets you build web
pages for static content that
renders quickly. This feature is
ideal for publishers who want to
create mobile-optimized content
once, and have it load instantly
everywhere.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Added documentation for new
features in Analysis Workspace.

Date Published

February 24, 2016

February 18, 2016

February 11, 2016

January 21,2016

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous
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Item

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Data Workbench 6.5 Update

Release Notes - March 2016

Description

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use

cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Date Published

September 17,2015

September 17, 2015

September 17,2015

September 17, 2015

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous
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Item

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Freeform Analysis (public beta)

Release Notes - March 2016

Description Date Published

Updated the Classification Rule
Builder so that you add report

August 20, 2015

suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross- August 20, 2015
device data sources to identify

and collect traits for

authenticated site visitors. It

includes the Profile Merge Rules

feature, which lets you segment

and target users accurately

across multiple devices.

Calculated Metrics now allow for  June 18, 2015
segmented metrics, more

advanced math and the ability to

organize and share metrics.

A feature in Analysis Workspace,  June 18,2015
freeform analysis lets you built

data tables and drag-and-drop

metrics, dimensions, segments,

and multiple visualizations to a

project panel.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous
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Item

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - March 2016

Description

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for

core services.

If you capture enterprise
customer data in a customer
relationship management (CRM)
database, you can upload that
data into the Marketing Cloud.

See the New Features section in
Analytics for a round-up of new
documentation for the Spring
2015 Analytics release.

Date Published

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015

March 19, 2015

March 19, 2015
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Item

Analytics Classification Rules -

overwrite existing values

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/03172016.html?lang=en#previous

Release Notes - March 2016

Description

In Admin Tools > Classification
Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

Date Published

February 19, 2015
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Documentation > Release Notes Guide > Release Notes - April 2016

Release Notes - April 2016

Learn about the Adobe Marketing Cloud Spring 2016 release, including single-click navigation between
solutions, new notifications widget, a redesigned Feed and more. Analytics features include the new Activity
Map, virtual report suites, Analysis Workspace project scheduling and downloading, and Data Workbench 6.6.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date and is subject to change. Please check back at release time for

updates.

Updated April 21, 2016

A IMPORTANT
Login notice for Recommendations Classic and Search&Promote users. In the updated Marketing
Cloud interface, you can access those links from the Analytics > Tools menu.

Experience Cloud

Marketing Cloud Interface

New features and fixes in the Adobe Marketing Cloud interface.

Release date: April 21,2016

Features Description

Simplified menu bar with streamlined navigation As part of the Adobe Marketing Cloud Spring 2016
release, a new-top level simplified navigation menu
displays at the top of all solution interfaces.

 Single-click navigation between solutions.

e Choose your own default landing page (in Edit
Profile).

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous 1/37
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Features

Improved notifications

Updated Feed

Release Notes - April 2016

Description

Get notified about events (like posts, mentions,
assets shared, system updates) happening across
your organization navigation widget.

We reimagined the Feed page to become a better
platform for cross-channel collaboration between
marketers.

See What's New in the Marketing Cloud - Spring 2016 for more information.

Adobe Mobile Services

The Mobile Services March 21, 2016 release includes the following changes:

Resource
Acquisition tracking enhancements

Note: Coming Soon!

Description

Create marketing links that send users to download
apps from the appropriate app store and to in-app
deep links. Marketers can attribute downloads, app
relaunches, and other in-app events to these links
to understand how to optimize acquisition
channels.

Enhancements Include:

e Link Manager: A new interface in the app
settings section lets users manage web, app
deep, and other link destinations. These
destinations can be called in workflows
relating to acquisition tracking links and to in-
app or push messages.

e Marketing Links Builder: A new graphical and
intuitive user interface helps users build
tracking links. Marketers can choose decisions
and destinations that best serve their users.

e Tracking links are created and saved in
the Ul. Marketers can change link

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous 2/37
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Resource Description

destinations or tracking meta data even
after the links are deployed.

e Links can device-detect on OS, OS
version, and form-factor.

o Marketers can choose a destination for
tracking links that routes users to a
fallback destination to preserve the
integrity of the landing experience.

¢ Links can contain token-replaceable
parameters.

e Tracking links can contain Adobe-hosted
and configurable interstitials.

Messaging enhancements Destinations for In-App and Push Messaging
Note: Coming Soon!

To enhance authoring convenience, marketers can
choose a “destination” URL to call a saved web or
app deep link from links saved in the Link Manager
or they can provide a link in-line.

e Manually enter a custom web link or deep
link.

¢ Choose a stored web or deep link stored in
Link Manager .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous

3/37



11/6/2020 Release Notes - April 2016

Resource Description

Push Notifications:

e Custom Push Payload: Marketers can provide
a custom push payload in JSON (4KB limit) to
be sent to the app via a push or a local
notification.

o Category & Sound (iOS only):
Marketers can provide a category and a sound
resource for push and local notifications.

Marketing Cloud navigation and menu changes As part of the Adobe Marketing Cloud Spring 2016
release, a new-top level navigation menu displays
at the top of all solution interfaces. The new
interface lets you:

¢ Single-click navigation between solutions:
Choose your own default landing page or take
advantage of the solution-switcher widget.

¢ Improved notifications: Get notified about
events (like posts, mentions, assets shared,
system updates) happening across your
organization navigation widget.

¢ Updated Feed: We reimagined the Feed page
to become a better platform for cross-channel
collaboration between marketers.

See What's New in the Adobe Marketing Cloud -
Spring 2016 in the Marketing Cloud and Core
Services Product Documentation.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.
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Marketing Cloud ID Service

There are no customer-facing changes in this release. The version (v1.4.5) remains the same.
Documentation Update

Documentation includes new procedural content for Target. See Implement the Marketing Cloud ID Service
With Analytics .

See Marketing Cloud ID Services product documentation.

Analytics

Release date: April 21,2016

e Important Notices about Analytics
¢ New Features in Analytics
e New Features in Analytics Premium

¢ Analytics Fixes

Important Notices about Analytics

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description

SSLv3 April 14,2016 As of early Feb 2016, Adobe
Analytics data collection and
reporting APIs no longer
supports SSL v3.
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Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:
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Notice

Release Notes - April 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

e Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous 8/37
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

UK Postal Code February 18, 2016 Adobe's geo service provider is
changing how we receive UK
postal codes. We will be
switching from providing
truncated UK postal codes to full
postal codes on or around March

18th.
Changes to backdating of October 15, 2015 For report suites with timestamp
session information data, backdating will no longer

create a visit, as described in
Compare Visits and Mobile App
Launches (published October
2015).

New Features in Analytics
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Feature Description

Activity Map Activity Map (formerly known as ClickMap) allows
you to view your data directly in the context of
your web site. More...

Also added Activity Map reporting capability in

Analytics.
Analysis Workspace - Scheduled / Downloadable Allows you to schedule Analysis Workspace
Projects projects for immediate or recurring delivery. More...
Virtual Report Suites Allows the analyst to restrict data access for users

based on specific segments by applying a segment
to a report suite and creating a new view (Virtual
Report Suite) based on that combination. Virtual
Report Suites can be accessed just like regular
report suites. More...

Simplified Menu Marketing Cloud Solutions will introduce a new
simplified menu bar across our Solutions and core
services, which provides streamlined access to the
solutions, core services, notifications, help and
profile information you need to get the most out of
your investment in Adobe’s Digital Marketing
technology. More...

Marketing Cloud Audiences in Analytics (BETA) This feature brings AAM segments into Adobe
Analytics for reporting in real time. More...

AEM Assets Reporting Enables Analytics to collect impressions and clicks
on Assets served up from AEM Asset Insights. This
integration will enable reporting within AEM, it will
add new reports to Reports and Analytics and new
metrics and dimensions to Analysis Workspace and
Ad Hoc Analysis. More...
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New Features in Analytics Premium

Release Notes - April 2016

In addition to the features listed in New Features in Analytics, Analytics Premium provides these additional

new features:

Feature
Data Workbench 6.6

Smart Feature selection

Segment Export Wizard

Description

Provides users with automated feature selection
within the Propensity Scoring model in a quick and
precise manner. You no longer need to select the
independent variables from an overwhelming list
of metrics and dimensions.

Click Options > Feature selection to enable the
Feature selection menu. If the Feature Reduction
option is unchecked, users can make the system
explore additional model inputs from the entire set
of metrics while retaining user added metrics .
Checking Feature Reduction makes the system
select the most relevant metrics from the user
added metrics.

While using Smart Feature Selection for an empty
model, Feature Selection Settings are redundant.

Selecting More Features or Less Features from the
Level Setting sub-menu makes the selection
algorithm less or more greedy respectively in
adding feature set to the model. Please note that in
some cases, both settings may return the same
model.

The Segment Export Wizard provides a step-by-
step process to configure and export segments.
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Feature

New export executable for Target exports

L4 Logging

XML Decoder enhancements

New features in Propensity Score

Release Notes - April 2016

Description

To export Adobe Target data, a new
TargetBulkUpload.exe has been developed to
replace the Exportintegration.exe for Target
exports. If a user wants to move legacy exports to
TargetBulkUpload.exe , then exports have to be
changed (change mbox3rdPartyld to thirdPartyld ).

Option for L4 logging has been added under
Server/Admin/Export/ along with a new config
loggingDetails.cfg where we can turn ON/OFF GE
Logging and L4 logging. By default, L4 Logging will
be set true and GE Logging will be set false in
config, but user can change it anytime.

You can now use the #value tag in XML paths to
pull the value of an XML element.

For example, you can now read the attribute value

of the &lt;Hit&gt; &lt;Page name="Home Page"
index="20"&gt;home.html&lt;/Page&gt; &lt;/Hit&gt
tag using a Hit.Page.#value expression.

See XML Decoder Groups for additional
information

Within the toolbar button you can now choose to
either Save a filter or automatically launch
Propensity Scoring with a new feature selection
capability. The Propensity Scoring opens the
builder with the workspace selections applied for
the dependent variable, enables the selected
features, and lets you click Go to start.

It is now possible to save a Propensity Score Model
as a Javascript file. After the model is built click on
Save > Save Javascript .
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Feature Description

New Presentation Layer options You can now set transparency and border thickness
for Circle and Rectangle in the presentation layer.
Right click on the object and select No Fill to make
it transparent. Four border thickness options are
present under Outline - Thin, Medium, or Thickest.

Sensor Transmitter & Collector certificates updated ~ Sensor Transmitter & Collector now uses

for all platforms enhanced certificates for Linux, Windows, AlX, and
Solaris when communicating from the sensor to
the server.

Set transparency and border thickness for circles You can now set the transparency and border size

and rectangles to annotate workspaces of circles and rectangles to highlight and annotate

visualizations in a workspace. New options for the
circle and rectangle include a No Fill option for
transparency and border thickness settings of Thin,
Medium, or Thickest.

Additional visit level predictive builders to Added new predictive builders with Visit as the
Predictive Analytics Package root countable dimension for Propensity Scoring,
Clustering, and Decision Trees.

Additional set of Latency Visualizations to release Added set of Latency visualizations. The former

package latency visualizations looked at an equal period
around the event (-7 to +7 days) to create an
assignment. This works well for only one event per
clip, but doesn't give adequate results when there
are multiple events, such as multiple conversions.

We have reorganized and added additional latency
visualizations to the menu that are configured to
just evaluate before or after the event, but not both
at the same time.
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Feature

Updates to report.cfg

Chord Visualization updates

Access to Detailed Status

System Updates

Release Notes - April 2016

Description

You can now view dates in calendar format in the
report.cfg configuration tree

Implemented the ability to scale in the Chord and
Pie Chart visualizations. You can scale them by
holding down <Ctrl> key and using the mouse
wheel, or by right-clicking on the window border,
selecting scale, and entering a value.

Access to Detailed Status is now restricted to
power users and administrators by default.

These features have been renamed, deleted, or the
installation files or folders were restructured in this
release:

e Ul changes:

e Workstation toolbar is in an inconsistent
state after importing a visualization from
the worktop and clicking the thumbnail.
This now has an error message stating
"The **vw is not a valid workspace."

e Bookmark tooltip text interferes with
click. Previously, the when you moved
you cursor over the bookmark icon the
tooltip would appear and interfere with
clicking the bookmark. Now, the tooltip
text disappears when the mouse is
moved.

¢ Added Ctrl-V to paste content from clipboard
into workspace.

 Configuration Tree changes (Insight.cfg):

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous
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Feature Description

e Warning message for Insight.cfg Max
Trace Log Size field.

e Printf Format. You can now set the printf
format from the Insight.cfg tree.

e Path Browser. You can now set the path
in menu in the Insight.cfg file using a new
drop-down menu.

e V3D. Set a V3D setting in the Insight.cfg
file using three associated edit boxes in
the configuration tree.

Analytics Fixes

Fixes were applied to the following products and services:

Product Fixes

Reports & Analytics
¢ InJanuary, Referrer Instances was updated so

that reports use the first hit of a visit instead of
the page sequence number in the current visit
(visit_page_num ). visit_page_num is
preferable because it does not change across
month boundaries when new months are
merged. This update also included a change
that caused some historic internal referrers to
be counted as a Referrer Instance. For April,
we reverted the latter change to ensure that
historic internal referrers are counted as
Referrer Instance. (AN-119405)

e List Variable change: A limit of 250 maximum
values stored at one time per visitor has been
implemented for List Variables . If 250 values
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Product

Release Notes - April 2016

Fixes

per visitor are exceeded, the latest 250 values
are used. Expiration for these values is based

on the configured expiration for the variable.

(AN-119172)

Fixed an issue that caused user permissions to
inadvertently be updated. (AN-121610)

Fixed an issue that prevented alerts from
being sent out. (AN-121102, AN-121916, AN-
120742)

Fixed an issue that prevented scheduled
reports from getting delivered. (AN-121540)

Fixed an issue that prevented users from
excluding “None, unspecified and Typed
bookmarked data in report graphs" from
graphs. (AN-120335)

Fixed an issue related that resulted in
Conversion Level enablement no longer
needing Adobe approval. (AN-120452)

Fixed an issue with calculated metrics, where
an Admin could not delete metrics created by
an Unknown User. (AN-116625)

Fixed an issue that prevented the breakdown
of Mobile Device by Traffic variables. (AN-
104249)

Fixed an issue with the Item filter redirecting
to a different report. (AN-90675)

Fixed an issue with classifications failing
through FTP upload. (AN-120669)

Fixed an issue where older classified values for
Video Solution were not automatically
overwritten with new classified values. They
will now automatically be overwritten. (AN-
120582)

Changed the Customer Loyalty report, adding
a “Not a customer” category. This change will
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Product Fixes

have implications for segments you built
around the customer loyalty categories. For
example, if you built a segment around the
former definition of "New Customer", this
definition will now apply to the "Not a
customer” category. More... (AN-106951)
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Product Fixes

Analysis Workspace Fixes
e Scheduled projects: Export to .csv has been

enabled for all users ( Components >
Scheduled Projects ). (AN-121953)

¢ In Scheduled Projects, fixed an issue
preventing the schedule ID from displaying in
a project exported to .csv (AN-121859).

¢ Improved the calendar layout so that interface
options are always visible, and we added a
scroll bar. (In certain situations, buttons were
cut off at the bottom of the page). (AN-121356)

¢ Improved report suite updating when you log
in to Analysis Workspace. Settings like time
zone, currency, and start date are now
updated. (AN-116440)

¢ Fixed an issue preventing administrators from
displaying company landing pages for new
users. (AN-121202)

¢ Fixed a table column issue that caused the
browser's native right-click menu to display
rather than the column's table menu. (AN-
121191)

o Fixed a display issue causing Area charts to
appear as Line charts. (AN-121157)

o Disabled the hot keys associated with the
Actions bar, so that non-permissioned users
could not create and curate Analysis
Workspace projects using a hotkey. (AN-
120882)

¢ Fixed an issue preventing you from removing
a projects from the Favorites list. (AN-120530)
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Product

Ad Hoc Analysis Fixes

Report Builder

Data Warehouse

AppMeasurement (Legacy and Mobile SDKs)

Release Notes - April 2016

Fixes

Fixed an issue that prevented customers from
launching Ad Hoc Analysis from Analytics.
(AN-120370)

Report Builder added support for Virtual
Report Suites, Marketing Cloud Audiences in
Analytics, and for AEM Asset Insights.

Data Warehouse has changed its calculation of
the Page Views metric to match the Reports &
Analytics UL Specifically, if pagename is set,
then the hit is counted as a page view. (AN-
115999, AN-119537, AN-113415)

Data Warehouse is changing the Customer
Loyalty report, adding a “Not a customer”
category, in order to match an equivalent
change in Reports & Analytics.(AN-121261)

Fixed issues with the Tableau (TDE) report file
generated by Data Warehouse. (AN-90576,
AN-116769)

AppMeasurement for JavaScript
JavaScript version 1.6:

e The AppMeasurement Activity Map module

has been integrated in the AppMeasurement
standard module, so that you only have to
reference one js file. Additionally, Activity Map
tracking is activated by default. (AN-112689)

Fixed a truncation issue occurring with the
order of query-string variables in
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Product Fixes

AppMeasurement, so that pageURLRest is last.
(AN-114647)

AppMeasurement for Flash

Adobe has released a security update APSB16-13 for
the AppMeasurement for Flash library. This update
resolves an important vulnerability in the library,
applicable only when debugTracking is enabled,
that could be abused to conduct DOM-based XSS

attacks.

Note: This issue affects AppMeasurement for Flash
only when debugTracking has been enabled (
debugTracking is disabled in the default
configuration). If affected, we strongly advise you
to disable debugTracking immediately. Here is
some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to false or remove line
/ for default "disabled” behavior

Affected versions are AppMeasurement for Flash

version 4.0 and earlier on all platforms.

Note: Due to security reasons, we will no longer be
distributing an AS2 version of AppMeasurement for
Flash. We will continue to support data collection
from existing AS2-based projects. However, we
highly recommend that customers upgrade their
implementations to AS3 and incorporate the latest
security features of AppMeasurement for Flash.

AppMeasurement for Flash customers affected by
this issue must rebuild projects with the updated
library available for download from the Analytics
Console More... (AN-121780)

AppMeasurement for Other Platforms
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Product Fixes
See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:
e JavaScript
e i0OS
¢ Android
e Flash-Flex
e OSX
e Windows Phone, XBOX, Silverlight, and .NET
e BlackBerry
e Java
e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )
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Product Fixes
Analytics Web Services (SOAP and REST APIs) Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 API requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.

New Virtual Report Suite APIs
¢ ReportSuite.SaveVirtualReportSuite
e ReportSuite.GetVirtualReportSuiteSettings

¢ ReportSuite.DeleteVirtualReportSuite
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Product Fixes

Data Workbench
 Algorithmic Attribution: Coefficients all zero

when SGD used to converge. This has been
fixed.

See Data Workbench 6.2 updates for additional
release information.

Known Issue

¢ Propensity Score Model error issue. Setting
target in the Propensity Score visualization
while viewing Completed Score returns "Error
compiling ScoreDim x No Score Model." With
an Propensity Score, you can select Go with a
build model. If you set a target and apply the
filter (Target > Name) and click OK, then an
error is thrown. The workaround is to click
Reset > Reset Model and then press Go to
build without an issue.

targetbulkupload.exe requires command-line
arguments in English. The output file name should
be named in English for Adobe Target Export,
Profiles & Audiences Export, and Customer Record
Service Export.

Audience Manager

Feature Description
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Feature Description

Profile Link Profile link reports and graphs include a new
metric, Total Devices . This is a frequency count of
the number of devices visitors have used to
authenticate to your site for a selected data source.
See Report Metrics for Profile Merge Rules .

Marketing Cloud Audiences in Analytics Beta release.

This new feature lets you bring Audience Manager
segments in to Analytics . See New Features in
Analytics above.

Fixes, Enhancements, and Deprecations

Fixed a bug that exposed deleted traits in the Destinations - Addressable Audience dashboard. (AAM-23857)

Social
Feature Description
Marketing Cloud navigation and menu changes As part of the Adobe Marketing Cloud Spring 2016
release, a new-top level navigation menu displays
at the top of the Social user interface.
See What's New in the Adobe Marketing Cloud -
Spring 2016 in the Marketing Cloud and Core
Services Product Documentation.
Enhancements

¢ Enhanced Moderation so that when you click a timestamp on a post’s comment, it directs you to the

comment itself rather than the top post.

Fixes
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The fixes highlighted below describe resolutions for the more important customer-reported issues.

e Fixed an issue that prevented data from populating the Post Analytics reports for certain Twitter
properties.

¢ Fixed an issue that caused link attachments in the publishing workflow to fail.

¢ Fixed an issue that prevented Moderation from capturing tweets, in one example, for a specific day.

¢ Fixed an issue that caused Publish Anywhere to create incorrect shortened links.

e Fixed an issue in Content Calendar that prevented the filter for LinkedIn properties from working
correctly.

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Search&Promote

A IMPORTANT
In the updated Marketing Cloud interface, you can access Search&Promote from the Analytics >
Tools menu. Or, log in directly using: https://center.atomz.com/center/.

Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation
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Adobe Campaign Standard

¢ Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest recommended patches to
ensure higher stability, security, and performance.

AEM Mobile Description

AEM Mobile Adobe announced Adobe Experience Manager
Mobile to simplify the process of building and
managing visually appealing enterprise applications
that are as easy to use as consumer applications.
For details of the announcement, see this blog post

Data connector Description

Amazon S3 Connector You can configure AEM to store data in Amazon's
Simple Storage Service (S3). Download the
connector from Package Share .

UberJar Description
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Uberlar

Unobfuscated UberJar

Marketing Cloud Status

Marketing Cloud Status

New tool

Oak Index Definition Generator tool

Hot fixes

Release Notes - April 2016

Description

Unobfuscated UberJar is now available from the
AEM Support Portal .

Documentation is here .

Description

Marketing Cloud Status lets you view the status of
the SaaS-based AEM products such as AEM Assets,
on-demand, Scene7 Publishing System, and
Communities Cloud Storage.

Description

Oak Lucene index provides various options to tune
your index depending on the query.

To simplify defining the index for a query, you can
use the new Oak Index Definition Generator tool.
You provide a set of related queries, for example, if
queries are based on the same nodeType, it
generates an index definition based on those
queries.

Description
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Hot fixes Description
AEM 6.1 hot fixes List of recommended hot fixes for AEM 6.1.
AEM 6.0 hot fixes List of recommended hot fixes for AEM 6.0.

OAK 1.0.28 is available for download.

AEM 5.6.1 hot fixes List of recommended hot fixes for AEM 5.6.1.
Security bulletins Description

APSB16-05 Security bulletin for Adobe Experience Manager.
Service packs Description
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Service packs Description

AEM 6.1 Service Pack 1 AEM 6.1 Service Pack 1is an important update that
includes performance, stability, security and key
customer fixes and enhancements released since
the general availability of AEM 6.1 in May 2015. SP1
can be installed on AEM 6.1 GA.

The overview on this page lists the changes added
with SP1. Some of the key highlights of the service
pack are:

e The built-in repository (Apache Jackrabbit
0ak) is updated to version 1.2.7.

¢ Includes touch-optimized Ul update pack
(Feature Pack 6563) for AEM 6.1.

e Includes critical fixes for Adobe Target
Integration.

Release Notes

Package Share Download
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Service packs

AEM 6.0 Service Pack 3

Latest Self-Help Content Updates

Self-help updates

CRX20AK migration tool

Release Notes - April 2016

Description

AEM 6.0 Service Pack 3 (SP3) is an important
update that includes security, performance,
stability, and key customer fixes and enhancements
released since the general availability of AEM 6.0 in
May 2014. Service Pack 3 contains all changes
introduced with Service Pack 2. It can be installed
on AEM 6.0 GA, AEM 6.0 SP1 and AEM 6.0 SP2.

The overview section on this page lists the changes
added with SP3. The included changes from SP2
are listed in the Service Pack 2 release notes .

The following are some key highlights of the
service pack:

e The built-in repository (Apache Jackrabbit
Oak) updated to version 1.0.22.

e It replaces Sling JCR Classloader with File
System Classloader.

Release Notes

Package Share Download

Description

CRX20ak is a tool designed to migrate data
between different repositories.
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Self-help updates

Integrating AEM with Adobe Campaign

Authoring Targeted Content

Touch Ul - Authoring FAQ

Touch Ul - Troubleshooting Guide

Touch Ul - Using custom xtypes

AEM with MongoDB

Best Practices for Queries and Indexing

Multi Site Management

For product documentation, see the following:

¢ Adobe Experience Manager 6.1 Release Notes

Release Notes - April 2016

Description

Adobe Campaign is a set of solutions that lets you
personalize and deliver campaigns across all of
your online and offline channels.

Author targeted content using Targeting mode of
the AEM touch-optimized Ul.

Frequently asked questions for Touch Ul authoring.

Tips and tools that help troubleshooting Touch Ul-
related issues.

Using custom xtypes in Adobe Experience Manager
6 Touch UL.

Improve your knowledge on tasks and
considerations needed to successfully deploy
Adobe Experience Manager with MongoDB.

When to create indexes as well as when they are
not needed, tricks to avoid using queries when they
are not necessary, and tips for optimizing your
indexes and queries to perform as optimally as
possible.

Use Multi Site Manager (MSM) to use the same site
content in multiple locations.
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e Adobe Experience Manager Help Home
e Scene7 Publishing System Release Notes

e AEM Assets, on-demand Release Notes

Advertising Cloud

Release Notes - April 2016

Advertising Cloud help is available in the product at ? > Help Contents.

Recent documentation updates

Item Description

Marketing Cloud Audiences in

With the Marketing Cloud

Date Published

April 14,2016

Analytics

Accelerated Mobile Pages

Audiences for Analytics
integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Adobe is participating in the February 24, 2016
Accelerated Mobile Pages (AMP)

Project. AMP is an open source

project that lets you build web

pages for static content that

renders quickly. This feature is

ideal for publishers who want to

create mobile-optimized content

once, and have it load instantly

everywhere.
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Item

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Release Notes - April 2016

Description

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Date Published

February 18, 2016

February 11,2016

January 21,2016

September 17,2015

September 17,2015
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Item

Timestamps Optional

Data Workbench 6.5 Update

Select Report Suites and
Variables

Release Notes - April 2016

Description Date Published

Added product documentation September 17, 2015
and best practices for

Timestamps Optional. This

feature lets you integrate both

timestamped and non-

timestamped data in a report

suite. All new report suites will

be Timestamps Optional by

default.

See Data Workbench 6.5 release September 17, 2015
notes for instructions to upgrade

and a list of new features and

bug fixes, including a new

Associations table and chord

diagram and updates to

visualizations, user interface,

algorithms, and export features.

Updated the Classification Rule
Builder so that you add report

August 20, 2015

suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.
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Item

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Freeform Analysis (public beta)

Data Workbench 6.4

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous

Release Notes - April 2016

Description

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

A feature in Analysis Workspace,
freeform analysis lets you built
data tables and drag-and-drop
metrics, dimensions, segments,
and multiple visualizations to a
project panel.

Data Workbench 6.4 release
includes several new features
described here.

Date Published

August 20, 2015

June 18, 2015

June 18, 2015

June 18, 2015
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Item

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - April 2016

Description Date Published

Added Adobe Managed
Certificate Program to the

May 22, 2015

revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

May 22, 2015

A high-level round-up what you March 19, 2015
need to do to modernize your
solution implementations for

core services.

If you capture enterprise March 19, 2015
customer data in a customer

relationship management (CRM)

database, you can upload that

data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.
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Item

Analytics Classification Rules -

overwrite existing values

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/04212016.html?lang=en#previous

Release Notes - April 2016

Description

In Admin Tools > Classification
Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

Date Published

February 19, 2015
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Documentation > Release Notes Guide > Release Notes - May 2016

Release Notes - May 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

® NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe

Priority Product Update. Release information in

the Priority Product Update comes one week in

advance of the release date and is subject to change. Please check back at release time for

updates.

Release date: May 19, 2016

Experience Cloud

Marketing Cloud 16.5.1

New features and fixes in the Adobe Marketing Cloud interface.

Release date: May 26 2016

Features and Improvements

Feature

Pre-configured product configurations in the
Enterprise Dashboard

Description

Marketing Cloud customer administrators can
leverage product configurations that are pre-
created and mapped to default permission groups
for Analytics and Dynamic Tag Management.

This optimization is available for newly provisioned
organizations, and it reduces the amount of time
required by organizations to manage users in the
Enterprise Dashboard.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Feature Description

Feed improvement When creating a new post in the Marketing Cloud
Feed, the To line now uses the currently active
topic instead using the organization by default.

Fixes

¢ Fixed an issue preventing thumbnails from showing for assets shared from Assets on Demand to the
Marketing Cloud Feed. (MAC-29955)

See Marketing Cloud Product Documentation for product help.

Adobe Mobile Services

@ NOTE
Accessing Target functionality within Mobile Services now requires that users be logged in with an

Adobe ID that is provisioned for their Target company. Logging in with a Target username and

password has been removed.

The Mobile Services May 19, 2016 release includes the following enhancements:
Enhancements
» Added Impressions / Engagement Rate for in-app messaging reporting. Requires version 4.9.0 of the
Android or iOS SDK.
The Mobile Services May 5, 2016 release includes the following changes:

New Features

Resource Description

Acquisition tracking enhancements Create marketing links that send users to download
apps from the appropriate app store and to in-app
deep links. Marketers can attribute downloads, app
relaunches, and other in-app events to these links

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 2/31


https://experienceleague.adobe.com/docs/core-services/interface/about-core-services/core-services-landing.html?lang=en

11/6/2020

Resource

Release Notes - May 2016

Description

to understand how to optimize acquisition

Enhancements Include:

o Link Manager: A new interface in the app
settings section lets users manage web, app
deep, and other link destinations. These
destinations can be called in workflows
relating to acquisition tracking links and to in-
app or push messages.

Marketing Links Builder: A new graphical and
intuitive user interface helps users build
tracking links. Marketers can choose decisions
and destinations that best serve their users.

Tracking links are created and saved in
the Ul. Marketers can change link
destinations or tracking meta data even
after the links are deployed.

Links can device-detect on OS, OS
version, and form-factor.

Marketers can choose a destination for
tracking links that routes users to a
fallback destination to preserve the
integrity of the landing experience.

Links can contain token-replaceable
parameters.

Tracking links can contain Adobe-hosted
and configurable interstitials.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 3/31
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Resource

Messaging enhancements

Push Notifications:

e Custom Push Payload: Marketers can provide
a custom push payload in JSON (4KB limit) to
be sent to the app via a push or a local
notification.

o Category & Sound (iOS only):
Marketers can provide a category and a sound
resource for push and local notifications.

Description
Destinations for In-App and Push Messaging

To enhance authoring convenience, marketers can
choose a “destination” URL to call a saved web or
app deep link from links saved in the Link Manager
or they can provide a link in-line.

e Manually enter a custom web link or deep
link.

¢ Choose a stored web or deep link stored in
Link Manager .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Resource Description

Marketing Cloud navigation and menu changes As part of the Adobe Marketing Cloud Spring 2016
release, a new-top level navigation menu displays
at the top of all solution interfaces. The new
interface lets you:

¢ Single-click navigation between solutions:
Choose your own default landing page or take
advantage of the solution-switcher widget.

» Improved notifications: Get notified about
events (like posts, mentions, assets shared,
system updates) happening across your
organization navigation widget.

e Updated Feed: We reimagined the Feed page
to become a better platform for cross-channel
collaboration between marketers.

See What's New in the Adobe Marketing Cloud -
Spring 2016 in the Marketing Cloud and Core
Services Product Documentation.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand

Previous Release Notes in the left pane.

Marketing Cloud ID Service

This release includes the following changes, improvements, and fixes.

Change Description

Versions e 1.5.5 (beta): This is a test version for a few
specific customers. Please do not use this
version.

¢ 15.6: Use this version if you need to update
your code.
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Change Description

Bug Fixes Fixed a bug that returned the wrong company
name if it has multiple Organization IDs. (AAM-
23861)

Documentation Added new documentation that describes how to

integrate the Marketing Cloud ID into Data
Workbench. See Data Workbench and the
Marketing Cloud ID Service . (AAM-23727)

See the Marketing Cloud ID Services product documentation.

Analytics

Features and fixes released in Analytics.

Important Notices about Analytics

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Notice Date Added or Updated Description
AppMeasurement for Flash - April 21,2016 Adobe has released a security
Security update update APSB16-13 for the

AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers

SSLv3 April 14,2016 As of early Feb 2016, Adobe
Analytics data collection and
reporting APIs no longer
supports SSL v3.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 7131


https://helpx.adobe.com/security/products/analytics/apsb16-13.html
https://www.owasp.org/index.php/DOM_Based_XSS

11/6/2020 Release Notes - May 2016

Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:
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Notice

Release Notes - May 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

¢ Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 10/31
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

UK Postal Code February 18, 2016 Adobe's geo service provider is
changing how we receive UK
postal codes. We will be
switching from providing
truncated UK postal codes to full
postal codes on or around March

18th.
Changes to backdating of October 15, 2015 For report suites with timestamp
session information data, backdating will no longer

create a visit, as described in
Compare Visits and Mobile App
Launches (published October
2015).

New Features in Analytics

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 11/31
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Feature Description

Analysis Workspace: Added Filter type Added filter type "Failed" within the Scheduled
Projects Manager . This feature shows all scheduled
projects that are no longer running because of
repeated failure. It is unchecked by default. Each
failed instance has a warning icon that, when
hovered over, indicates the reason for failure.

Admin Tools: Video & Video Ad Metadata When editing a report suite's video settings in
Admin Tools > Report Suites > Edit Settings > Video
Management , you can enable more video
reporting via the Video & Video Ad Metadata
checkbox. Metadata can be attached to a video
and/or an ad to further describe and categorize that
video or ad. Standardized video and ad metadata is
collected via solution variables and classifications.

Values include: Show, Season, Episode, Asset ID,
Genre, First Air Date, First Digital Date, Content
Rating, Originator, Network, Show Type, Ad Loads,
MVPD, Authorized, Day Part, Video Session ID,
Advertiser, Campaign ID, and Creative ID.

Activity Map e Activity Map's Internet Explorer Extension
version is now downloadable and installable.

¢ Added a list of selected segments to the
bottom of the Segment drop-down panel so
that users do not have to scroll through all
segments to see the selected ones. (AN-
122464)

¢ Added a checkbox in Segments to limit
segments to the ones in the selected report
suite.

¢ Added a checkbox in Metrics to limit metrics
to the ones in the selected report suite.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 12/31
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Feature Description

Mobile Messaging Reporting Added support for reporting mobile messaging
local notifications.

A new event report was added to Mobile App >

Messaging Reports > In-App Message Impressions .

In addition, a new Calculated Metric was added,
called "Engagement Rate(Messages)".

Analytics Fixes
Fixes were applied to the following products and services:

Product Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Product

Reports & Analytics

Release Notes - May 2016

Fixes

Fixed an issue that occurred when attempting
to edit eVars for multiple report suites
simultaneously. The menu would not load
past eVar 38. (AN-120804)

Fixed an issue with editing virtual report
suites: tags, segments, and report suites
sometimes appeared blank in the Virtual
Report Suite Manager . (AN-122688)

Fixed an issue with processing rules failing to
be copied. (AN-122109)

Fixed an issue preventing audience sharing
between Analytics and Target. (AN-120472)

Fixed an issue that prevented reports with a
large number of applied filters from being
downloaded. (AN-122771)

Fixed an issue that caused User Group details
for report suites (under Admin &gt; User
Management) to not show up. (AN-122943)

Fixed an issue that prevented the Virtual
Report Suite Manager from loading. (AN-
122604)

Fixed an issue that prevented the download
and sending of dashboards. (AN-122800)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Product

Analysis Workspace

Data Platform

Release Notes - May 2016

Fixes

Fixed an issue where hourly granularity was
not working when exporting the project as a .
CSV file. (AN-122842)

Fixed a “Unique Visitors” data mismatch issue
between Cohort and Freeform Analysis. (AN-
122449)

Fixed a display issue that occurred when
minimizing Freeform panels with custom
widths and heights. (AN-122651)

Fixed an issue with Summary Number
Visualizations not showing table totals. (AN-
122728)

Fixed a display issue that prevented a list from
adjusting to a decrease in the screen size. (AN-
122815)

Fixed an error in the text box when the "Text"
visualization type was dragged into a Freeform
panel. (AN-122801)

Fixed a display issue with the email body
when receiving a scheduled project as a PDF
in a localized environment. (AN-121967)

Fixed an issue that caused the “Cities” report
to show unknown values in all Analytics tools.
(AN-121533)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Product

Activity Map

Data Warehouse

Data Sources

Release Notes - May 2016

Fixes

Fixed an issue that prevented Activity Map
from working with page names that contained
double-byte characters. (AN-122878)

Fixed an issue with the Activity Map session
timeout value and set it to 30 days. (AN-
122807)

Fixed an issue that caused some cancelled
Data Warehouse requests to display the wrong
status. (AN-122436)

The Data Source type “SearchCenter Bulk
Upload” has been deprecated. (AN-93325)

Fixed an issue with Data Source files not
getting uploaded and showing 0 rows in the
user interface. (AN-120969, AN-120757, AN-
120274, AN-114049)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Product Fixes
AppMeasurement (Legacy and Mobile SDKs) AppMeasurement for JavaScript
JavaScript Version 1.5.6

* Inclusion of Visitor API 1.5.6 (latest Marketing
Cloud ID service )

¢ Fixed the handling of link click tracking in
Firefox that was not firing the complete event.

JavaScript H code (Legacy)

Inclusion of Visitor API1.5.5 (latest Marketing Cloud
ID service )

Flash 4.0.1 - Update

Inclusion of Visitor APl 1.5.6

Analytics Web Services (SOAP and REST APIs) full_response

We added a new optional parameter full_response
to ReportSuite.Create . If this parameter included
and set to "true", the response will be an object
instead of a boolean.

See ReportSuite.Create .
Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 API requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.
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Product Fixes

Data Workbench See Data Workbench 6.6 updates for additional
release information.

Audience Manager

New features and fixes in Adobe Audience Manager.
Fixes, Enhancements, and Deprecations

« Fixed a bug in Profile Merge Rules that showed a 1-day date range in the Authenticated Identity Metrics.
(AAM-24100)

 Fixed a bug in the Admin Ul that prevented you from deactivating a user account when it is in a pending
status. (AAM-16087)

« Fixed a bug that prevented you from re-activating a paused segment. (AAM-23938)

« Fixed a bug that prevented you from clearing a selected Profile Merge Rule checkbox. (AAM-23359)

» Fixed a bug that prevented you from activating a private data feed. (AAM-23395 and related, AAM-23377)
* Fixed a bug that showed demonstration data in Audience Marketplace. (AAM-23837)

 Fixed a bug in the Destinations search tool that retained search results when you navigated away from
the page and returned later. (AAM-23860)

* Fixed a bug that prevented the breadcrumb navigation from updating as you moved to different screens.
(AAM-24120)

« Fixed a bug that prevented the Trait screens and graphs from displaying properly. (AAM-24141)

 Fixed a bug that prevented the Users and Groups sections from displaying properly. Affects users with
Administration access only. (AAM-24144)

Documentation Updates

Social

Revised the Destinations section. Changes include simplified procedural documents and reorganized content.
Fixes
The fixes highlighted below describe resolutions for the more important customer-reported issues.
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e Fixed an issue that caused a “reply failed” message to display in Moderation when replying to a LinkedIn
post.

¢ Fixed an issue that caused inconsistent data between the Moderation Overview report and its
downloaded report.

e Fixed an issue in Publish Anywhere in which Adobe Social did not recognize a custom branded domain.
This fix is for Publish Anywhere and not for Publisher and Content Calender.

¢ Fixed an issue that caused duplicate email messages to be sent during the approval workflow.

e Fixed an issue that caused users to receive email messages indicating failed campaign tracking.

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Documentation

Adobe Campaign Standard

e Adobe Campaign v6 Release Notes

¢ Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the recommended patches to ensure
higher stability, security, and performance.
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AEM releases

AEM 6.2 is now available as of April 21,2016

AEM hot fix releases

AEM 6.2 hot fix pack

AEM 6.1 hot fixes

AEM 6.0 hot fixes

AEM 5.6.1 hot fixes

AEM service pack releases

Release Notes - May 2016

Description

Adobe Experience Manager 6.2 is an upgrade
release to the code base of Adobe Experience
Manager 6.1. It provides new and enhanced
functionality, key customer fixes, high priority
customer enhancements and general bug fixes
oriented toward product stabilization. It also
includes Adobe Experience Manager 6.1 feature
pack, hot fix, and service pack releases.

What is new?

Release notes

Description

A hot fix pack is being planned for release June,
2016. The hot fix pack addresses several known
issues in AEM 6.2

List of recommended hot fixes for AEM 6.1.

List of recommended hot fixes for AEM 6.0.

OAK 1.0.28 is available for download.

List of recommended hot fixes for AEM 5.6.1.

Description
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AEM service pack releases Description

AEM 6.1 Service Pack 1 AEM 6.1 Service Pack 1is an important update. It
includes performance, stability, security, key
customer fixes, and enhancements released since
the general availability of AEM 6.1 in May 2015. You
can install SP1 on AEM 6.1 GA.

The overview on this page lists the changes added
with SP1. Some of the key highlights of the service
pack are the following:

e The built-in repository (Apache Jackrabbit
0ak) is updated to version 1.2.7.

¢ Includes touch-optimized Ul update pack
(Feature Pack 6563) for AEM 6.1.

¢ Includes critical fixes for Adobe Target
Integration.

Release Notes

Package Share Download
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AEM service pack releases Description

AEM 6.0 Service Pack 3 AEM 6.0 Service Pack 3 (SP3) is an important
update. It includes security, performance, stability,
key customer fixes, and enhancements released
since the general availability of AEM 6.0 in May
2014. Service Pack 3 contains all changes
introduced with Service Pack 2. You can install it on
AEM 6.0 GA, AEM 6.0 SP1,and AEM 6.0 SP2.

The overview section on this page lists the changes
added with SP3. The included changes from SP2
are listed in the Service Pack 2 release notes .

The following are some key highlights of the
service pack:

e The built-in repository (Apache Jackrabbit
Oak) updated to version 1.0.22.

e It replaces Sling JCR Classloader with File
System Classloader.

Release Notes

Package Share Download

AEM security bulletin releases Description
APSB16-05 Security bulletin for Adobe Experience Manager.
AEM webinars Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous 22/31


https://docs.adobe.com/docs/en/aem/6-0/release-notes-sp2.html
https://docs.adobe.com/docs/en/aem/6-0/release-notes-sp3.html
https://www.adobeaemcloud.com/content/marketplace/marketplaceProxy.html?packagePath=/content/companies/public/adobe/packages/cq600/servicepack/AEM-6.0-Service-Pack-3
https://helpx.adobe.com/security/products/experience-manager/apsb16-05.html

11/6/2020 Release Notes - May 2016

AEM webinars Description

Gems on Adobe Experience Manager Gems on Adobe Experience Manager is a series of
technical deep dives delivered by Adobe experts.
This series complements product documentation
and technical channels, and allows developers to
get in touch and explore a specific topic.

Next session is Wednesday, June 1, 2016. The topic is
AEM web performance.

Deep Dive in AEM Communities on May 24, 2016 Join us May 24, 2016 for this deep dive session on
understanding how community functionality works
in Experience Manager. Besides the presentation
and live demo, subject matter experts will answer
your questions related to AEM Communities.

Suggested self-help content

The following table contains a selection of links to suggested topics. These topics can help you make the most
of your implementation and use of Adobe Experience Manager.

AEM topic Description

Repository Maintenance Best Practices Learn about the two ways to perform revision
cleanup in Adobe Experience Manager.

User Interface Recommendations for Customers Adobe Experience Manager includes the classic and
touch-optimized Ul. As such, the "User Interface
Recommendations for Customers" topic can help
you decide which Ul is best for you to use during
project implementation, or when you update from
an earlier release.
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AEM topic Description

Components Provides, among other things, a basic overview of
Adobe Experience Manager components, including
components in the classic Ul and the touch-
optimized UL.

Solution Integrations Integrate Adobe Experience Manager with other
Adobe Marketing Cloud solutions and with third-
party services.

AEM with MongoDB Improve your knowledge on tasks and
considerations needed to successfully deploy
Adobe Experience Manager with MongoDB.

Best Practices for Queries and Indexing Information on when to create indexes and when
they are not needed. Also includes tips to avoid
using queries when they are not necessary, and tips
for optimizing the performance of your indexes and
queries.

Multi Site Management Use Multi Site Manager (MSM) to use the same site
content in multiple locations.

Additional resources:

e Adobe Experience Manager Help Home
e Scene7 Publishing System Release Notes

e AEM Assets, on-demand Release Notes

Advertising Cloud
Advertising Cloud help is available in the product at ? > Help Contents.
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Recent documentation updates

Item

Adobe Experience Manager 6.2

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous

Description

Adobe Experience Manager 6.2
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,
and service pack releases.

A getting started guide for new
Analytics administrators.

A round-up of available
integration topics.

Activity Map product
documentation.

Date Published

May 19, 2016

May 15, 2016

May 15, 2016

April 14,2016

25/31


https://docs.adobe.com/content/docs/en/aem/6-2.html
https://marketing.adobe.com/resources/help/en_US/analytics/getting-started/
https://marketing.adobe.com/resources/help/en_US/mcloud/marketing-cloud-integrations.html
https://marketing.adobe.com/resources/help/en_US/analytics/activitymap/

11/6/2020

Item

Marketing Cloud Audiences in
Analytics

Accelerated Mobile Pages

Analytics Product Comparison

Marketing Cloud Assets

Release Notes - May 2016

Description

With the Marketing Cloud
Audiences for Analytics
integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Adobe is participating in the
Accelerated Mobile Pages (AMP)
Project. AMP is an open source
project that lets you build web
pages for static content that
renders quickly. This feature is
ideal for publishers who want to
create mobile-optimized content
once, and have it load instantly
everywhere.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Date Published

April 14,2016

February 24, 2016

February 18, 2016

February 11, 2016
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Item

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Release Notes - May 2016

Description

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

Date Published

January 21,2016

September 17, 2015

September 17,2015

September 17, 2015
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Item

Data Workbench 6.5 Update

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Release Notes - May 2016

Description

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

Date Published

September 17,2015

August 20, 2015

August 20, 2015

June 18, 2015
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Item

Freeform Analysis (public beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core
Services

Release Notes - May 2016

Description

A feature in Analysis Workspace,
freeform analysis lets you built
data tables and drag-and-drop
metrics, dimensions, segments,
and multiple visualizations to a
project panel.

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for

core services.

Date Published

June 18, 2015

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015
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Item

Customer Attributes

Analytics Spring Release

Analytics Classification Rules -
overwrite existing values

If you capture enterprise

In Admin Tools > Classification

Release Notes - May 2016

Description Date Published

March 19, 2015

customer data in a customer
relationship management (CRM)
database, you can upload that
data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new

documentation for the Spring

2015 Analytics release.

February 19, 2015

Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any

existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/05192016.html?lang=en#previous
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Documentation > Release Notes Guide » Release Notes - June 2016

Release Notes - June 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date and is subject to change. Please check back at release time for

updates.

Release date: June 16, 2016

Experience Cloud

New features and fixes in the Adobe Experience Cloud.

Adobe Mobile Services

The Mobile Services June 16, 2016 release includes the following enhancement:

Enhancement
Resource Description
Messages You can now sort and filter the Messages list.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

A IMPORTANT

Accessing Target functionality within Mobile Services now requires that users be logged in with an
Adobe ID that is provisioned for their Target company. Logging in with a Target username and
password has been removed.

Marketing Cloud ID Service

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous 1/26
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Version 1.5.7 includes the following features and fixes.

Feature Description

Changes to the iframe.sandbox attribute The iFrame is now set so that
iframe.sandbox="allow-scripts allow-same-origin’; .

Allowing only these 2 tokens helps improve
security and provides the ID service with the basic
functionality required for ID synchronization.

The sandbox attribute is not supported in Internet
Explorer version 9 or earlier. For more information,
see the Attributes section in this iFrame
documentation . (AAM-22334)

Encoding the Marketing Cloud ID (MID) The ID service encodes the MID value returned
from the server or when it's set by the
visitor.setMarketingCloudVisitorID() function. For
more information about the MID, see Cookies and
the Marketing Cloud ID . (AAM-23336)

Fixes

The visitor API no longer forces an extra re-synchronization call with Audience Manager when there is no
legacy Analytics visitor ID. (AN-121403)

See Marketing Cloud ID Service product documentation.

Analytics

Important Notices about Analytics

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.
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Notice Date Added or Updated Description
AppMeasurement for Flash - April 21,2016 Adobe has released a security
Security update update APSB16-13 for the

AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers

SSLv3 April 14,2016 As of early Feb 2016, Adobe
Analytics data collection and
reporting APIs no longer
supports SSL v3.
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Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.
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Notice Date Added or Updated Description

UK Postal Code February 18, 2016 Adobe's geo service provider is
changing how we receive UK
postal codes. We will be
switching from providing
truncated UK postal codes to full
postal codes on or around March
18th.

New Features in Analytics
Release date: June 16, 2016

Feature Description

Simplified implementation for new customers New customers who log in to Analytics via the
Marketing Cloud can quickly implement Analytics
using the Getting Started with Adobe Analytics
modal, then deploy Analytics using Dynamic Tag
Management.

This simplified implementation is hosted by
Dynamic Tag Management and enables you to:
o Quickly create your first report suite.
¢ Run reports on basic page-level data.

¢ Deploy Analytics and the Marketing Cloud ID
service.

See Getting Started with Analytics Implementation
for details.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous
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Feature

Changes to visit processing for time-stamped data.

Analysis Workspace &gt; Segment Comparison

Analysis Workspace enhancements

Release Notes - June 2016

Description

We are improving the way visits are calculated for
Timestamps Required and Timestamps Optional
report suites. These changes will primarily affect
data collected through Mobile SDKs and will result
in lower overall visit counts going forward, in
certain situations.

Learn more in Compare visits and mobile app
launches.

To see which report suites might be affected, see
Timestamps Optional .

The Segment Comparison Panel in Analysis
Workspace allows customers to quickly compare
any two Analytics segments to find the most
significant differences between them across all data
points. More...

¢ New Projects Menu.

e New left rail that contains Panels,
Visualizations , and Components .

¢ Ability to delete all visualizations in a panel,
and all panels in a project.

e \enn visualization.

e Trend Selection / Line chart on a ranked table
is now live-linked

e Create Visual icon: clicking this icon provides
an intelligent guess at your next action (bar
chart, Venn...).

e Add Segment drop zone: lets you drag 1+
items and converts this into a segment;
internal segments. More...
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Feature Description

Admin Tools Analytics added two new global user permissions
in Admin > User Management > Groups :
¢ Analysis Workspace Access

¢ Reports & Analytics Access

If an admin turns these permissions off for a user,
the user cannot see or access Reports and/or
Workspace in the Analytics top header and in the
global search.

By default, on June 16, all users will be added to
these groups. More...

Data Warehouse improvements ¢ General Data Warehouse stability and
performance enhancements.

e Stability and performance improvements
regarding SFTP delivery.

Analytics Fixes

Fixes were applied to the following products and services:

Product Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous 7126
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Product

Reports & Analytics

Release Notes - June 2016

Fixes

Fixed an issue that caused “Unable to retrieve
reportlet" messages to appear in dashboards.
(AN-124302)

Fixed a report display issue that caused the
graph to show one fewer item than specified
under Configure Graph. (AN-116470)

Fixed an issue with the metric visibility feature
under Report Suite Manager . Hidden events
were still showing up in the user interface.
(AN-123681)

Fixed an issue that caused queries for report
suites to fail with large numbers of report
suites. (AN-121845)

Fixed an issue that showed report suite
activations as “pending” even though they
were already completed. (AN-124558)

Fixed an issue that caused an error message to
appear when attempting to add a new
calculated metric or when editing an existing
one. (AN-124564)

Fixed an issue with the Publishing List drop-
down menu not working. (AN-120762)

Fixed an issue with video reporting eVars that
were set up in SiteCatalyst 14 not displaying
properly in Adobe Analytics 15. (AN-122453)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous
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Product Fixes

Analysis Workspace Fixes
e Changed the definition of "None" in the

Mobile Carrier report. “None” now includes
non-mobile devices in addition to mobile
devices. This brings the report in line with
Reports & Analytics. (AN-122678)

¢ Fixed an issue that prevented the scheduling
of Analysis Workspace projects in any format.
(AN-123378)

e Fixed an issue with not being able to
download projects in PDF format. (AN-123231)

Ad Hoc Analysis Fixes
¢ Changed the definition of "None" in the

Mobile Carrier report. “None” now includes
non-mobile devices in addition to mobile
devices. This brings the report in line with
Reports & Analytics . (AN-122678)

e Fixed an issue with the page selector pane not
showing more than the top 50 pages. (AN-
124990)

¢ Fixed an issue that resulted in a change to
how “None” rows were calculated for visit-
level dimensions with “recent” allocation. (AN-
122279)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous 9/26
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Product

Activity Map

Data Warehouse

Data Platform

Release Notes - June 2016

Fixes

Fixed a display issue that caused the overlay
detail to be displayed below links that were at
the bottom of a page. It is now displayed
above the link. (AN-124049)

Fixed an issue with the Region ID being
reported as “Body". (AN-122966)

Fixed an issue with access to the Activity Map
download page for non-admin users. The fix
means that non-admin users no longer have
to be part of the Legacy Click Map group to be
able to download Activity Map , just members
of the Activity Map Access group. (AN-125144)

Fixed regression introduced in the May
maintenance release that caused reports
segmenting on Customer Loyalty &gt; Loyal
Customer to not return data. (AN-124498)

Fixed an issue with merchandising eVars when
the eVar number was greater than 75, causing
a data mismatch between Data Warehouse
and Reports & Analytics . (AN-123328)

Fixed an issue with the header name in
reporting on some participation metrics. (AN-
121371)

Fixed an issue that caused campaign
classifications to be automatically created for
variables without classifications. We no longer
auto-create classifications.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous
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Product Fixes

AppMeasurement (Legacy and Mobile SDKs) See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e iOS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET
e BlackBerry

e Java

e PHP

e Symbian

Analytics Web Services (SOAP and REST APIs) Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 API requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.

Data Workbench See Data Workbench 6.2 updates for additional
release information.

Audience Manager

Fixes, Enhancements, and Deprecations

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous 11/26
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« Fixed a bug in the admin Ul that prevented you from saving group permissions. (AAM-24684)
* Fixed a bug in the admin Ul that prevented administrators from changing user passwords. (AAM-24561)
« Fixed a bug that showed incorrect dates on the unique trait graph on the trait view page. (AAM-24598)

 In Audience Marketplace, data sellers can now update an a rate card for active data feeds. (AAM-23476)

New and Revised Documentation
Revised:

o Capturing Campaign Impression Data via Pixel Calls
e Beta Environment

e APIURLs

Improvements

¢ Reply to direct messages from Twitter handles which do not follow you.

Fixes
The fixes highlighted below describe resolutions for the more important customer-reported issues.
e Fixed an issue where deleted users remain listed as authorizers for specific properties in Social. (AS-

37219)

 Fixed an issue where claiming of a feed after escalation was not working correctly, and two users were
able to claim and work on the same tweet. (AS-37190)

¢ Fixed an issue where publishing a large video to Facebook produced an error and multiple back-to-back
postings. (AS-36176)

¢ Fixed an issue where downloaded Moderation Overview reports of specific date ranges were missing
certain sections. (AS-34917)
Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Search&Promote
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@® NOTE

Links from Adobe Analytics to all Adobe point products, including Search&Promote, have been
removed from navigation. Users of these tools can log in either via Marketing Cloud (where
supported) or directly. To log in to Search & Promote, use this
link:https://center.atomz.com/center/.

Primetime

Adobe Primetime is a multiscreen TV platform that helps media companies create and monetize engaging,
personalized viewing experiences.

Feature Description
Server Side Ad Insertion (SSAI) QoS Monitoring This is Primetime's first integration into the Adobe
Dashboard Marketing Cloud interface. The first iteration of this

Quality of Service dashboard enables you to track
SSAl request counts, request success rates and
HTTP error counts in interactive formats. More
importantly, this dashboard is expandable and will
allow Primetime to harness the Marketing Cloud
more fully.

Primetime Help Home
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/06162016.html?lang=en#previous 13/26


https://center.atomz.com/center/
https://help.adobe.com/en_US/primetime/
https://docs.campaign.adobe.com/doc/standard/en/RN.html
https://docs.campaign.adobe.com/doc/standard/en/home.html

11/6/2020 Release Notes - June 2016

Adobe Campaign v6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

AEM Help Description

AEM 6.2 Documentation Update
e Upgrading to AEM 6.2

¢ API| Reference Materials
e Adobe AEM 6.2.0 API
¢ API Differences

e Granite Ul (Touch-Optimized Ul) API
Documentation

e Coral Ul Guide (coming soon)
o Widgets API (Classic Ul) Documentation

o Ul Test Framework Javascript API
Reference

e Editor Core Javascript API Reference

¢ Testing Your Ul Using Automated Tests
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AEM Help Description

Performance tuning tips for AEM 6.x Various tuning tip to optimize the performance of
AEM 6.x.

"AEM Web Performance" presentation Delivering complex web experiences fast is

challenging. During this training you will learn,
among other things, common pitfalls to
implementation, theory, examples, and best
practices. There is also a demonstration of tooling
that covers the following areas:

e Optimization of HTTP/1.1and HTTP/2 for
network and latency.

e Identification of issues concerning slow AEM
server requests.

e Minimizing the overhead of JavaScript.

AEM hot fix releases Description

AEM 6.1 hot fixes 0OAK 1.2.14 is available for download and
installation. For additional details, check the list of
recommended hot fixes for AEM 6.1.

AEM 6.0 hot fixes OAK 1.0.30 is available download and installation.
For additional details, check the list of
recommended hot fixes for AEM 6.0.

AEM 5.6.1 hot fixes List of recommended hot fixes for AEM 5.6.1.
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AEM hot fix releases

AEM Communities 6.1 Feature Pack 4

AEM service pack releases

AEM 6. Service Pack 1

Release Notes - June 2016

Description

This feature pack includes fixes, new features, and
improvements for the release of AEM 6.1

Communities.

Description

AEM 6.1 Service Pack 1is an important update. It
includes performance, stability, security, key
customer fixes, and enhancements released since
the general availability of AEM 6.1 in May 2015. You
can install SP1 on AEM 6.1 GA.

The overview on this page lists the changes added
with SP1. Some of the key highlights of the service
pack are the following:

o The built-in repository (Apache Jackrabbit
0ak) is updated to version 1.2.7.

e Includes touch-optimized Ul update pack
(Feature Pack 6563) for AEM 6.1.

e Includes critical fixes for Adobe Target
Integration.

Release Notes

Package Share Download
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AEM service pack releases Description

AEM 6.0 Service Pack 3 AEM 6.0 Service Pack 3 (SP3) is an important
update. It includes security, performance, stability,
key customer fixes, and enhancements released
since the general availability of AEM 6.0 in May
2014. Service Pack 3 contains all changes
introduced with Service Pack 2. You can install it on
AEM 6.0 GA, AEM 6.0 SP1,and AEM 6.0 SP2.

The overview section on this page lists the changes
added with SP3. The included changes from SP2
are listed in the Service Pack 2 release notes .

The following are some key highlights of the
service pack:

e The built-in repository (Apache Jackrabbit
Oak) updated to version 1.0.22.

e It replaces Sling JCR Classloader with File
System Classloader.

Release Notes

Package Share Download

AEM security bulletin releases Description
APSB16-05 Security bulletin for Adobe Experience Manager.
AEM webinars Description
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AEM webinars Description

Gems on Adobe Experience Manager Gems on Adobe Experience Manager is a series of
technical deep dives delivered by Adobe experts.
This series complements product documentation
and technical channels, and allows developers to
get in touch and explore a specific topic.

Suggested self-help content

The following table contains a selection of links to suggested topics. These topics can help you make the most
of your implementation and use of Adobe Experience Manager.

AEM topic Description

Repository Maintenance Best Practices Learn about the two ways to perform revision
cleanup in Adobe Experience Manager.

User Interface Recommendations for Customers Adobe Experience Manager includes the classic and
touch-optimized Ul. As such, the "User Interface
Recommendations for Customers" topic can help
you decide which Ul is best for you to use. This
information comes in handy during project
implementation or when you update from an
earlier release.

Components Provides, among other things, a basic overview of
Adobe Experience Manager components, including
components in the classic Ul and the touch-
optimized UL.
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AEM topic Description

Solution Integrations Integrate Adobe Experience Manager with other
Adobe Marketing Cloud solutions and with third-
party services.

AEM with MongoDB Improve your knowledge on tasks and
considerations needed to successfully deploy
Adobe Experience Manager with MongoDB.

Best Practices for Queries and Indexing Information on when to create indexes and when
they are not needed. Also includes tips to avoid
using queries when they are not necessary, and tips
for optimizing the performance of your indexes and
queries.

Multi Site Management Use Multi Site Manager (MSM) to use the same site
content in multiple locations.

Additional resources:

e AEM Help Home
e AEM Assets, on-demand Release Notes

e Scene7 Publishing System Release Notes

Advertising Cloud help is available in the product at ? > Help Contents.

Recent documentation updates

Item Description Date Published
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Item

Getting Started with Analytics

Implementation

Adobe Experience Manager 6.2

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

Release Notes - June 2016

Description

New customers can quickly
implement Analytics using the
Getting Started with Adobe
Analytics modal, then deploy
Analytics using Dynamic Tag
Management.

Adobe Experience Manager 6.2
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,
and service pack releases.

A getting started guide for new
Analytics administrators.

A round-up of available
integration topics.

Activity Map product
documentation.

Date Published

June 16, 2016

May 19, 2016

May 15, 2016

May 15, 2016

April 14,2016
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Marketing Cloud Audiences in
Analytics

Accelerated Mobile Pages

Analytics Product Comparison

Marketing Cloud Assets

Release Notes - June 2016

Description

With the Marketing Cloud
Audiences for Analytics
integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Adobe is participating in the
Accelerated Mobile Pages (AMP)
Project. AMP is an open source
project that lets you build web
pages for static content that
renders quickly. This feature is
ideal for publishers who want to
create mobile-optimized content
once, and have it load instantly
everywhere.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Date Published

April 14, 2016

February 24,2016

February 18, 2016

February 11,2016
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Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Release Notes - June 2016

Description

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

Date Published

January 21,2016

September 17, 2015

September 17, 2015

September 17,2015
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Data Workbench 6.5 Update

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Release Notes - June 2016

Description

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

Date Published

September 17, 2015

August 20, 2015

August 20, 2015

June 18, 2015
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Freeform Analysis (public beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core
Services

Release Notes - June 2016

Description

A feature in Analysis Workspace,
freeform analysis lets you built
data tables and drag-and-drop
metrics, dimensions, segments,
and multiple visualizations to a
project panel.

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for

core services.

Date Published

June 18, 2015

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015
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Customer Attributes

Analytics Spring Release

Analytics Classification Rules -
overwrite existing values

If you capture enterprise

In Admin Tools > Classification

Release Notes - June 2016

Description Date Published

March 19, 2015

customer data in a customer
relationship management (CRM)
database, you can upload that
data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new

documentation for the Spring

2015 Analytics release.

February 19, 2015

Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any

existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.
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Documentation > Release Notes Guide > Release Notes - July 2016

Release Notes - July 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date. Please check back at release time for updates.

Release: July 21, 2016

Experience Cloud

Adobe Mobile Services

Feature Description
New permission requirement for Manage App Changing configuration settings in Manage App
Settings Settings now requires Mobile App Admin access

from Admin > Groups > Mobile App Admin .

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

Dynamic Tag Management

Feature Description

Marketing Cloud ID service tool The option to have the Marketing Cloud ID service
tool in DTM load at the top of the page is now
enabled by default.

Fix
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When the Marketing Cloud ID Service tool is added, Automatically request Visitor ID is now selected by
default. (DTM-8189)

See What's New in Dynamic Tag Management for current and cumulative release notes, help, and
documentation updates.

Marketing Cloud ID Service

This release increments the version to 1.6.0. It includes the following features, bug fixes, and other changes.
Important Notices about the Marketing Cloud ID Service
A IMPORTANT

Review the following table for crucial ID service notices that may affect implementation, data
collection, and general product functionality.

Notice Description

AppMeasurement Code Requirements Version 1.6.0 of the Marketing Cloud ID service
requires AppMeasurement for JavaScript version
1.6.3 or higher. If you want to upgrade to version
1.6.0 of the Marketing Cloud ID service, please make
sure you are using AppMeasurement code verison
1.6.3 or higher.

Features

Feature Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/07212016.html?lang=en#previous 2/27
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Feature Description

Cross-Origin Resource Sharing (CORS) CORS allows browsers to request resources from a
domain other than the current domain. The
Marketing Cloud ID service supports CORS
standards to enable client side, cross-origin
resource requests. The ID service reverts to JSONP
requests on browsers that do not support CORS.
(AAM-23988)

See:

e CORS Support in the Marketing Cloud ID

Service

e useCorsOnly

Fixes and Improvements
e Changed the default 1ocadTimeout value to 30,000 milliseconds (30 seconds) from 500 milliseconds. See
Variables Used by the ID Service getinstance Function. (MCID-96)

e Added a d_fieldgroup parameter to ID synchronization calls to dpm.demdex.net . This new parameter is
used for internal troubleshooting and debugging purposes. (MCID-94)

¢ Added a title attribute to the ID service iFrame. An iFrame title helps screen readers provide page
information to users who require assistance when interacting with online content. The iFrame title
attribute is setto Adobe ID Syncing iFrame . (MCID-81)

e Added idsyncAttachIframeASAP: true as an optional flagyou can setinthe visitor.getInstance function.
When true , the ID service loads the ID synchronization iFrame as fast as possible. This is designed to
help improve ID synchronization match rates. By default, the ID service loads the iFrame on window load.
(MCID-86)

New and Revised Documentation

¢ New: Implement the Marketing Cloud ID Service for Analytics and Audience Manager

» Revised: Test and Verify the Marketing Cloud ID Service

See also the Marketing Cloud ID Service product documentation.
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Analytics

Important Notices for Analytics Administrators

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description
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Notice

Permission changes coming in
October 2016

Release Notes - July 2016

Date Added or Updated

July 21,2016

Description

In October 2016, Analytics
administrators will be able to
manage users and product
configuration (groups) in the
Enterprise Dashboard . The
Enterprise Dashboard is the
administration interface for
Adobe's Marketing, Creative, and
Document Clouds.

You will be able to:

¢ Create product
configurations for products,
tools, products, report
suites (and more).

 Create users and assign
them to product
configurations.

e Delegate administrative
roles to users over specific
products configurations.

e Apply permissions to
specific dimensions and

metrics.

Additionally, the current Admin
Tools user management feature
will receive important
enhancements.

Note: See Administrative Product
Changes for Fall 2016 for more

information.
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Notice

AppMeasurement 1.6.3 and
Visitor API1.6.0

AppMeasurement for Flash -
Security update

Release Notes - July 2016

Date Added or Updated

August 4, 2016

April 21,2016

Description

Version 1.6.0 of the Marketing
Cloud ID service requires
AppMeasurement for JavaScript
version 1.6.3 or higher. If you
want to upgrade to version 1.6.0
of the Marketing Cloud ID
service, please make sure you
are using AppMeasurement code
verison 1.6.3 or higher.

Adobe has released a security
update APSB16-13 for the
AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;
s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers
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Notice

SSLv3

SiteCatalyst 14, ExcelClient, etc.
end of life in September 2016

Web Services v 1.2 API end-of-life

Release Notes - July 2016

Date Added or Updated

April 14,2016

March 17,2016

February 18, 2016

Description

As of early Feb 2016, Adobe
Analytics data collection and
reporting APIs no longer
supports SSL v3.

SiteCatalyst 14, ExcelClient, and a
number of other legacy
components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.
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Notice Date Added or Updated Description

UK Postal Code February 18, 2016

New Features in Analytics

Feature

All Report Suite Access

Adobe's geo service provider is
changing how we receive UK
postal codes. We will be
switching from providing
truncated UK postal codes to full
postal codes on or around March
18th.

Description

When adding report suites to include in a group,
the new option All Report Suite Access applies
group permissions to all current and future report
suites.

Te enable this feature, navigate to User
Management > Groups > Add New User Group,
then select All Report Suite Access .

Note: See Administrative Product Changes for Fall
2016 for information about important upcoming
enhancements to permissions.
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Feature Description

Analysis Workspace - Project Information panel Added an information modal at Project > Project
Information . This panel displays the following
project information:

e Project name
o Created by

¢ Last modified
o Tags

e Description

(Added June 2016) Simplified implementation for New customers who log in to Analytics via the

new customers Marketing Cloud can quickly implement Analytics
using the Getting Started with Adobe Analytics
modal, then deploy Analytics using Dynamic Tag
Management.

This simplified implementation is hosted by
Dynamic Tag Management and enables you to:

e Quickly create your first report suite.
e Run reports on basic page-level data.

¢ Deploy Analytics and the Marketing Cloud ID
service.

See Getting Started with Analytics Implementation
for details.

Analytics Fixes and Improvements

Fixes and improvements were applied to the following products and services:

Product Fixes
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Product Fixes
Analytics Web Services (SOAP and REST APIs) - Developer Connection Content Updates (Added
July 25,2016 July 25, 2016)

Updates to Classifications.CreateExport :

row_filter_empty_column (new field)
e all_rows (new field)

e campaign_filter_start_date (updated)
e row_filter_column_name (updated)
o row_filter_column_value (updated)

e element (updated)

Updates to Permissions.SaveGroup .

e all_report_suite_access (new field)

e rsid_list (edited)

Updates to Permissions.GetGroup .

e all_report_suite_access (new field)

e rsid_list (updated)

Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 APl requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.
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Product Fixes

Reports & Analytics
e Increased the display length for segment

names in the Segment panel, to avoid
truncated names. (AN-123194)

e Admin: Fixed an issue preventing activity
tracking for users who log in via the Marketing
Cloud using their Adobe ID. This fix replicates
activity tracking for users who log in
traditionally via their company name, user
name, and password. (AN-124792)

¢ Fixed an issue preventing shared calculated
metrics from being applied to non-admin
users. (AN-125412)

o Fixed a rare issue causing reports to be sent,
even if the report was not scheduled for
distribution. (AN-126552)

* Fixed a login issue occurring for users whose
default product login was SearchCenter (AN-
126281).

¢ Fixed an issue preventing reportlets from
being added to dashboards while in Layout
mode, then clicking Add Content. (AN-97419)
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Product Fixes

Analysis Workspace Fixes
¢ Scheduled projects now use the report suite

time zone rather than the browser's time zone.
(AN-126233)

e Added the ability in Scheduled Projects to
specify the width of a project's PDF. (AN-
124242)

¢ Fixed an error occurring when downloading
PDF projects when previewing them in the
Chrome browser. (AN-123674)

¢ Fixed an issue preventing components from
being placed and resized (in rare situations).
(AN-126175)

¢ Fixed a segment definition issue occurring
when adding a Browser segment and then
changing the Browser Type in the table. (AN-
126086)

¢ Fixed an issue in weekly project scheduling
that caused the day of the week to not display
properly in the interface. (AN-125760)

¢ Fixed undo functionality for sub-panel name
changes and for the Segment Comparison
Panel. (AN-125518, AN-125467)

e Improved display of visualizations that are
dragged to the Segment Comparison Panel .
(AN-125456)

 Fixed a random issue preventing project
dashboards from displaying after logging in.
(AN-124635)

¢ Fixed a sorting issue in the table for projects
that use multiple metrics and segments. (AN-
126162)
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Product

Activity Map

Report Builder

Release Notes - July 2016

Fixes

Reorganized and renamed the tabs in the
Activity Map Settings panel as follows:
e Others tab was renamed to General and
moved to the first position.

 Settings that apply to both Standard and
Live settings tabs were moved to the
General tab.

Improved the styling and layout of the Overlay
Details panel. (AN-124048)

Removed unsupported overlay metrics (New
Visitors and New Customers) from Activity
Map. (AN-124056)

Activity Map Live mode now reports on all
links present in the web page. (AN-116094)

Fixed an issue that caused calculated metrics
to not display after reloading the page. (AN-
125900)

Improved support for scheduling workbooks that
were initially opened from the Excel Web interface
through Office 365. (AN-118240
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Product Fixes

Data Warehouse
¢ Add segment support for page views in Data

Warehouse (AN-125067).

» Fixed a segment logic issue in rules where a
"0" hash value is present in the classification
lookup table (AN-125340).

¢ Added the ability to send empty reports
instead of responding with "no data." (AN-
126210)

¢ New email distribution lists created after the
interface's Virtual Report Suite changes will
now work in Data Warehouse. (AN-123842)

¢ Breakdown now supplies proper MIME types
in emails it produces (AN-124243)

e Fixed an issue preventing the display of
participation metric names. (AN-117260)

AppMeasurement (Legacy and Mobile SDKs) - AppMeasurement for JavaScript

Updated 8/4/2016
8/4/2016: Version 1.6.3

Fixed an issue where AppMeasurement
prematurely terminated request connections. (AN-
126448)

Note: Version 1.6.0 of the Marketing Cloud ID
service requires AppMeasurement for JavaScript
version 1.6.3 or higher. If you want to upgrade to
version 1.6.0 of the Marketing Cloud ID service,
please make sure you are using AppMeasurement
code verison 1.6.3 or higher.

AppMeasurement for JavaScript
Version 1.6.2

¢ Inclusion of Visitor APl 1.6.0 .
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Product Fixes

¢ Fixed an issue causing AppMeasurement to
call the wrong obfuscated method in the
Visitor API. (AN-126006)

¢ Fixed an issue causing the JavaScript error:
"Attribute only valid on v:image". (AN-124009)

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e i0OS

¢ Android

e Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )

Feature Description
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Feature Description

Sample Error Report The Sample Error Report checks success and failure
rates for processing records in your inbound data
source files. Error reporting displays data in an
interactive bar chart and provides summary
metrics in tabular form. And, it includes an option
that samples files for a fixed time interval and
displays the most common errors for each error

type.

Documentation will be available when the feature
is released at the end of July.

Advertiser Analytics Reports Updated the Advertiser Analytics reports with
Cross Channel Conversion, Role-Based Access
Control , Conversion Groups, and the Reported
Conversion Traits report.

Cross Channel Conversion The Cross Channel Conversion option in the
Advertiser Analytics reports allows you to attribute
offline conversions to served online impressions or
clicks.

Reported Conversion Traits This report shows you all the traits labeled as
conversion traits for a conversion group at a certain
date.

Fixes, Enhancements, and Deprecations

e Upgraded Google Bid Manager from v201601 to v201603. (AAM-24618)
« Fixed a bug where the Profile Merge rules reporting were showing 0. (AAM-24685)

¢ Fixed a bug where customers were unable to edit or delete user groups because of a unique key error in
the audit table. (AAM-24864)

* Fixed a bug where no limit was being enforced on S2S and Bulk S2S destinations. (AAM-24905)
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e Changed the style of the line dividing the legacy login and the Marketing Cloud. (AAM-24378)

e Fixed a bug where incorrect error messages would appear after deleting users, groups or data sources.
(AAM-24638)
New and Revised Documentation
New:

e Optimal Frequency Report
e Cross Channel Conversion

o Device Targeting with Platform-level Keys

Revised:

e Getting Started with Bulk Management. Includes a new bulk management spreadsheet.

o Geotargeting with Platform-level Keys. Includes an updated the keys list that contains the latest values.

Fixes, Enhancements, and Deprecations

Fixed an issue where replying to a tweet produced an error stating the tweet exceeded 140 characters.

Fixed an issue where toggle buttons enabling certain link shorteners were not functioning.

Fixed an issue where moderator replies were not showing in Moderation.

Fixed an issue where clicking the magnifying glass on a post within Social Buzz returned an error page.

A IMPORTANT
Effective September 15, 2016, Publish Anywhere will replace Publisher.
Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Search&Promote

-m
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~ NOTE

Links from Adobe Analytics to all Adobe point products, including Search & Promote, have been
removed from navigation. Users of these tools can log in either via Marketing Cloud (where
supported) or directly. To log in to Search & Promote, use this
link:https://center.atomz.com/center/.

Primetime

See Primetime Help Home for the latest Primetime help.
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation

Adobe Campaign v6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

AEM Help Description
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AEM Help Description

AEM 6.2 Documentation Update
e API References - Coral Ul (Touch-Optimized

Ul) API Documentation

e AEM 6.2 Security Checklist was updated.

e The AEM 6.2 eCommerce Connector
documentation now includes details on how

to install and administer Demandware:

¢ Deploying eCommerce with

Demandware

e Administering Demandware

e AEM 6.2 Application Server Install
documentation was updated.

Performance tuning tips for AEM 6.x Various tuning tips to optimize the performance of
AEM 6.x.
Gems on AEM Gems on AEM is a series of technical deep dives

delivered by Adobe experts. The series
complements product documentation and
technical channels. It also helps developers to get
in touch and explore a specific topic in detail.

AEM hot fix releases Description
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AEM hot fix releases Description

AEM 6.2 hot fixes The following new hot fix is now available:

e Hot fix 11490 -Fixes a deadlock issue with the
Sling Resource Resolver.

AEM 6.1 hot fixes The following new hot fixes are now available:

e Hot fix 10832 -Oak 1.2.16 is available for
download and installation.

e Hot fix 11074 -Improves indexing resilience for
PDF files.

Dispatcher 4.2.0 New features include the following;:

o Regular Expression (regex) support for filters
and cache rules.

 Support for HTTP persistent connection (also
known as HTTP keep-alive) on all platforms.

Download

https://www.adobeaemcloud.com/content/companie

Documentation

Suggested self-help content
The following table contains a selection of links to suggested topics. These topics can help you make the most

of your implementation and use of AEM.

AEM topic Description
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AEM topic

Repository Maintenance Best Practices

User Interface Recommendations for Customers

Components

Solution Integrations

AEM with MongoDB

Best Practices for Queries and Indexing

Multi Site Management

Additional resources:

Release Notes - July 2016

Description

Learn about the two ways to perform revision
cleanup in AEM.

AEM includes the classic and touch-optimized Ul.
As such, the "User Interface Recommendations for
Customers" topic can help you decide which Ul is
best for you to use. This information comes in
handy during project implementation or when you
update from an earlier release.

Provides, among other things, a basic overview of
AEM components, including components in the
classic Ul and the touch-optimized Ul.

Integrate AEM with other Adobe Marketing Cloud
solutions and with third-party services.

Improve your knowledge on tasks and
considerations needed to successfully deploy AEM
with MongoDB.

Information on when to create indexes and when
they are not needed. Also includes tips to avoid
using queries when they are not necessary, and tips
for optimizing the performance of your indexes and
queries.

Use Multi Site Manager (MSM) to use the same site
content in multiple locations.
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e AEM Help Home
e AEM Assets, on-demand Release Notes

e SPS Release Notes

Advertising Cloud

Advertising Cloud help is available in the product at ? > Help Contents.

Recent documentation updates

Item Description Date Published
Administrative Product Changes Important announcement about  July 21,2016
for Fall 2016 permission changes coming in

Fall 2016.

Adobe Experience Manager 6.2 Adobe Experience Manager 6.2 May 19, 2016
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,
and service pack releases.

Getting Started with Analytics A getting started guide for new May 15, 2016
Analytics administrators.

Marketing Cloud Integrations A round-up of available May 15, 2016
integration topics.
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Item

Activity Map

Marketing Cloud Audiences in
Analytics

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

Release Notes - July 2016

Description

Activity Map product
documentation.

With the Marketing Cloud
Audiences for Analytics
integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Added documentation for new
features in Analysis Workspace.

Date Published

April 14,2016

April 14, 2016

February 18, 2016

February 11, 2016

January 21, 2016
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Item

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Data Workbench 6.5 Update

Release Notes - July 2016

Description

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use

cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Date Published

September 17, 2015

September 17, 2015

September 17, 2015

September 17, 2015
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Item

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Analysis Workspace (public
beta)

Data Workbench 6.4

Release Notes - July 2016

Description

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

Build data tables and drag-and-
drop metrics, dimensions,
segments, and multiple
visualizations to a project panel.

Data Workbench 6.4 release
includes several new features
described here.

Date Published

August 20, 2015

August 20, 2015

June 18, 2015

June 18, 2015

June 18, 2015
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Item

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - July 2016

Description Date Published

Added Adobe Managed
Certificate Program to the

May 22, 2015

revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

May 22, 2015

A high-level round-up what you March 19, 2015
need to do to modernize your
solution implementations for

core services.

If you capture enterprise March 19, 2015
customer data in a customer

relationship management (CRM)

database, you can upload that

data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.
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Item

Analytics Classification Rules -

overwrite existing values

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/07212016.html?lang=en#previous

Release Notes - July 2016

Description

In Admin Tools > Classification
Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

Date Published

February 19, 2015

27127


https://marketing.adobe.com/resources/help/en_US/reference/classification_rule_set.html

11/6/2020 Release Notes - August 2016

Documentation > Release Notes Guide > Release Notes - August 2016

Release Notes - August 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date. Please check back at release time for updates.

Last Update - August 25, 2016

Experience Cloud

Marketing Cloud ID Service
This release increments the ID service code to version 1.7.0. It includes the following features, bug fixes, and
other changes.

Fixes and Improvements

e Added idsyncAttachIframeonWindowLoad asan optional Boolean flag you can setin the
Visitor.getInstance function. When idsyncAttachIframeOnWindowLoad= true ,the ID service loads the ID
synchronization iFrame on window load. By default, the ID service loads the iFrame as fast as possible.
This flag replaces idsyncattachIframeAsap , which is deprecated. See Variables Used by the ID Service
getinstance Function. (MCID-122)

¢ Added functionality to support tracking Marketing Cloud IDs across domains, native apps and hybrid apps
to web transitions. See Append Visitor ID Helper Function. (MCID-42)

e Added functions to visitorAPLjs code that determine if the ID service has generated the visitor Marketing
Cloud ID client-side or server-side or if ID calls timed out. See Timeout Tracking Functions and Tracking
Client-side Visitor ID Generation. (MCID-116)

Known Issues

Customers using Audience Manager DIL code and visitorAPLjs code on the same page should set the DIL

variable securebataCollection= false .See secureDataCollection.

Maintenance Release: August 18, 2016
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Analytics

New features and fixes for Analytics.

Important Notices for Analytics Administrators

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description
Timeout increase from 30 to 60 August 19, 2016 To improve data integrity, we
seconds have changed the Visitor APl and

AppMeasurement in
coordination with Adobe Target.
This improvement increases the
latency of the data by 30
seconds.

This change affects only
customers using the Marketing
Cloud ID service,
AppMeasurement for Analytics,
and who have Target
implemented on their pages.
(AN-128584)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous
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Notice

Legacy Alerts

Data Warehouse request settings

AppMeasurement 1.6.3 and
Visitor API1.6.0

Release Notes - August 2016

Date Added or Updated

August 18, 2016

August 18, 2016

August 4, 2016

Description

Several features of existing
Analytics alerts will not be
included in the new Alert
Manager , which will be released
(as part of Analysis Workspace )
in the Fall of 2016.

Legacy Alerts Migration lists the
deprecated alert features and
some alert features that will be
migrated to the new Alert
Manager in a different form.

In the September 2016
Maintenance Release, Data
Warehouse will add a new
request setting that will enable
Data Warehouse to send empty
files when there is no data in the
report. This settings will be
enabled by default.

Version 1.6.0 of the Marketing
Cloud ID service requires
AppMeasurement for JavaScript
version 1.6.3 or higher. If you
want to upgrade to version 1.6.0
of the Marketing Cloud ID
service, please make sure you
are using AppMeasurement code
verison 1.6.3 or higher.
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Notice Date Added or Updated Description
AppMeasurement for Flash - April 21,2016 Adobe has released a security
Security update update APSB16-13 for the

AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers
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Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:
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Notice

Release Notes - August 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

e Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous 7125
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 404 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

New Features in Analytics

Feature Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous 8/25
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Feature

Data Feeds' expanded communication to AWS
regions (AN-118446)

Data Warehouse: Support for ranking line items
(AN-125562)

Release Notes - August 2016

Description

Data Feeds can now communicate to the following
11 standard AWS regions (using the appropriate
signature algorithm where necessary):

us-east-1

e us-west-1

e us-west-2

e ap-south-1

e ap-northeast-2
¢ ap-southeast-1
¢ ap-southeast-2
¢ ap-northeast-1
e eu-central-1

e eu-west-1

e 53-east-1

We currently do not support the Beijing, China AWS
region (cn-north-1).

Data Warehouse reporting now supports ranking
line items by the supplied metric or metrics. When
sorting is in use, if you also choose to limit the
number of rows in the table (DW advanced settings
page), the report will return the "Top N" values with
respect to the metric you are sorting by.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous
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Feature Description

Data Warehouse: Change in column naming logic In the July maintenance release, the column
naming logic for Data Warehouse file was changed.
Previously, if the evarl name was "ABC", the column
name would be "ABC (evar1)".

In cases where the variable already contained the
identifier, this became redundant:

e Variable name ABC (evar1) &gt;&gt; Column
Name ABC (evar1)(evar1)

The updated logic looks out for this and makes sure
that the name doesn't have a redundant identifier:

e Variable name ABC (evar1) &gt;&gt; Column
name ABC (evar1)

e Variable name ABC &gt;&gt; Column name
ABC (evar1)

Video Analytics: Concurrent Viewers report The Video Concurrent Viewer Report displays
concurrent viewers during one day. The data can be
filtered by content, device type, or country. More...

Analytics Fixes

Fixes were applied to the following products and services:

Product Fixes

Reports & Analytics
¢ Fixed an issue that prevented calculated

metrics from working with the “Try in
Workspace” option when running the Key
Metrics report. (AN-126181)
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Product Fixes

Analysis Workspace Fixes
Fixed an issue where the breakdown of the

‘Week’ dimension by ‘Days’ resulted in
including days of different weeks. (AN-123821)

e Fixed an issue where, when switching to a
different report suite, the project’s currency
code was not updated. (AN-123821)

¢ Fixed an issue that occasionally prevented
projects with text visualizations from being
downloaded. (AN-124982, AN-127546)

e Fixed an issue where the time zone reflected
in the PDF file did not match the report suite's
time zone. (AN-127547)

¢ Fixed an issue that prevented users from
clicking “Limit Max Items” a second time in a
freeform table. (AN-126717)

¢ Fixed an issue that caused the first instance in
a series of scheduled reports to be skipped.
(AN-127200)

AppMeasurement (Legacy and Mobile SDKs) AppMeasurement for JavaScript
JavaScript Version 1.6.4

¢ Updated AppMeasurement to read and write
AMCV cookies. (AN-127098)

¢ Inclusion of Visitor AP 1.7.0 .

Note: Also see the August 4 release notes for
JavaScript version 1.6.3, which includes updated
requirements for Marketing Cloud ID service.

AppMeasurement for Flash
Flash Version 4.0.2

¢ Inclusion of Visitor API 1.6.0.
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Product Fixes
AppMeasurement for Other Platforms
See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:
e JavaScript
e i0OS
¢ Android
e Flash-Flex
e OSX
¢ Windows Phone, XBOX, Silverlight, and .NET
o BlackBerry
e Java
e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )

Data Workbench See Data Workbench Release Notes .

Audience Manager

Updated August 25

Feature Description
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Feature Description

Audience Lab Audience Lab lets you split baseline segments into
mutually exclusive test segments. Test segments
can be used to evaluate different variables (e.g,,
targeting platforms or targeting criteria) while
controlling for an audience variable. Customers can
create up to 10 multivariate tests at a time. See the
Audience Manager documentation for more
information.

Known issues in Mozilla Firefox and Internet
Explorer: When viewing reporting for a test:

e The default conversion trait selection is "None'

but the data will show. The "None" option
actually shows data for "All Traits".

e The graphs will have one color for each test
segment displayed. Selecting a conversion or
tab will fix the issue.

e The trend graph will show 14 days of data but
the selector will say "Last 7 Days". Selecting a
different reporting range will put the graph
and selector in sync.

A patch release to address these issues is in
development.

Fixes and Enhancements

e Added new reporting features to Addressable Audiences. (AAM-24411)

o Fixed a Segment Builder bug that prevented you from adding traits to new segments when using Chrome.

(AAM-24994)

 Fixed a bug that prevented administrators from assigning permissions to groups with a large number of
data sources. (AAM-24870)

 Fixed a bug that prevented segment folders from expanding and showing sub-folders or segments. (AAM-

25054)
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¢ Fixed a bug in the Onboarding Status Report that shifted the date range 1-day earlier than the selected
date. (AAM-25484)

* Fixed a broken link to help documentation in Data Source Settings. (AAM-25447)

DIL Bug Fixes, Enhancements, and Deprecated Code

DIL is the API data collection code for Audience Manager. The July release increments DIL to version 6.5.
Upgrade to the latest version to take advantage of these features and fixes.
« Fixed a bug that prevented DIL code from being deployed in Firefox. (AAM-24708)

e Added a title attribute to the DIL iFrame. An iFrame title helps screen readers provide page information to
users who require assistance when interacting with online content. (AAM-25317)

e Added DIL support for Cross-Origin Resource Sharing (CORS). See useCorsOnly. (AAM-25319, AAM-20139).

e The DIL iFrame supports the iframe.sandbox="allow-scripts allow-same-origin'; attributes. Allowing only
these 2 tokens helps improve security. For more information, see the Attributes section in this iFrame
documentation. (AAM-23335)

¢ DIL now makes secure, HTTPS calls by default. Customers using Audience Manager DIL code and
visitorAPLjs code on the same page should set the DIL variable securepatacollection= false .See
secureDataCollection.

Fixes, Enhancements, and Deprecations

¢ Increased frequency and lifetime of Facebook metrics data collection. New data collection time frame is
as follows:

¢ All Facebook metrics are collected every hour for the first 72 hours after a post is posted.
¢ Continue data collection every 8 hours for the next 72 hours.
¢ Continue data collection daily thereafter for the next 60 days.

e Added a Geotarget column for Twitter in the Post Analytics report export.

¢ Five new Facebook reaction metrics are now available in both Post Analytics and Property Analytics
reports. They include: Love, Wow, Sad, Haha, and Angry. In an upcoming release, Facebook reactions
metrics will also be available in Adobe Analytics reports.

 Fixed an issue where clicking the magnifying glass on a private Twitter post within Social Buzz looped you
back to the same page instead of opening the original post in Twitter.

¢ Fixed an issue where some escalated tweets were unable to be claimed.
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¢ Fixed an issue where Social Buzz reports generated on different days were dropping certain posts.

¢ Fixed an issue where changing feed settings within Unified Moderation did not save after logging out and
backin.

e Fixed an issue where URLs in quoted tweets were taking up more than the expected 24 characters.

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic

Search&Promote

@® NOTE

Links from Adobe Analytics to all Adobe point products, including Search & Promote, have been
removed from navigation. Users of these tools can log in either via Marketing Cloud (where
supported) or directly. To log in to Search & Promote, use this
link:https://center.atomz.com/center/.

Primetime

Adobe Primetime is a multiscreen TV platform that helps media companies create and monetize engaging,

personalized viewing experiences.

Feature Description
Server Side Ad Insertion (SSAI) QoS Monitoring This is Primetime's first integration into the Adobe
Dashboard Marketing Cloud interface. The first iteration of this

Quality of Service dashboard enables you to track
SSAl request counts, request success rates and
HTTP error counts in interactive formats. More
importantly, this dashboard is expandable and will
allow Primetime to harness the Marketing Cloud
more fully.
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Primetime Help Home
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation

Adobe Campaign V6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

AEM Help Description

AEM 6.2 Documentation Update e Improved AEM 6.2 Mobile documentation .

e Improved HTML Template Language (formerly
Sightly) documentation.

¢ Updated documentation to describe new AEM
6.2 Translation features:
https://docs.adobe.com/docs/en/aem/6-
2/administer/sites/translation.html and
subpages.
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AEM Help

Gems on AEM

AEM hot fix releases

AEM 6.2 hot fixes

Security hot fixes

Release Notes - August 2016

Description

Gems on AEM is a series of technical deep dives
delivered by Adobe experts. The series
complements product documentation and
technical channels. It also helps developers to get
in touch and explore a specific topic in detail.

Description

The following new hot fixes are now available:

e Hot fix 11490 -Fixes a deadlock issue with the
Sling Resource Resolver.

e Hot fix 11700 -Thread Dump Collector fixes.

Adobe released security hot fixes for Adobe
Experience Manager. These hot fixes resolve two
validation issues that could be used in cross-site
scripting attacks (CVE-2016-4168 and CVE-2016-
4170):

e Animportant vulnerability in backup
functionality that could lead to information
disclosure (CVE-2016-4253).

¢ Animportant vulnerability that could disclose
audit log events to unprivileged users (CVE-
2016-4169). See

https://helpx.adobe.com/security/products/expe

manager/apsb16-27.html
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Suggested self-help content

The following table contains a selection of links to suggested topics, events, and webinars that can help you
make the most of your implementation and use of AEM.

AEM-related information Description

Link to article Create an AEM HTML Template Language
component that uses the WCMUsePojo class.

Community calendar Join peers in your area or, if you are traveling, join a
user group meeting. A list of each events is
available from the Community calendar.

Join your peers at AEM Developer Events The following are two upcoming @AEM_Dev
events:

e EVOLVE hosted by 3Share, August 29-31in San
Diego. Tickets are available at the following:
https://evolve.3sharecorp.com.

e adaptTo() hosted by Pro!Vision, September
26-28 in Berlin. Tickets are available at the
following: https://adapt.to/2016/en.html.

Ask the AEM Experts On August 23, 2016, join Lokesh BS and Scott
Macdonald for a discussion on how to use AEM
eCommerce.

The session covers the eCommerce Framework,
including how to use the eCommerce APIs. By
joining this session, you can gain a deeper
understanding of how to use the AEM eCommerce
framework and associated APIs.

Sign up for the session here..
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AEM-related information Description

AEM webinar On August 17, 2016, attend the webinar "How to
setup and configure Dynamic Media".

Topics covered in the webinar include the
following;:

¢ Dynamic Media use cases.
¢ Technical architecture.
¢ How to configure Dynamic Media in AEM 6.2.

¢ Setup and best practices for Dynamic Media
imaging.

¢ Setup and best practices for Dynamic Media
video.

Register for the webinar here..

Additional resources:

e AEM Help Home
e AEM Assets, on-demand Release Notes

e SPS Release Notes

Advertising Cloud

Advertising Cloud help is available in the product at ? > Help Contents.

Recent documentation updates

Item Description Date Published
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Item

Administrative Product Changes
for Fall 2016

Adobe Experience Manager 6.2

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

Release Notes - August 2016

Description

Important announcement about
permission changes coming in
Fall 2016.

Adobe Experience Manager 6.2
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,
and service pack releases.

A getting started guide for new
Analytics administrators.

A round-up of available
integration topics.

Activity Map product
documentation.

Date Published

July 21,2016

May 19, 2016

May 15, 2016

May 15, 2016

April 14,2016
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Item

Marketing Cloud Audiences in
Analytics

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

(Updated) Users and Groups

Release Notes - August 2016

Description

With the Marketing Cloud
Audiences for Analytics
integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Added a product comparison
table for Analytics products.

In Marketing Cloud Assets, you
can store, share, and synchronize
your digital assets from one
central location. Marketing
Cloud Assets leverages some of
the features available in Adobe
Experience Manager (AEM).

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Date Published

April 14, 2016

February 18, 2016

February 11,2016

January 21, 2016

September 17, 2015
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Analysis Workspace

Timestamps Optional

Data Workbench 6.5 Update

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/08182016.html?lang=en#previous

Release Notes - August 2016

Description

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

See Data Workbench 6.5 release
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Date Published

September 17,2015

September 17, 2015

September 17,2015
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Item

Select Report Suites and
Variables

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Analysis Workspace (public
beta)

Data Workbench 6.4

Release Notes - August 2016

Description

Updated the Classification Rule
Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link works with cross-
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

Calculated Metrics now allow for
segmented metrics, more
advanced math and the ability to
organize and share metrics.

Build data tables and drag-and-
drop metrics, dimensions,
segments, and multiple
visualizations to a project panel.

Data Workbench 6.4 release
includes several new features
described here.

Date Published

August 20, 2015

August 20, 2015

June 18, 2015

June 18, 2015

June 18, 2015
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https://marketing.adobe.com/resources/help/en_US/aam/profile-link-intro.html
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Item

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - August 2016

Description Date Published

Added Adobe Managed
Certificate Program to the

May 22, 2015

revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

May 22, 2015

A high-level round-up what you March 19, 2015
need to do to modernize your
solution implementations for

core services.

If you capture enterprise March 19, 2015
customer data in a customer

relationship management (CRM)

database, you can upload that

data into the Marketing Cloud.

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.
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Analytics Classification Rules -

overwrite existing values
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Release Notes - August 2016

Description

In Admin Tools > Classification
Rule Builder > &lt;rule set
name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

Date Published

February 19, 2015
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Documentation > Release Notes Guide > Release Notes - September 2016

Release Notes - September 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date. Please check back at release time for updates.

September 2016

Experience Cloud

Marketing Cloud 16.81
New features and fixes in the Adobe Marketing Cloud interface and core services.

Release date: September 15, 2016

Feature Description
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Feature Description

Marketing Cloud Triggers Triggers bring together Analytics and Campaign,
enabling marketers to define and monitor key
consumer behaviors, and then generate cross-
solution communication for use in real-time
decisions and personalization. For example, you
can create triggers for:

¢ Re-marketing for cart abandons or cart
abandons with products removed.

e Session start or session end events.

¢ Any actions or sequence of actions on site,
such as incomplete forms and applications.

Configuration:

o Create triggers from Analytics data at
Marketing Cloud > Activation > Triggers .

¢ Use these triggers for real-time remarketing in
Adobe Campaign .

See Marketing Cloud Product Documentation for product help.

Marketing Cloud ID Service
This release increments the ID service code to version 1.8.0. It includes the following features, bug fixes, and
other changes.

Fixes and Improvements

Added disableThirdPartyCalls as an optional, Boolean flag you can setin the visitor.getInstance function.
When disableThirdPartyCalls= true , the ID service will not make calls to other domains. By default,
disableThirdPartyCalls= false . See disableThirdPartyCalls. (MCID-51)

See Marketing Cloud ID Services product documentation.

Adobe Mobile Services

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous
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Feature Description

Android: In-App Messaging Added a new message type that opens a deep link
URI.

Android: Tracking Deep Links Added the ability to enable tracking of 3rd party

deferred deep links.

e processAdobeDeeplLink

iOS: In-App Messaging Added a new message type that opens a deep link
URI.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

Analytics

Release date: September 15, 2016

Important Notices for Analytics Administrators

A IMPORTANT

Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description
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Notice

Schedule Traffic Spike Deadline

Ad Hoc Analysis - Java 1.7.

Analytics API 1.3 deprecation.

Release Notes - September 2016

Date Added or Updated

September 23, 2016

September 15, 2016

September 15, 2016

Description

If you have report suites that you
expect to receive increased
traffic during the holiday season
(particularly Black Friday, Cyber
Monday, Christmas, or New
Year's), please schedule traffic
spikes as soon as possible.

See Importance of Scheduling
Traffic Spikes for more

information.

In the upcoming October 2016
release, you must use Java 1.7 or
later to launch Ad Hoc Analysis.

If you use Java version 1.6 or
earlier, you will see an error
message, "Unable to Launch the
Application." (On the error
message, you can view the Java
version that you are using by
clicking Details , then click the
Console tab.)

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous
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Notice Date Added or Updated Description
Analytics for Target processing August 19, 2016 To achieve a higher visitor match
time increased by 30 seconds. rate between Adobe Analytics

and Adobe Target, we have
increased the amount of time
data is held in processing from
30 seconds to 60 seconds. This
change only affects customers
using the Marketing Cloud ID
service, AppMeasurement for
Analytics, and who have Target
implemented on their pages.
(AN-128584)

Legacy Alerts August 18, 2016 Several features of existing
Analytics alerts will not be
included in the new Alert
Manager , which will be released
(as part of Analysis Workspace )
in the Fall of 2016.

Legacy Alerts Migration lists the
deprecated alert features and
some alert features that will be
migrated to the new Alert
Manager in a different form.

Data Warehouse request settings ~ August 18, 2016 In the September 2016
Maintenance Release, Data
Warehouse will add a new
request setting that will enable
Data Warehouse to send empty
files when there is no data in the
report. This settings will be
enabled by default.
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Notice

AppMeasurement 1.6.3 and
Visitor API1.6.0

AppMeasurement for Flash -
Security update

Release Notes - September 2016

Date Added or Updated

August 4, 2016

April 21,2016

Description

Version 1.6.0 of the Marketing
Cloud ID service requires
AppMeasurement for JavaScript
version 1.6.3 or higher. If you
want to upgrade to version 1.6.0
of the Marketing Cloud ID
service, please make sure you
are using AppMeasurement code
verison 1.6.3 or higher.

Adobe has released a security
update APSB16-13 for the
AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;
s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers
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6/34


https://helpx.adobe.com/security/products/analytics/apsb16-13.html
https://www.owasp.org/index.php/DOM_Based_XSS

11/6/2020 Release Notes - September 2016

Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in September 2016 number of other legacy

components will reach end-of-
life in September 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:
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Notice

Release Notes - September 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

e Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous 9/34
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 410 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

New Features in Analytics

Feature Description
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Feature Description

Time Zone Selection for Virtual Report Suites You can now choose a time zone when creating a
virtual report suite.

If you choose one, it will be saved along with the
virtual report suite. If you do not choose one, the
time zone of the parent report suite is used.

When editing a virtual report suite, the time zone
that it was created with displays in the drop-down
selector. If the virtual report suite was created
before time zone support was added, the parent
report suite's time zone is displayed in the drop-
down selector.

Also, if you create a virtual report suite with a time
zone that differs from the parent report suite's time
zone, and then copy that virtual report suite, the
copied virtual report suite will reference the parent
report suite's time zone unless you manually
update the time zone.
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Feature

Permission Changes in Analysis Workspace (AN-
125014)

Dimension name change in Segment Builder

Release Notes - September 2016

Description

The following permission changes were
implemented for Analysis Workspace.

Previously, you needed the following permissions
to create segments or metrics in Analysis
Workspace:

e Segment creation

e Calculated metric creation

e Create/Curate projects in Analysis Workspace

With this release, you only need these permissions:

e Segment creation

e Calculated metric creation

If you want to restrict your non-admin users from
creating new segments and metrics in curated
Analysis Workspace projects, use the permission
setting to limit the relevant group’s ability to create
segments and metrics.

These permissions are accessible via Admin > User
Management > Groups > [click group] > Report
Access > Advanced Reporting .

The Full Domain dimension in the Segment Builder
has been renamed to Domains to match the
permission name. (AN-129355)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous

12/34



11/6/2020 Release Notes - September 2016

Feature Description

Data Warehouse Updates ¢ New setting for delivering empty Data
Warehouse files. This setting delivers empty
Data Warehouse reports containing only a
header row when there are no rows in the
result set. (AN-126249).

o New Date Started field set to the report suite's
time zone. The start date and completed date
represent the round trip time. (AN-126155)

e Timezone overrides have been enabled for
Virtual Report Suites.

Activity Map Updates ¢ Activity Map now supports web sites that
default their page name to their page URL.
(AN-129703)

e Activity Map now supports all calculated
metric formats (decimal, time, percent, and
currency) in the Links on Page report, the
Bubble and Gradient overlays, and the Overlay
Details panel. (AN-124059)

Analytics Fixes

Fixes were applied to the following products and services:

Product Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous 13/34
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Product

Reports & Analytics

Release Notes - September 2016

Fixes

Mobile device breakdowns for reports are no
longer available for certain reports. As a
workaround, run the Device Report and add
the relevant metric to the report. ( AN-126460)

Fixed a segmentation issue where segments
that involved dates that were outside the date
range of the report suite did not work
properly. (AN-123911)

Fixed a segment editing error occurring if the
segment owner had been deleted. Deleted
segment owners now show up as Unknown
User in the log. (AN-129554)

Fixed a dashboard issue that prevented the
download of dashboards that contained
fallout reportlets with non-existing
checkpoints. (AN-123380)

Fixed an issue with editing virtual report suites
- an error was thrown when no changes were
made and Save was clicked. (AN-128077)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous
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Product

Analysis Workspace

Data Warehouse

Data Sources

Release Notes - September 2016

Fixes

Fixed an issue that prevented the Send File
Now functionality to work properly. (AN-
128055, AN-128057)

Fixed an issue that let administrators click
Delete more than once when deleting a user,
thereby causing Analysis Workspace projects
to disappear. (AN-127911)

Fixed an issue that prevented curated and
shared Analysis Workspace projects from
showing the same data to different users. (AN-
126558)

Fixed an issue with downloading Analysis
Workspace projects in .pdf format. (AN-
127277)

Fixed an issue that caused the time zone for
date_scheduled to be incorrectly calculated.
(AN-126155)

Segments containing literal backslashes, tabs,
or newline characters in string rules are now
evaluated correctly. (AN-129552)

Fixed an issue in rule builder where rule sets
would not activate. (AN-127762)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous

15/34



11/6/2020 Release Notes - September 2016

Product Fixes
AppMeasurement (Legacy and Mobile SDKs) AppMeasurement for JavaScript
Version 1.7.0

¢ Update AppMeaurement Audience Manager
Module with DIL 6.5 and Additional
Configurations (AN-129411)

e Inclusion of Visitor API 1.8.0 (AN-129887)

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e i0OS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )
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Product Fixes
Analytics Web Services (SOAP and REST APIs) Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 APl requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 410.

Data Workbench See Data Workbench Release Notes .
Feature Description
Addressable Audience 1.1 enhancement This update improves the accuracy of segment-

level addressable audience and presents the
current segment-level audience reach for campaign
planning and review. See Addressable Audiences.

Fixes and Enhancements

« Fixed an issue where the Help Modal was not working on the Profile Merge Rules page. (AAM-25712)

e Fixed an issue in Audience Lab where no warning would appear that you have not mapped all selected
destinations when navigating to “Finalize” step. (AAM-25877)

e Fixed an issue in Audience Lab where “Invalid date” would show on the Test Group Information page
when no end date was specified on the Destination Mappings page. (AAM-26016)

 Fixed an issue in Audience Lab where, in the edit baseline segment modal, [object Object] would appear
instead of the baseline segment creator. (AAM-26057)

e Fixed an issue where for Audience Lab and Profile Merge, "Adobe Audience Manager | undefined” would
appear in the browser tab title. (AAM-26091)
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e Fixed an issue in the Create Test Groups flow in Audience Lab where no warning message would appear
in case you left any destinations unmapped. (AAM-26109)

¢ Fixed an issue when you tried to edit Destinations, an alert box would appear and the Destination could
not be edited. (AAM-26191)

Improvements
e Removed the “OK_With_Unused_Signals” error from the error list in the Onboarding Status Report.
(AAM-25240)

¢ In Audience Lab, we now remind you to download the CSVs before deleting any Segment Test Groups.
(AAM-25581)

e The API now returns more accurate Segment Addressable Audience numbers. (AAM-25460)

e The Destination and Segments pages now show actual numbers instead of estimated numbers for
Segment Addressable Audience. (AAM-25461)

Fixes, Enhancements, and Deprecations

e Publish Anywhere has replaced Publisher. Get familiar with the improved features.
e New Facebook page-level and post-level video metrics are available. View new metrics.

¢ A post retweeted from within Adobe Social now appears the same as when it is retweeted natively in
Twitter. For more information, see Moderate an Individual Tweet and Post a Quoted Tweet.

 Social tags will be available in Adobe Analytics after October 1 (exact date TBD).

e After October 1, Adobe Social users will be able to use social tags to classify outbound content and
report on this content within Adobe Analytics. To get on this list for access to this new feature, please
contact your Adobe Social account manager or Social Support. From there you will receive updates
on next steps regarding gaining access as well as enablement assistance.

 Fixed an issue within Post Analytics where the filter was unable to distinguish between images and links
posted on LinkedIn.

e Fixed an issue where publishing a post with an attached link would post without the link.

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

e Recommendations Classic
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Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

o Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation

Adobe Campaign V6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

Title Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous 19/34


https://docs.campaign.adobe.com/doc/standard/en/RN.html
https://docs.campaign.adobe.com/doc/standard/en/home.html
https://docs.campaign.adobe.com/doc/AC6.1/en/RN.html
https://docs.campaign.adobe.com/doc/AC6.1/en/home.html

11/6/2020 Release Notes - September 2016

Title Description
Product releases AEM Communities Feature Communities 6.2 Feature Pack 1
Packs and 6.1 Feature Pack 5 released

on August 30, 2016. The release
includes the following:

e Adobe Social Resource
Provider.

¢ Social Component
Framework Enhancements.

o Bulk Moderation.
¢ Turnkey Community Sites.

¢ Platform updates and

Samples.
Mobile 2016.11 Mobile update release .
Livefyre releases Livefyre update release .
Product maintenance releases S3 Connector Version 1.4.4 of the S3 Connector

is available for AEM 6.2 .

Version 1.2.2 of the S3 Connector
is available for AEM 6.1.
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Title Description

AEM 6. Service Pack 2 AEM 6.1 Service Pack 2 includes
the following:

¢ The built-in repository
(Apache Jackrabbit Oak) is
now updated to version
1.2.16.

¢ Improvements were made
between Oak versions 1.2.7
(included in AEM 6.1 SP1)
and 1.2.16 (included in SP2).

¢ Removal of discrepancies
and errors in the process
editing presets of assets.

¢ Increased responsiveness of
the author modes and
improved functional
components in Sites, such
as the carousel component.

For more information, see AEM
6.1 SP2 release notes .
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Title Description

AEM 6.1 Cumulative Fix Pack 1 To improve the customer
experience for maintaining AEM,
the hot fix delivery model for
AEM is changing for AEM 6.1.

Instead of releasing hot fixes for
single issues, a CFP (Cumulative
Fix Pack) is planned for release
every month. A CFP has the
following advantages for single
hot fixes:

¢ Increased level of quality
assurance.

o Simplified installation
experience. That is, no
dependencies except the
latest Service Pack.

e Itis a cumulative package.
For example, CFP 3 will
contain all the fixes from
CFP 2 and CFP1.

AEM hot fixes The following new hot fixes are
available:

AEM 6.2 - Hot fix 11687 - Oak
14.5.

AEM 6.1 - Hot fix 11309 - Oak
1.2.17.

Self-help AEM 6.2 documentation updates ¢ Improved AEM 6-2 SEO and
URL documentation .

e Improved Administering
Workflows documentation
including the following:
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Title Description
e Starting Workflows .

e Administering
Workflow Instances .

e Managing Access to
Workflows .

¢ Improvements to the MSM
documentation, including
the following:
e MSM - Live Copies -

Composition .

e Extending MSM -
Overview of the Java
API .

e The AEM 6.2 Uberlar,
containing all public Java
APIs exposed by Adobe
Experience Manager is now
publicly available and
documented.

o Assets Best Practices - Best
practices for Assets
performance tuning, Sizing,
Migration, and Network
Considerations. These best
practices provide
knowledge about processes
and tools to build and
manage an enterprise asset
management system that
meets your needs.

e Maintenance Release
Vehicle Definitions - Details
about the various types of
Adobe Experience Manager
releases, including full
releases, feature packs, and
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Title Description

services packs that Adobe
delivers to customers.

e A new Recent
Documentation Updates
page was created for AEM
6.2, AEM 6.1, and AEM
Assets. The page identifies
all updates made to the
online documentation for a
given 90 days.

AEM Forms

e Improved AEM Forms
reference site
documentation, including
the following:

e Set up and configure
AEM Forms reference
sites .

e Geometrixx Gov
reference site

walkthrough .

e Geometrixx Finance
reference site

walkthrough .

o Reference themes and
fragments packages for
adaptive forms are now
documented and available.

Knowledgebase article A new knowledgebase article is
now available regarding a
performance issue related to the
usage of AEM with Java7 .
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Title Description

Community AEM Community article A new article detailing all the
steps to build an e-commerce
provider is now available.

See Creating custom Adobe
Experience Manager 6.2

eCommerce providers.

Upcoming local user group Join peers in your area or, if you

meetings are traveling, join a user group
meeting. Adobe Systems lists
each of the events on the
community calendar here .

The Seattle User Group has two
upcoming meetings. See details
at
https://www.meetup.com/Seattle-
Adobe-CQ-AEM-Meetup-Group/

The Melbourne Adobe

Experience Manager Meetup

group is hosting a code contest.

The deadline to register your

teams for presenting at the

Adobe Marketing Cloud -

Community Expo (AMCCE) is

September 30, 2016. You can

register at the following:
https://www.surveymonkey.com/r/R596336

The next meeting for the
Amsterdam, Netherlands AEM
User Group is November 3, 2016.
You can RSVP here.
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Ask the AEM Community
Experts webinars
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Title

The recorded August webinar
titled, "AEM and eCommerce" is
available to watch at the
following:

e Adobe Connect version -
https://adobe.ly/2bHWkgF .

e MP4 version -
https://adobe.ly/2bHWmF9

RSVP for the September webinar
titled "Best Practices for
Experience Manager and AEM
Assets" here .

Description
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Title Description

AEM GEMs webinars The last recorded GEM webinar
titled "Setup and Configure AEM
Dynamic Media" is available to
watch at the following:

e Connect version -
https://adobe.ly/2b1T5WG .

e MP4 version -
https://adobe.ly/2b1SODb .

AEM GEMS webinar titled
"Managing your content with the
template editor of Adobe
Experience Manager" is
scheduled for September 14,
2016. You can RSVP here..

To access all past AEM GEM
webinar recordings, slide decks,
and code links, see

www.adobe.com/go/gems .

adaptTo() AEM Developer Community
event hosted by Pro!Vision,
September 26-28 in Berlin.

Tickets are available at the
following:
https://adapt.to/2016/en.html .
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IMMERSE 2017

Additional resources:

e AEM Help Home

Release Notes - September 2016

Title

Mark your calendars for the
week of May 15-19, 2017 for
IMMERSE 2017.

Watch the AEM Technologist
Calendar for the "Call for
Presentations" and Early Bird
Registrations.

e AEM Assets, on-demand Release Notes

e SPS Release Notes

Recent documentation updates

Item

Marketing Cloud Triggers

Administrative Product Changes
for Fall 2016

Description

Identify, define, and monitor key
consumer behaviors, and then
generate cross-solution
communication to re-engage
visitors.

Important announcement about
permission changes coming in
Fall 2016.

Description

Date Published

September 15, 2016

July 21,2016
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Item

Adobe Experience Manager 6.2

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

Marketing Cloud Audiences in
Analytics

Release Notes - September 2016

Description Date Published

Adobe Experience Manager 6.2 May 19, 2016
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,

and service pack releases.

A getting started guide for new May 15, 2016

Analytics administrators.

A round-up of available May 15, 2016

integration topics.

Activity Map product April 14,2016

documentation.

With the Marketing Cloud
Audiences for Analytics

April 14,2016

integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.
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Item

Analytics Product Comparison

Marketing Cloud Assets

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Release Notes - September 2016

Description Date Published

Added a product comparison February 18, 2016
table for Analytics products.

In Marketing Cloud Assets, you February 11,2016
can store, share, and synchronize

your digital assets from one

central location. Marketing

Cloud Assets leverages some of

the features available in Adobe

Experience Manager (AEM).

Added documentation for new January 21,2016
features in Analysis Workspace.

Analytics Administrators: If you September 17, 2015
are an administrator in the

Marketing Cloud, see Users and

Groups for updated information

about mapping Analytics groups

to broader Adobe groups, and

adding or bulk-adding users via

the Enterprise Dashboard .

Updated Analysis Workspace September 17, 2015
product documentation with

feature descriptions, tasks for

creating projects, videos, and use

cases.
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Item

Timestamps Optional

Data Workbench 6.5 Update

Select Report Suites and
Variables

Release Notes - September 2016

Description Date Published

Added product documentation September 17,2015
and best practices for

Timestamps Optional. This

feature lets you integrate both

timestamped and non-

timestamped data in a report

suite. All new report suites will

be Timestamps Optional by

default.

See Data Workbench 6.5 release September 17, 2015
notes for instructions to upgrade

and a list of new features and

bug fixes, including a new

Associations table and chord

diagram and updates to

visualizations, user interface,

algorithms, and export features.

Updated the Classification Rule
Builder so that you add report

August 20, 2015

suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.
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Item

Profile Link

New Calculated Metric Builder
and Calculated Metric Manager

Analysis Workspace (public
beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Release Notes - September 2016

Description Date Published

Profile Link works with cross- August 20, 2015
device data sources to identify

and collect traits for

authenticated site visitors. It

includes the Profile Merge Rules

feature, which lets you segment

and target users accurately

across multiple devices.

Calculated Metrics now allow for ~ June 18, 2015
segmented metrics, more

advanced math and the ability to

organize and share metrics.

Build data tables and drag-and- June 18, 2015
drop metrics, dimensions,
segments, and multiple

visualizations to a project panel.

Data Workbench 6.4 release
includes several new features

June 18, 2015

described here.

Added Adobe Managed
Certificate Program to the

May 22, 2015

revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/09152016.html?lang=en#previous
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Item

Mobile

Enabling Your Solutions for Core

Services

Customer Attributes

Analytics Spring Release

Release Notes - September 2016

Description

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for
core services.

If you capture enterprise
customer data in a customer

relationship management (CRM)

database, you can upload that
data into the Marketing Cloud.

See the New Features section in

Analytics for a round-up of new
documentation for the Spring
2015 Analytics release.

Date Published

May 22, 2015

March 19, 2015

March 19, 2015

March 19, 2015
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Item Description Date Published
Analytics Classification Rules - In Admin Tools > Classification February 19, 2015
overwrite existing values Rule Builder > &lt;rule set

name&gt; , two new options
enable you to select an
overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.
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Documentation » Release Notes Guide » Release Notes - October 2016

Release Notes - October 2016

Analytics Fall 2016 feature release. New features in Analysis Workspace include Funnel functionality (Fallout
and Flow), Intelligent Alerts, Custom Histograms, and Starter Projects. Anomaly Detection and Contribution

Analysis are now available in Analysis Workspace. Major permission enhancements are available in Admin >
Groups. Report Builder 5.4 and updates to Adobe Mobile. AEM releases include Mobile 2016.12, Desktop App
1.3, AEM 3D Assets feature pack, and updates to Livefyre and Scene7.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date. Please check back at release time for updates.

Last Update: November 3, 2016

Experience Cloud

Release Date: October 20, 2016

Marketing Cloud ID Service (Updated 10/28)

This release increments the ID service code to version 1.9.0. It includes the following features, bug fixes, and
other changes.

A IMPORTANT
Using Marketing Cloud ID service Library 1.9.0+, ID synching will begin for Adobe Advertising
Cloud by default. SeeUnderstanding ID Synchronization and Match Rates.

* Fixed a bug that passed Audience Manager unique user IDs (AAMUUIDs) as Marketing Cloud IDs to the ID
service. (MCID-203)

o If time-to-live (TTL) for an AMCV cookie has expired, the ID service will still return that information to the
server as long as the cookie contains a Marketing Cloud ID. After this call, the ID service makes an
asynchronous call to update the cookie. This helps improve performance because the ID service doesn't
have to wait for a server response. It can use existing AMCV cookie values and then request an update.
(MCID-204)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 1/41
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11/6/2020 Release

o (Updated 10/28, 11/4) The ID service automatically synchronizes Marketing Cloud IDs (MIDs) with Adobe

Notes - October 2016

Advertising Cloud and other internal Adobe domains directly on the page. Automatic synchronization is

enabled for all existing and new accounts. This helps improve match rates for Advertising Cloud. Applies
to VisitorAPLjs version 1.9, or higher. See also, Understanding ID Synchronization and Match Rates. (MCID-

152, MCID-184)

See Marketing Cloud ID Services product documentation.

Adobe Mobile Services

Feature

Target

Postbacks

Push Messaging

Analytics Reporting

SDK

Description

Mobile audiences, activities, and content are now
accessible across Target and Mobile Services
regardless of where they were created.

Added a new postback type: Pl

The PII postback type enables the user to send data
tagged with CollectPIl calls to 3rd party endpoints.

Push certificate expiration management allows you
to see the expiration date of your push certificates
and also receive reminders to update the certificate
before it expires. For more information, see
Troubleshooting Push Messaging .

Dimension and metric permissions set in Adobe
Analytics now apply to Mobile Services. For more
information, see Administrative Product Changes
Coming in October 2016 .

Xamarin, Unity, and PhoneGap plugins are updated
to work with iOS and Android SDKs version 4.13.1.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Feature Description

Mobile App Admin In order to modify settings in Mobile Services, users
were previously required to be added to a group
called Mobile App Admin in Adobe Analytics. This
has changed and users now only need to be a part
of a group that has Mobile App Admin selected in
the Tools section of the group's settings. Because of
this change, all Analytics Admins are now Mobile
App Admins.

See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand

Previous Release Notes in the left pane.
Analytics

New features and fixes in Analytics.

Important Notices for Analytics Administrators

A IMPORTANT
Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 3/41
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Notice

Removed restrictions on how
Analytics handles technology
data

Schedule Traffic Spike Deadline

Release Notes - October 2016

Date Added or Updated

October 15, 2016

September 23,2016

Description

Previously, Adobe Analytics did
not record technology data for
mobile web traffic. Meaning,
reports in the Visitor Profile &gt;
Technology section in Reports &
Analytics did not receive data for
mobile web hits. Beginning with
this release, the following reports
will populate from mobile web
traffic:

e Java

e JavaScript / JavaScript
Version

¢ Color Depth

¢ Resolution

e Browser Width
e Browser Height

o Referrer Type (typed /
bookmarked)

If you have report suites that you
expect to receive increased
traffic during the holiday season
(particularly Black Friday, Cyber
Monday, Christmas, or New
Year's), please schedule traffic
spikes as soon as possible.

See Importance of Scheduling
Traffic Spikes for more
information.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Notice

Ad Hoc Analysis - Java 1.7.

Analytics API 1.3 deprecation.

Analytics for Target processing
time increased by 30 seconds.

Release Notes - October 2016

Date Added or Updated

September 15, 2016

September 15, 2016

August 19,2016

Description

In the upcoming October 2016
release, you must use Java 1.7 or
later to launch Ad Hoc Analysis.

If you use Java version 1.6 or
earlier, you will see an error
message, "Unable to Launch the
Application." (On the error
message, you can view the Java
version that you are using by
clicking Details , then click the
Console tab.)

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

To achieve a higher visitor match
rate between Adobe Analytics
and Adobe Target, we have
increased the amount of time
data is held in processing from
30 seconds to 60 seconds. This
change only affects customers
using the Marketing Cloud ID
service, AppMeasurement for
Analytics, and who have Target
implemented on their pages.
(AN-128584)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Notice

Legacy Alerts

Data Warehouse request settings

AppMeasurement 1.6.3 and
Visitor API1.6.0

Release Notes - October 2016

Date Added or Updated

August 18, 2016

August 18, 2016

August 4, 2016

Description

Several features of existing
Analytics alerts will not be
included in the new Alert
Manager , which will be released
(as part of Analysis Workspace )
in the Fall of 2016.

Legacy Alerts Migration lists the
deprecated alert features and
some alert features that will be
migrated to the new Alert
Manager in a different form.

In the September 2016
Maintenance Release, Data
Warehouse will add a new
request setting that will enable
Data Warehouse to send empty
files when there is no data in the
report. This settings will be
enabled by default.

Version 1.6.0 of the Marketing
Cloud ID service requires
AppMeasurement for JavaScript
version 1.6.3 or higher. If you
want to upgrade to version 1.6.0
of the Marketing Cloud ID
service, please make sure you
are using AppMeasurement code
verison 1.6.3 or higher.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 6/41
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Notice Date Added or Updated Description
AppMeasurement for Flash - April 21,2016 Adobe has released a security
Security update update APSB16-13 for the

AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 7141
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Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient, and a
end of life in October 2016 number of other legacy

components will reach end-of-
life in October 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 8/41
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Notice

Release Notes - October 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

¢ Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 10/41
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 410 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

New Features in Analytics

Feature Description

Update to Segment Builder ( Updated 11/03/16) When building sequential segments, you now have
the option to filter for traffic "before sequence"” or
"after sequence”.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 11/41
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Feature

Intelligent Alerts

Customer Journey (Fallout and Flow) in Analysis
Workspace

Release Notes - October 2016

Description

As the new alert system for all of Adobe Analytics,
Intelligent Alerts let you create and manage alerts
in Analysis Workspace , complete with alert
preview and rule contribution. You can

e Build alerts based on anomalies (90%, 95%, or
99% thresholds; % change; above/below).

e Preview how often an alert will trigger.

¢ Send alerts by e-mail or SMS with links to
auto-generated Analysis Workspace projects.

o Create "stacked" alerts that capture multiple
metrics in a single alert.

More...

Refer to Legacy Reports & Analytics alerts for more
information on how legacy alerts are migrated.

The new Fallout feature bring funnel functionality
to Analysis Workspace to enable you to build
robust funnels with new visualizations and the
inherent flexibility that Analysis Workspace
provides.

The new Flow feature lets you view customer
flow/journey through sites/apps via new, updated
and flexible visualizations in Analysis Workspace .
You can discover how customers are moving and
progressing through their sites/apps.

More... on Fallout. More... on Flow.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Feature Description
Anomaly Detection and Contribution Analysis in Lets you know if a change in trended data is
Analysis Workspace significant, and what caused it.

Both Anomaly Detection and Contribution Analysis
are now core workflows in Analysis Workspace .
You can automatically detect statistically significant
data anomalies in your data, then run Contribution
Analysis against any daily anomaly and embed it in
your Analysis Workspace project.

Availability - Updated 10/21

¢ Analytics Premium customers:
¢ Anomaly Detection in Analysis
Workspace and Reports & Analytics (full
functionality)

¢ Contribution Analysis in Analysis
Workspace and Reports & Analytics (full
functionality)

¢ Analytics Standard customers:
e Anomaly Detection in Analysis
Workspace and Reports & Analytics (full
functionality)

¢ Contribution Analysis in Reports &

Analytics (basic functionality)

More...

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 13/41
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Feature Description

Custom Histograms in Analysis Workspace The new histogram visualization in Analysis
Workspace allows customers to visualize
distributions of customer behavior quickly and
easily. You can set up custom bucket sizes, starting
bucket and number of buckets for the visualization
and then automatically generate segments to
address each bucket and generate a histogram. You
can identify high-value or low-value users.

More...

Starter Projects in Analysis Workspace Starter Projects provide useful templates for
common use cases.

When you open Workspace, you will see a number
of Starter Projects in the left rail. They are grouped
by the vertical or platform they belong to: Media,
Mobile, Retail, and Web. They come pre-populated
with different dimensions, segments, metrics, and
visualizations, depending on the report suite. You
can use these pre-populated templates as they are,
or adapt them to your needs.

More...
Updates to Permission Management Administrator Access
Admin > User Management > Groups Group membership is no longer required for

administrators. By default, administrators now have
access to all items (tools, dimensions, and metrics),
as well as Web Service access, Report Builder,
Activity Map, and Ad Hoc Analysis.

Custom Groups

Predefined groups are no longer used. All
predefined groups have been replaced by custom
groups of the same name. Administrators can
delete these groups and create their own, as all

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 14/41
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Feature Description

settings that were previously available in the
predefined groups are available for customization.

Use groups to grant or restrict access for non-
administrative users. For example, you can delete
all the migrated groups and replace them with a
single group that grants access to Report Builder,
Activity Map, Ad-Hoc Analysis, Reports & Analytics
Access, Analysis Workspace Access, and so on.

See Changes to All Report Access below for more
information.

Group Permissions

The Report Access section in Groups > Add New
User Group has been streamlined to four
categories, which enable you to customize
permissions at a granular level. The new
permission categories include:

¢ Analytics Tools: Formerly Company Tools,
includes General items (billing, logs, etc.),
Company Management, Tools, Web Service
Access, Report Builder, and Data Connectors
integration. Privileges previously obtained
from predefined groups are in this category.
Existing, predefined groups have been added
to this category.

¢ Report Suite Tools: Includes report suite
management, tools and reports, dashboard
items, and so on.

e Metrics: Includes traffic, conversion, custom
events, solution events, and so on.

e Dimensions:
o ¢eVars 1-250 are individually permissioned.

o All traffic reports are dimensions.

¢ Video & Mobile reports are dimensions,
as well as other Analytics solutions

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 15/41
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Feature Description

reports (Experience Manager, Advertising
Cloud, Social, and do on.)

e Pathing reports are available if a user has
access to the parent dimension.

¢ All current dimensions and metrics within
custom groups have been automatically
migrated to the new categories. If an existing
group has metrics enabled, it will be given all
newly permissionable dimensions (eVars and
content aware) and metrics by default.

e Classifications Importer (formerly, SAINT)
permissions: Access to classifications is
determined by access to the variable on which
the classification is based.

For more information, see Administrative Product
Changes for Fall 2016 .
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Feature Description

Changes to All Report Access As part of the permission changes, a custom group
has replaced the All Report Access predefined
group. This custom group has access to:

¢ All Dimensions

e All Metrics

¢ All Report Suites

¢ Channel Report Permission

¢ Anomaly Detection Report Permission
¢ Real-Time Report Permission

¢ Analysis Workspace Access Permission
e Web Service Access

¢ Reports & Analytics Access

e Create/Curate Projects

e Metric Creation

e Segment Creation

At release, all customers will be migrated. Every
user that used to be in All Report Access will be
added to the new custom group.
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Feature Description
Defunct Traffic Reports have been removed These defunct reports will be removed:

e Monthly Summary

¢ Visitor Home Page

¢ Netscape Plugins

e Key Visitors

o Pages Viewed By Key Visitors
¢ Visitor Snapshot

e DRM

¢ Net Protocols

e Java Version

¢ Bookmark URL Length

¢ Device Number Transmit
e PTT

¢ Decoration Mail Support
e Information

¢ |nformation Service

These reports:

¢ Can still be accessed by Bookmarks.

e Are notincluded in new Dimensions

permission category.
¢ Can no longer have their permissions edited.

e Will retain access for custom groups with

current access.
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Feature Description

Report Builder 5.4 e Better management and editing of segments
across multiple requests. New options under
Edit Multiple Requests let you add, remove,
replace, and replace all segment(s) within
multiple target requests.

¢ New link to the Adobe Report Builder
Community

¢ Enhanced login security

More...

SiteCatalyst 14 End of Life After October 20, 2016, users will be unable to log
in to SiteCatalyst 14. The User Interface will be
completely offline. All users must log in to Adobe
Analytics/SiteCatalyst 15. More...

Analytics Administration API 1.4 Updates
As part of the Analytics permission enhancements, all of the group related, permissions APIs will accept and

return (where appropriate) the group_id . This includes:

Permissions.GetGroups’

GetGroup®

SaveGroup®

DeleteGroup®

For more information, See Permission API Changes for October in the Developer Connection.

For convenience, you can still use the group_name , but it is no longer required when the group_id is used. This
should make managing groups programmatically easier and more intuitive.

Analytics Fixes

Fixes were applied to the following products and services:
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Product

Reports & Analytics

Release Notes - October 2016

Fixes

Fixed an issue that prevented bookmarked
reports from being sent to dashboards. (AN-
130940)

Fixed an error that caused the Allocation for
Paid Search Keywords to say “Multiple” instead
of “Most recent”, in some cases. (AN-129378)

Fixed an issue that limited processing rules to
100, instead of 150, when copying rules from
one report suite to another. (AN-129433)

Fixed an issue with advanced links when the
filter contained "=" and short links. (AN-121144)

Fixed an issue that prevented dashboards
from being downloaded as PDFs. (AN-123380)

Fixed an issue causing large or negative values
to display in the Time to Start report ( Video >
Video Quality > Quality Variables / Quality
Events ). Previously, the timeToStart metric
was sent to Analytics without validation. Now,
the metric value is sent to only if it is within
the 0-60 seconds range.
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Product Fixes

Analysis Workspace
¢ Fixed an issue with using “Try In Workspace”

in the Key Metrics report, with calculated
metrics. (AN-130945)

¢ Fixed a calendar localization issue for the
Japanese language. (AN-131745)

¢ Fixed an issue that prevented user access to
Analysis Workspace even though the user had
rights to access it. (AN-131515)

¢ Fixed a display issue in donut and bar charts.
(AN-1044971)

e Fixed a calendar display issue. (AN-115527)

Ad Hoc Analysis
¢ Java 1.7: Ad Hoc Analysis now requires Java 1.7

or later to run. If you use Java version 1.6 or
earlier, you will see an error message, "Unable
to Launch the Application." (On the error
message, you can view the Java version that
you are using by clicking Details , then click
the Console tab.)

¢ Fixed an issue that caused only 50 pages to be
shown in the Pages report. (AN-115506)

Activity Map
e Fixed an issue that caused link clicks in the

page details report to report on element page
instead of clickmappage. This resulted in an
incorrect number of link clicks to be reported.
(AN-127422)
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Product Fixes

Report Builder

Data Warehouse

Data Sources

Clickstream Data Feed N/A

Fixed an issue with the Browser dimension
not being available as a breakdown for
Operating System. (AN-130197)

ASI: Official end-of-life (and no longer visible
in Ul)

DB VISTA upload: Added row count info to
success e-mails (AN-126004)

Fixed bugs related to latency issues with
Triggers and LiveStream.

Fixed performance bugs in Classifications.
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Product Fixes
AppMeasurement (Legacy and Mobile SDKs) AppMeasurement for JavaScript
Version 1.7.0:

¢ Update Audience Manager module with
Demdex Integration Library (DIL) 6.6. (AN-
132065)

e Inclusion of Visitor API11.9.0. (AN-132072)

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e i0OS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )
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Product Fixes
Analytics Web Services (SOAP and REST APIs) Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 API requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.

Data Workbench See Data Workbench Release Notes .

Fixes, Enhancements, and Deprecations
 Fixed a bug that prevented you from viewing a segment if the segment name contained an HTML
encoded value. (AAM-21860)

¢ Fixed a bug in the Onboarding Status Report that prevented the bar chart from loading when filtering
records by a single day. (AAM-26702)

 Fixed a bug that prevented you from mapping segment IDs to a server-to-server destination. (AAM-26174)

e Fixed a bug in Audience Marketplace that prevented some customers from subscribing to data feeds.
(AAM-26334)

¢ Fixed a bug in Audience Marketplace that prevented data providers from receiving access requests from
data buyers. (AAM-25813)

» Fixed a bug that prevented users with Admin permissions from updating the permissions of another user
with Admin permissions. (AAM-25804)

¢ Fixed a bug in the Onboarding Status Report that prevented the number of items for a page view from
updating when you changed the display amount. (AAM-26339)

¢ Fixed a bug in the Onboarding Status Report that prevented the status graph from updating when you
changed the date range. (AAM-26473)

 Fixed a bug in segment rule builder that removed parenthesis from segment rule logic. (AAM-24388)

« Fixed broken links to the help documentation in the Ul footer. (AAM-26609)
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e Fixed a bug that prevented the Onboarding Status Report the prevented error sampling from returning
errors in your inbound data file. See also, Onboarding Status Report: About. (AAM-26460)

¢ In the Onboarding Status Report, the summary metrics table for success and failure rates is limited to 5
rows plus the aggregate totals. (AAM-25485)

e Added an action button to a trait update/edit warning message that let’s the user close the message
window. Previously, the message closed automatically and did give the user enough time to read it.
(AAM-25559)

¢ You can now save a segment with the same segment rules and data source as another segment as long as
the new segment has a different profile merge rule. (AAM-26671)

DIL Bug Fixes, Enhancements, and Deprecated Code

DIL is the API data collection code for Audience Manager. The October release increments DIL to version 6.6.
Upgrade to the latest version to take advantage of these changes.

e DIL synchronizes IDs with Adobe Advertising Cloud and other internal Adobe domains directly on the
page. To enable this functionality, DIL sets a new cookie, aam_ * partner name here *_ * containerNSID
here * . See DIL create for information about the * partner name * and * containerNSID * variables.
This type of synchronization helps improve match rates for Advertising Cloud. (MCID-138)

e DIL uses the value set by 1oadTimeout property of the Marketing Cloud ID service to determine how long
to wait for a getMarketingCloudvisitorID response from the data collection server. See loadTimeout.
(MCID-143)

Planned Release Date: October 25, 2016
Improvements

¢ Facebook Branded Content is now supported. When publishing 3rd party branded content that is not the
brand of your own Facebook page, you can tag the featured 3rd party in your post from Publish
Anywhere. For more information, see Facebook Branded Content Policies.

¢ Animated GIFs are now supported within Twitter Moderation. No content is lost when looking at your
Twitter feed within Adobe Social.

e Adobe Social now supports Twitter's new character count calculation, allowing you to put more into your
tweets. For more information, see the Twitter blog,

Fixes

¢ Fixed an issue where GIF images were not displaying correctly on the details page of any reply, retweet, or
quoted tweet.
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Release Notes - October 2016

Fixed an issue where Attach Photo Album was not clickable in Publish Anywhere when expanded to full
screen.

Fixed an issue where Facebook posts that had a failed moderation action became stuck in the feed and
moderation options were no longer available.

Fixed an issue where changes were not saved after uploading and editing an image within Publish
Anywhere.

Fixed an issue where clicking on Instagram hashtags from within Adobe Social was navigating users to the
wrong page.

Fixed an issue where platform-specific changes made to a draft post in edit mode weren't reflected in the
updated draft post in the Content Calendar.

Fixed an issue where some tweets were not displaying correctly within Adobe Social.

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

Target Standard and Premium
Target Classic

Recommendations Classic

Primetime

Adobe Primetime is a multiscreen TV platform that helps media companies create and monetize engaging,

personalized viewing experiences.

Feature Description
Server Side Ad Insertion (SSAI) QoS Monitoring This is Primetime’'s first integration into the Adobe
Dashboard Marketing Cloud interface. The first iteration of this

Quality of Service dashboard enables you to track
SSAl request counts, request success rates and
HTTP error counts in interactive formats. More
importantly, this dashboard is expandable and will
allow Primetime to harness the Marketing Cloud
more fully.
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Primetime Help Home
Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

e Adobe Campaign Standard Release Notes

¢ Adobe Campaign Standard Documentation

Adobe Campaign V6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

Title Description

Product releases Mobile 2016.12 Mobile update release .
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Title Description

AEM Desktop App 1.3 AEM Desktop App 1.3 provides
performance enhancements and
stability of accessing files and
saving changes to AEM (Adobe
Experience Manager), especially
from Creative Cloud desktop
applications, such as Adobe
InDesign , Adobe Illustrator, or
Adobe Photoshop . This release
aims to provide users with a
more local desktop-like
experience when working with
files, while simultaneously
handling network data transfer
operations in the background.

AEM 3D Assets Feature Pack This feature pack enables
support for 3D content in AEM
Assets. It provides capabilities to
upload, manage, preview, and
render 3D assets.

Livefyre release Livefyre update release .
Scene?7 Viewers Scene? Viewers 5.5.1 release.
Scene?7 Scene? Fall 2016 release .
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Product maintenance releases

Release Notes - October 2016

Title

AEM 6.1 Cumulative Fix Pack 1

Description

Starting with AEM 6.1 Service
Pack 2, Adobe has introduced a
single delivery model for
releasing fixes. Instead of
releasing hot fixes for single
issues, Adobe will release a
Cumulative Fix Pack (CFP) every
month (subject to passing
quality checks), which is an
aggregator content package for
multiple fixes. CFPs do not
include any improvements, but
have the following advantages
over single hot fix releases:

¢ Increased quality assurance.

« Simplified installation (User
installs a CFP as a single
package that has no
dependencies, except for
the latest service pack).

e Cumulative in nature (for
example, CFP 3 contains
fixes for CFP2 and CFP1) For
more information on CFP
and other types of releases,
see Maintenance Release
Vehicle.

The AEM 6.1 Cumulative Fix Pack

is available on the Adobe

Package Share and the release
notes under
https://helpx.adobe.com/experienc
manager/release-notes--aem-6-

1-cumulative-fix-pack-.html
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Self-help

Release Notes - October 2016

Title

AEM 6.2 documentation updates

Description

Completed several
enhancements to the example
used to explain how to pre-
configure a Web services in rule
editor . Also, attached sample
files that one can directly upload
to CRX to get the example
working.

Added Developer Best Practices
for: Content Architecture,
Software Architecture, Coding
Tips, Coding Pitfalls, JCR
Interaction and OSGI Bundles.

Documented settings to use
OpenOffice files with AEM Forms
PDF Generator.

Updated the SAML 2.0
Authentication Handler
documentation to include:

¢ The new location of the IdP
certificate in the AEM
Truststore .

¢ The new location of the
Service Provider key and
the certificate chain in AEM

AEM Communities

New nested groups feature
available in AEM 6.2
Communities FP1and AEM 6.1
Communities Feature Pack 5:

¢ New Groups console
section of Communities
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Title Description
Sites console.

e Adapted Getting Started
tutorial to show adding
nested groups from both
author and publish
environments.

e Updated Overview to
mention nested groups.

Community Get the latest AEM Developer The AEM Technologist
Community event calendar and Community in Adobe
more. Communities is a great learning

resource center for AEM
customers. For example, you
can:

e See upcoming GEMs and
"Ask the Expert" webinar
series.

¢ Seein-person events from
across the globe.

e Access on-demand

recordings

Join now .
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Release Notes - October 2016

Title

AEM Architect Workshops

Description

This three-day course is designed
for AEM architects and Senior
AEM developers to accelerate
the learning and understanding
of recommended practices for
AEM 6.1.

Participants will gain knowledge
of AEM's architecture design,
migration methodologies and
recommended practices,
integration with Adobe and 3rd
party solutions, and
performance optimization.
Collaborative exercises will
challenge the participants,
driving the creation of solution
designs and applying them to
implementation walk-throughs
with their peers.

Two sessions are scheduled in
EMEA: one in Maidenhead,
November 15, 2016, and one in
Basel, November 21, 2016.
Register for either session at the
following:

https://training.adobe.com/training
architect-workshop.html
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Title Description

AEM Power Sessions Join Adobe's digital marketing
expert for three power sessions
on learning how you can drive
the success of your digital
marketing programs by
effectively using the powerful
innovations and integration
capabilities in Adobe Marketing
Cloud.

Learn how to use MongoDB on
AEM, integrate AEM with Adobe
Analytics, and how to use the
advanced features of AEM digital
assets.

Additional resources:

e AEM Help Home
e AEM Assets, on-demand Release Notes

e SPS Release Notes

Advertising Cloud

We are excited to announce the community for Adobe Advertising Cloud! It is a place where you can ask
questions, get advice, share best practices, and learn more about the product. The Community provides a
platform to connect, share, and collaborate with Adobe teams and fellow product users from around the
world. It is a great opportunity to get help and help others.

As you participate in the community, Adobe recognizes your engagement and rewards top contributors
regularly. It gives you greater visibility amongst fellow participants and ground to establish yourself as product
expert.

The community is free for all and you just need a valid email ID to join and participate on the community.

We look forward to see you and hear from you at the community!
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New Features in Advertising Cloud

Feature

Search Campaigns

Search Campaigns Beta

Search Advanced Campaign Management(ACM)

Display Managed Campaigns

Release Notes - October 2016

Description

Support was added for Kochava as a mobile
measurement partner for Google AdWords app
install ads and app extensions.

New grids and settings are available for ad groups,
placements, Google call-only ads, Google app
install ads, and auto targets.

Beta campaign settings include device bid
adjustments, negative keywords, and tracking.

Google AdWords text ad templates support
expanded text ads (ETAs).

Ad strategies include organization targeting.

Recency rules for ad strategies in optimized
campaigns are now applied to the optimized bid
that Advertising Cloud generates, rather than to the
base bid.

The following creatives sizes are supported for RTB
ad strategies: 580 x 100 and 320 x 320.

Target templates (presets) include all ad targets.

Labels are available as filters in reports.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 34/41



11/6/2020 Release Notes - October 2016

Feature Description

Additional date range presets are available in the
Managed Campaigns views.

Display Audiences You can download an Excel spreadsheet with the
addressable audience data for each segment in the
Segments and Marketing Cloud Segments views.

Social Campaigns Ad targets created in Facebook editors using
flexible targets are visible as read-only in
Advertising Cloud.

Social Feed Console Alpha The feed console lists all files in your organization's

FTP folder for product feed files.

Advertising Insights (Search menu only) The new Match Type (Online)
insight includes on-screen charts of the cost and

weighted revenue across match types in a portfolio.

Beta access to advertising insights is available.
Contact your account manager to participate.

Recent documentation updates

Item Description Date Published / Last Updated
Administrative Changes - Fall The Fall 2016 release of Adobe October 20, 2016
2016 Analytics includes several

updates groups and permission
management. Please review the
following information.
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Item

Fall 2016 - What's New in
Analysis Workspace

Marketing Cloud Triggers

Adobe Experience Manager 6.2

Release Notes - October 2016

Description

New features include: October 20, 2016
o Fallout Analysis in Analysis
Workspace

e Flow Visualization in

Analysis Workspace

* Intelligent Alerts in Analysis
Workspace

¢ Anomaly Detection and
Contribution Analysis in
Analysis Workspace

e Starter Projects in Analysis
Workspace

e Histogram Visualization in
Analysis Workspace

Identify, define, and monitor key September 15, 2016
consumer behaviors, and then

generate cross-solution

communication to re-engage

visitors.

Adobe Experience Manager 6.2 May 19, 2016
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,

and service pack releases.
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Item

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

Marketing Cloud Audiences in
Analytics

Analytics Product Comparison

Marketing Cloud Assets

Release Notes - October 2016

Description

A getting started guide for new May 15, 2016
Analytics administrators,
including implementation for

first-time users.

A round-up of available May 15, 2016

integration topics.

Activity Map product April 14,2016

documentation.

With the Marketing Cloud
Audiences for Analytics

April 14,2016

integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Added a product comparison February 18, 2016

table for Analytics products.

In Marketing Cloud Assets, you February 11, 2016
can store, share, and synchronize

your digital assets from one

central location. Marketing

Cloud Assets leverages some of

the features available in Adobe

Experience Manager (AEM).

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Item

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Release Notes - October 2016

Description

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

Date Published / Last Updated

January 21,2016

September 17, 2015

September 17,2015

September 17, 2015

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Item Description Date Published / Last Updated

Data Workbench 6.5 Update See Data Workbench 6.5 release September 17,2015
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Select Report Suites and Updated the Classification Rule August 20, 2015

Variables Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link Profile Link works with cross- August 20, 2015
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

New Calculated Metric Builder Calculated Metrics now allow for  June 18, 2015
and Calculated Metric Manager segmented metrics, more

advanced math and the ability to

organize and share metrics.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous 39/41
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Item

Analysis Workspace (public
beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core
Services

Customer Attributes

Release Notes - October 2016

Description

Build data tables and drag-and-
drop metrics, dimensions,
segments, and multiple
visualizations to a project panel.

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a

new first-party SSL certificate for

first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for
core services.

If you capture enterprise
customer data in a customer

relationship management (CRM)

database, you can upload that
data into the Marketing Cloud.

Date Published / Last Updated

June 18, 2015

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015

March 19, 2015

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Item

Analytics Spring Release

Analytics Classification Rules -
overwrite existing values

Release Notes - October 2016

Description

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.

In Admin Tools > Classification February 19, 2015
Rule Builder > &lt;rule set

name&gt; , two new options

enable you to select an

overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/10202016.html?lang=en#previous
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Documentation » Release Notes Guide » Release Notes - November 2016

Release Notes - November 2016

Learn about new features and fixes in the Adobe Marketing Cloud.

A IMPORTANT

EnterpriseTV has been decommissioned as of December 9, 2016. Product videos are available at
Adobe Video Learning. Please be patient, as you may see broken video links while we migrate
videos to the new location. Video content will become embedded in relevant product
documentation pages when the migration is complete.

@ NOTE

To receive release notes one week prior to the monthly product update, subscribe to the Adobe
Priority Product Update. Release information in the Priority Product Update comes one week in
advance of the release date. Please check back at release time for updates.

Experience Cloud and Core Services

Last update: January 6, 2017

Marketing Cloud Interface 16.11.1

New features and fixes in the Adobe Marketing Cloud interface.

Release date: November 8, 2016

Feature Description

Update to Profile & Passwords Users can no longer edit IMS user profile
information under Personal Details In Edit Profile >
Profile & Passwords . Instead users are redirected to
accouts.adobe.com . This applies to all identity
types (Adobe ID, Enterprise, and Federated).

Fixes

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 1/44
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¢ Fixed an issue with technical passwords that caused an error in folder sharing between Creative Cloud
and Marketing Cloud. (MAC-31067, MAC-32014)

¢ Fixed an issue with the upload of certain file types, including PDF, that was found after the October
release in Assets Core Service. (MAC-32517)
See Marketing Cloud Product Documentation for product help.

Marketing Cloud ID Service
Release date: November 10, 2016

Updated (1/6/2017) This release increments the ID service code to version 1.10. It includes the following
features, bug fixes, and other changes.

A IMPORTANT
e \Version 1.10 requires AppMeasurement 1.8.0.

 Using Marketing Cloud ID service Library 2.0.0+, ID synching will begin for Adobe Advertising
Cloud by default. See Understanding ID Synchronization and Match Rates.

e Added visitor.overwriteCrossDomainMCIDANdAID , @ boolean function that lets you overwrite the Marketing
Cloud and Analytics IDs on other domains that you own. (MCID-218)

e Added T7s = * UTCtimestamp * as a property of the visitor.appendvisitorinsTo function. The ID
service uses the timestamp to determine if it should use the IDs in the redirect URL based on a 5-minute
aging interval. See Append Visitor ID Function. (MCID-219)

e Added visitor.getlocationHint ,a new function that returns a region ID. (MCID-227)

e Added idsyncByURL and idSyncByDataSource , 2 functions that let you manually implement an ID syncin
the Destination Publishing iFrame. (MCID-166)

* Fixed a bug that blocked the AppMeasurement tracking call if disableThirdPartycalls:true . (MCID-223)

« Fixed a bug that prevented the ID service from passing the Marketing Cloud ID (MID) across different
domains. (MCID-215)
See Marketing Cloud ID Services product documentation.

Adobe Mobile Services

Mobile Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 2/44
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Mobile

Universal Links and App Links

Android SDK

Visitor ID Service

Deep Linking

iOS SDK

Visitor ID Service

Configuration

Deep Linking

Acquisition

Release Notes - November 2016

Description

Staring in i0S 9.2, deep linking is no longer
supported. Universal Links (i0S) and App Links
(Android) are the new method of deep linking into
your app or website.

Description

Added timestamp and Marketing Cloud
Organization ID to adobe_mc parameter.

When calling trackAdobeDeepLink, variables
prefixed with " adb " and " ctx " are now handled

properly.

Description

Added timestamp and Marketing Cloud
Organization ID to adobe_mc parameter.

Invalid IDFAs (00000000-0000-0000-0000-
000000000000) passed to the SDK via
setAdvertisingldentifier: will be ignored.

When calling trackAdobeDeepLink , variables
prefixed with " adb " and " ctx " are now handled

properly.

Data from Apple Search Ads will now be sent along
with your acquisition data.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 3/44
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See Adobe Mobile Services for product documentation. To see the release notes for previous releases, expand
Previous Release Notes in the left pane.

Analytics

Release Date: November 10, 2016

Important Notices for Analytics Administrators

A IMPORTANT

Review the following table for important Analytics notices that may affect data collection,
processing, APIs, product end-of-life, and so on.

Notice Date Added or Updated Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 4/44
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Notice

Removed restrictions on how
Analytics handles technology
data

Schedule Traffic Spike Deadline

Release Notes - November 2016

Date Added or Updated
Update for November 29:

This change became effective on
November 14, 2016.

September 23,2016

Description

Previously, Adobe Analytics did
not record technology data for
mobile web traffic. Meaning,
reports in the Visitor Profile &gt;
Technology section in Reports &
Analytics did not receive data for
mobile web hits. Beginning with
this release, the following reports
will populate from mobile web
traffic:

e Java

e JavaScript / JavaScript
Version

¢ Color Depth

¢ Resolution

e Browser Width
e Browser Height

o Referrer Type (typed /
bookmarked)

If you have report suites that you
expect to receive increased
traffic during the holiday season
(particularly Black Friday, Cyber
Monday, Christmas, or New
Year's), please schedule traffic
spikes as soon as possible.

See Importance of Scheduling
Traffic Spikes for more
information.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Notice

Ad Hoc Analysis - Java 1.7.

Analytics API 1.3 deprecation.

Analytics for Target processing
time increased by 30 seconds.

Release Notes - November 2016

Date Added or Updated

September 15, 2016

September 15, 2016

August 19,2016

Description

In the upcoming October 2016
release, you must use Java 1.7 or
later to launch Ad Hoc Analysis.

If you use Java version 1.6 or
earlier, you will see an error
message, "Unable to Launch the
Application." (On the error
message, you can view the Java
version that you are using by
clicking Details , then click the
Console tab.)

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

To achieve a higher visitor match
rate between Adobe Analytics
and Adobe Target, we have
increased the amount of time
data is held in processing from
30 seconds to 60 seconds. This
change only affects customers
using the Marketing Cloud ID
service, AppMeasurement for
Analytics, and who have Target
implemented on their pages.
(AN-128584)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Notice

Legacy Alerts

Data Warehouse request settings

AppMeasurement 1.6.3 and
Visitor API1.6.0

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous

Release Notes - November 2016

Date Added or Updated

August 18, 2016

August 18, 2016

August 4, 2016

Description

Several features of existing
Analytics alerts will not be
included in the new Alert
Manager , which will be released
(as part of Analysis Workspace )
in the Fall of 2016.

Legacy Alerts Migration lists the
deprecated alert features and
some alert features that will be
migrated to the new Alert
Manager in a different form.

In the September 2016
Maintenance Release, Data
Warehouse will add a new
request setting that will enable
Data Warehouse to send empty
files when there is no data in the
report. This settings will be
enabled by default.

Version 1.6.0 of the Marketing
Cloud ID service requires
AppMeasurement for JavaScript
version 1.6.3 or higher. If you
want to upgrade to version 1.6.0
of the Marketing Cloud ID
service, please make sure you
are using AppMeasurement code
verison 1.6.3 or higher.

7/44
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Notice Date Added or Updated Description
AppMeasurement for Flash - April 21,2016 Adobe has released a security
Security update update APSB16-13 for the

AppMeasurement for Flash
library. This update resolves an
important vulnerability in the
library, applicable only when
debugTracking is enabled, that
could be abused to conduct
DOM-based XSS attacks .

Note: This issue affects
AppMeasurement for Flash only
when debugTracking has been
enabled ( debugTracking is
disabled in the default
configuration). If affected, we
strongly advise you to disable
debugTracking immediately.
Here is some sample code:

public var s:AppMeasurement;

s = new AppMeasurement();

s.debugTracking = false; / set to fals
/ for default "disablec

</codeblock> <p>Affected vers

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 8/44
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Notice Date Added or Updated Description
SiteCatalyst 14, ExcelClient, etc. March 17,2016 SiteCatalyst 14, ExcelClient , and
end of life in October 2016 a number of other legacy

components will reach end-of-
life in October 2016.

This means that all access to the
SiteCatalyst 14 user interface and
several related features will be
removed. To prepare for this
event, view this list of affected
components, along with
required user actions and
suggestions on how to move
forward with alternatives.

Changes to visit processing for March 17, 2016 In June, we will begin improving

timestamped data to the way visits are calculated
for Timestamps Required and
Timestamps Optional report
suites. These changes will
primarily affect data collected
through Mobile SDKs and will
result in lower overall visit
counts going forward, in certain
situations.

Learn more in Compare visits
and mobile app launches.

To see which report suites might
be affected, see Timestamps

Optional .
Data processing change February 18, 2016 Sometime between the February
between February and March and March Maintenance
MRs Releases, the following Analytics

data processing change was
implemented:

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 9/44
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Notice

Release Notes - November 2016

Date Added or Updated

Description

Previously, when using the
Product variable without having
an event set, the event would
default to "ProdView", set early in
processing (before processing
rules take effect). The event is
now set after the processing
rules to avoid conflicts with how
mobile data processing works.
This change has the following
downstream effects:

e ProdViews are no longer
inflated because of hits
where context data is
generating events
(especially in Mobile).
Going forward, an event will
be set at the time in data
processing when the
ProdView would have been
set (without a set event.)

e Any VISTA rule that has
logic depending on a
ProdView event being set
on a hit might need to be
reviewed to see if changes
to the VISTA rule are
needed. This is because
ProdView events might be
set on fewer hits than they
previously were, because
ProdView is set earlier in
the processing pipeline. This
change may or may not
impact what is desired from
the VISTA rule.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Notice Date Added or Updated Description
Elimination of hashed values in February 18, 2016 In certain circumstances, hashed
Data Feeds values ( ::hash::&lt;hash

value&gt; ) may appear in data
feeds for the following types of
variables:

e Merchandising eVars in
post_product_list

e List Vars (called
post_mvvari-3, post_tnt,
and post_survey )

¢ Marketing Channel details.
The tracking code for the
Marketing Channels reports
(called va_finder_detail and
va_closer_detail )

A change is being implemented
that eliminates hashed values
over time, and replaces them
with actual values.

Note: The max size of any
particular value is 100 bytes or
255 bytes. For fields that support
multiple values, such as
post_product_list and List Vars,
the max size of those fields is
64k. Therefore, if you are passing
in a large number of values,
some of the values may be lost
as the field will be truncated at
64k.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 11/44
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Notice Date Added or Updated Description

Web Services v 1.2 APl end-of-life ~ February 18, 2016 Version 1.2 of the Web Services
API was officially deprecated on
February 20, 2014. It will reach
end-of-life on September 15,
2016. At that time, Adobe will
remove the ability of the API
servers to respond to version 1.2
API requests. Any API requests
made to the
https://api.omniture.com/admin/1.2
endpoint will return a 410 error.
Customers have until the end-of-
life date to upgrade from the
version 1.2 API to the version 1.4
API to prevent an outage in their
API applications.

Analytics APIs version 1.3 will be
officially deprecated as of
September 15, 2016. To prevent
disruption, Adobe recommends
upgrading to the latest API
versions as soon as possible.

See the API Support Policy page
for more information.

New Features in Analytics

Feature Description

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 12/44
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Feature

Date Comparison in Analysis Workspace

Segment Builder enhancements

Analytics Fixes and Improvements

Release Notes - November 2016

Description

The new Date Comparison feature lets you take
any column and create a common date
comparison, such as: year-over-year, quarter-over-
quarter, month-over-month, and do on.

Date Comparisons automatically include a
Difference column, which shows the percentage
change.

More...

The following features were added to the Segment
Builder:

o Date Ranges in segments. Allows you to build
segments that contain rolling date ranges in
order to answer questions about ongoing
campaigns or events. For example, now you
can easily build a segment that includes
“everyone who has made a purchase over the
past 60 days." More...

» Before/After sequence segments (Added in
October). When building sequential segments,
you now have the option to filter for traffic
"before sequence" or "after sequence”. More...

« Dimension constraints with Sequential
Segments (Added in October). In a “within"
clause, in between THEN statements, you can
add, for example, “within 1 search keyword
instance”, “within 1 eVar 47 instance”. This
constrains the segment to within one instance

of a dimension. More...

Fixes were applied to the following products and services:

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Product

Reports & Analytics

Analysis Workspace

Release Notes - November 2016

Fixes

Fixed an issue in Real-Time reports, where the
Today column was showing only zeros. (AN-
132975)

Fixed an issue with Calculated Metric formulas
showing known metrics as “Unknown” in the
Calculated Metric Builder . (AN-133203)

Fixed an issue that caused the IP address
dimension to no longer be available in the
Segment Builder . (AN-132982)

Fixed an issue with Real-Time reports, where
the Item Detail report was not providing any
data in the second and third tabs. (AN-133112)

Fixed a number of permissions-related issues

that were introduced with the October release.

(AN-133298, AN-133399, AN-132985, AN-133124,
AN-133217, AN-133122)

Fixed a number of alerts-related issues that
were introduced with the October release.
(AN-132996, AN-133307, AN-133268, AN-133247,
AN-133407)

Fixed an issue that prevented the duplication
of panels, histograms, bar charts and other
visualizations. (AN-133373, AN-133316)

Fixed issues with text visualizations that
prevented them from being saved and
resulted in blank projects. (AN-133355)

Fixed an issue with dual-axis settings not
getting saved or loaded appropriately. (AN-
133315, AN-133177, AN-133096)

Fixed an issue with segments inside of
functions (in calculated metrics) not getting
saved. (AN-133305)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Product Fixes

Fixed an issue that prevented the download of
PDF files. (AN-133289, AN-133120)

Fixed an issue that prevented the editing of
segments by non-Admin users. (AN-133269)

Fixed an issue with the calendar widget. Now,
when opening the Calendar widget, the first
click (whether it is on the right/start or
left/end of the calendar) indicates the start
date for the range.(AN-133263)

Fixed an issue that caused the segment
comparison feature to hang. (AN-133222)

Fixed an issue where resized columns in
freeform tables were not saved and Undo for
this case was not working. (AN-133190, AN-
132296)

Fixed an issue with the Summary Number
display not working for percentage value
displays. (AN-133177)

Fixed an issue with all the breakdowns in the
solution / pages section getting reset.
Customers had to re-add all the breakdowns.
(AN-133177)

Fixed an issue with the horizontal bar graph
not adjusting its size based on the number of
rows selected. Horizontal bars now have a
minimum height and a vertical scroll bar has
been added to accommodate in certain
situations. (AN-132939, AN-133177)

Fixed an issue that prevented the manual
entry of dates in the date selector for the Send
File pop up. (AN-132421)

Fixed an issue that prevented projects from
being copied. (AN-133309)

Fixed an issue that prevented some projects
from loading correctly. (AN-133282)

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Product

Data Warehouse

Data Sources

Clickstream Data Feed

Release Notes - November 2016

Fixes

¢ Updated Data Warehouse to match Reports &
Analytics rules for determining when "Other"
should be used as the page name in reports.
This occurs primarily when the page name is
blank. (AN-131951)

¢ Fixed an error that occurred when activating a
classification rule set. (AN-130658)

e N/A

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Product

AppMeasurement (Legacy and Mobile SDKs)

Release Notes - November 2016

Fixes
AppMeasurement for JavaScript
Java 1.3

e Added SSL hostname verification. (AN-130350)

¢ Removed support for Java 1.4. Only 1.5+ is
supported.

JavaScript 1.7.0

Updated Visitor API version number on January 4,
2017:

e Inclusion of Visitor APl 1.10.1 (AN-133359)

AppMeasurement for Other Platforms

See AppMeasurement Release History the
following for a release history of AppMeasurement
on the following platforms:

e JavaScript

e i0OS

¢ Android

¢ Flash-Flex

e OSX

¢ Windows Phone, XBOX, Silverlight, and .NET

e BlackBerry

e Java

e PHP

e Symbian

See Also: Marketing Cloud ID Service (formerly
visitor ID service )

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 17/44
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Product

Analytics Web Services (SOAP and REST APIs)

Data Workbench

Audience Manager

Release Notes - November 2016

Fixes

Administration API 1.4 Updates - Released
October 2016

As part of the Analytics permission enhancements,
all of the group related, permissions APIs will
accept and return (where appropriate) the
group_id . This includes:

e Permissions.GetGroups
o GetGroup
e SaveGroup

e DeleteGroup

For more information, See Permission APl Changes
for October in the Developer Connection.

For convenience, you can still use the group_name
, but it is no longer required when the group_id is
used. This should make managing groups
programmatically easier and more intuitive.

Deprecation Notice

Version 1.2 of the Web Services API was officially
deprecated on February 20, 2014. It will reach end-
of-life on September 15, 2016. At that time, Adobe
will remove the ability of the API servers to
respond to version 1.2 APl requests. Any API
requests made to the
https://api.omniture.com/admin/1.2 endpoint will
return a 404.

See Data Workbench Release Notes .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Feature Description

Addressable Audiences New features include a redesigned user interface,
report improvements that include segment-level
match rates, and additional look-back options for
reporting. See Addressable Audiences.

Fixes, Enhancements, and Deprecations

e If you are using a Marketing Cloud user account to log in to Audience Manager and forget your password,
you must go to the Marketing Cloud log in page to reset it. See Password Requirements, Locked Accounts,
and Forgotten Passwords

e Minor workflow and Ul changes to Profile Link that help support Adobe Marketing Cloud Device Co-op
options. (AAM-25988) See Profile Link.

Improvements

* New ID Definition option for all Cross-Device Data Sources - The IDs in a Cross Device Data Source can
now be defined as “Person” or “Household”. This definition indicates the relationship the Cross-device ID
has with the Audience Manager ID. The default option for all existing Cross-Device Data Sources will be
Person. See the Create Data Sources document. (AAM-25988)

@ NOTE
Due to changes being made by our data providers, we will no longer be providing Wordpress and
Disqus data effective December 1st, 2016. For more information, clickhere.

Social
Feature Description
Publish Anywhere Workflow Twitter media upload limits have been increased to

match those available when uploading natively in
Twitter. Videos up to 140 seconds and 512 MB in
size can now be published via Adobe Social .
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https://marketing.adobe.com/resources/help/en_US/aam/addressable-audiences.html
https://marketing.adobe.com/resources/help/en_US/aam/c_password_requirements.html
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Feature Description

Listening Rules &gt; Filters Twitter listening rule Filters are being migrated to

new Filters. These migrations will be automatic and

Lsitetill [Fukes 6 [l L may influence results. No adjustments are needed.

The following Filters will have their operators
change: bio contains, bio name contains, country
code, language, URL contains.

The following Filters will be deprecated: bio
language, bio location contains, contains, place
contains. For rules including these filters, they will
continue to exist but will no longer pull data.

Fixes

¢ Publish Anywhere: Fixed an issue where URLs copied and pasted into a post were not attaching properly.

¢ Moderation: Fixed an issue where images were not loading when moderating Facebook private
messages.

o Escalations: Fixed an issue where links within emails received from Escalations would not open the
actual post that was escalated.

Target

Refer to the Adobe Target Release Notes for the latest release information about the following products:

e Target Standard and Premium
e Target Classic

¢ Recommendations Classic

Primetime

Adobe Primetime is a multiscreen TV platform that helps media companies create and monetize engaging,
personalized viewing experiences.

Primetime Help Home

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 20/44
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Campaign

Adobe Campaign provides an intuitive, automated way to deliver one-to-one messages across online and
offline marketing channels. You can now anticipate what your clients want using experiences determined by
their habits and preferences.

For product documentation, see:
Adobe Campaign Standard

o Adobe Campaign Standard Release Notes

e Adobe Campaign Standard Documentation

Adobe Campaign V6

e Adobe Campaign v6 Release Notes

e Adobe Campaign v6 Documentation

Experience Manager

AEM release notes (December 9, 2016)

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

Title Description
Product releases AEM Assets Smart Tags Service With automatic image tagging,
(AEM 6.2) Smart Tags makes images more

easily discoverable in your DAM
(Digital Asset Manager).

AEM Assets 6.1 Feature Pack Includes new scalability,
performance, and usability
improvements for AEM 6.1
customers.
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https://docs.campaign.adobe.com/doc/standard/en/RN.html
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AEM Desktop App 1.3
(Windows)

AEM Communities 6.1 FP6
and

AEM Communities 6.2 FP2

Livefyre - November 3, 2016

Dispatcher 4.2.1

Release Notes - November 2016

Title Description

Provides performance
enhancements and stability of
accessing files and saving
changes to AEM, especially from
Creative Cloud desktop
applications, such as Adobe
InDesign , Adobe Illustrator, or
Adobe Photoshop .

This release aims to provide
users with a more local desktop-
like experience when working
with files, while simultaneously
handling network data transfer
operations in the background.

Enhancements to Front-end,
Multilingual, Groups, Ideation
function, Featured content,
Moderation, and Gamification.

Enabled support for customers
to drive mobile traffic to their
sites with Storify 2, Google
markup, display Tweets
appropriately on their sites with
the recent Twitter length
updates, and resolved many
customer escalations.

Documentation also available
here .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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https://docs.adobe.com/docs/en/aem/6-2/release-notes/desktop-app-release-notes.html
https://www.adobeaemcloud.com/content/marketplace/marketplaceProxy.html?packagePath=/content/companies/public/adobe/packages/cq610/social/featurepack/fp6/AEM-6.1-Communities-Livefyre-Feature-Pack-6
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https://docs.adobe.com/docs/en/dispatcher.html
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Product maintenance

Release Notes - November 2016

Title

AEM 6.1 SP2-CFP 3

Description

AEM 6.1 SP2 (Service Pack 2)-
CFP3 (Cumulative Fix Pack 3) is
an important update that
includes key customer fixes
released since the general
availability of AEM 6.1 SP2 in
August, 2016.

AEM 6.1 SP2-CFP3 also includes
Oak 1.2.18.

Note: AEM 6.1 SP2-CFP3 is
dependent on AEM 6.1 Service
Pack 2. Therefore, be sure you
first install AEM 6.1 SP2. For AEM
6.1 SP2 installation instructions,
see AEM 6.1 SP2 release notes .
Then, you can install AEM 6.1
SP2-CFP3 package, available on
Adobe Package Share (release
notes are also available from the
same Package Share location).

The AEM 6.1 Cumulative Fix Pack
and accompanying release notes

are available on Adobe Package
Share here .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Title Description

AEM 6.1 SP2-CFP2 AEM 6.1 SP2 (Service Page 2)-
CFP2 (Cumulative Fix Pack 2) is
an important update that
includes key customer fixes
released since the general
availability of AEM 6.1 SP2 in
August 2016.

You can install AEM 6.1 SP2-CFP2
on AEM 6.1 SP2, and AEM 6.1
SP2-CFP1.

See the release notes for
additional information.

AEM 6.1 SP2 Refresh An updated version of AEM 6.1
SP2 (Service Pack 2) is being
released to avoid a potential
long reindexing of
damScene7Name index.

Self-help AEM 6.2 documentation updates

Community AEM developer article Creating Adobe Experience
Manager packages using the
jerPackageManager API .

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous 24/44


https://www.adobeaemcloud.com/content/marketplace/marketplaceProxy.html?packagePath=/content/companies/public/adobe/packages/cq610/cumulativefixpack/AEM-6.1-SP2-CFP2
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IMMERSE

Release Notes - November 2016

Title Description

IMMERSE17 occurs May 15-19,
2017

IMMERSE is a global virtual
developer conference for AEM.

Register Now—early bird pricing
ends January 31, 2017.

Our inaugural conference was
held this past April. It was so well
received that Adobe Systems
decided to make this an annual
event with more great content.
Our expanded agenda now
includes an exhibit hall, Birds-of-
a-feather round table
discussions, and networking
lounges. You can attend the
conference from the comfort of
your office or home depending
on your location. Learn more.

Are you actively involved with
the AEM Developer Community?
Does your company want to be
seen as a leading supporter of
the community? Check out our
IMMERSET17 Sponsorship
Prospectus to get involved in
this vibrant community.

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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Ask the AEM Community Expert

AEM GEMS

Release Notes - November 2016

Title Description

Watch past November, 2016
session: "Best Practices for Using
Experience Manager and Adobe
Campaign"

Watch Adobe Connect version .

Watch MP4 version .

e Upcoming December, 2016
session: "Tools to Use for
Testing AEM Applications"

From unit testing to
integration testing of an
Experience Manager
application.

Automated testing is
indispensable for
developing any application.
This AEM GEMS
presentation walks you
through various tools that
you can use to test Java
code. You will start with the
basics of unit testing and
advance to functional and
integration testing. Learn
how to easily add tests in
the most effective way to
your code base, regardless
of whether you want to test
a simple utility method,
some OSGi service, or an
HTTP endpoint.

December 14, 2016, 09:00-
10:00 (Mountain Standard

https://experienceleague.adobe.com/docs/release-notes/experience-cloud/previous/legacy-rns/2016/11102016.html?lang=en#previous
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11/6/2020 Release Notes - November 2016

Title Description

Time). Join Carsten Ziegeler
(Project Lead, Software
Development), and Robert
Munteanu (Senior
Developer) for this live
session. RSVP here for this

session .

e Watch past November, 2016
session: "Introduction to
AEM Screens"

Watch Adobe Connect

version .

Watch MP4 version .

AEM release notes (November 10, 2016)

Adobe recommends customers with on-premise deployments to deploy the latest patches to ensure higher
stability, security, and performance.

Title Description

Product releases AEM Mobile 201613 Includes key features such as rich
content browsing experiences
(dynamic banners) and Android
push notifications. Also includes
full support for Coral 3 user
interface.

Scene? Viewers Fall Release Features include HLS video and
Search capability in eCatalog.
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Title Description

Livefyre October 20, 2016 Enabled support for customers
to do the following:

¢ Monetize Storify 2 pages by
building a configurable
"Show More" button and
enabling content below the
app.

¢ Curate content by way of
RSS feeds with varying
formats to support an
expanded list of sources
that include YouKu,
Pinterest, Vimeo, and so on.

¢ Configure nest level and
number of replies to load in
Comments to improve user

experience.
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Product maintenance

Self-help

Release Notes - November 2016

Title

AEM 6.1 Cumulative Fix Pack 2

AEM 6.2 documentation updates

Description

AEM 6.1 SP2-CFP2 is an
important update that includes
key customer fixes released since
the general availability of AEM
6.1 SP2 in August 2016.

AEM 6.1 SP2-CFP2 also includes
Oak 1.2.18.

Note: AEM 6.1 SP2-CFP2 is
dependent on AEM 6.1 SP2.
Therefore, be sure you first install
AEM 6.1 SP2. For AEM 6.1 SP2
installation instructions, see AEM
6.1 SP2 release notes . Then, you
can install AEM 6.1 SP2-CFP2
package, available on Adobe
Package Share. Release notes are
available here .

e Linked related Marketing
Cloud Integrations
Community Articles with
AEM content.

¢ You can now edit an
existing video encoding
profile (Using custom-
added video encoding
parameters ) to take
advantage of advanced
video encoding parameters
that are not found in the
user interface when you
create or edit a Video Profile
in AEM.

e Linked related HTL
Community Articles with
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Title Description

the AEM HTL content.

e Expanded Live Copies -

Compositions to cover MSVI

- Stacked Live Copies .

e Improved the

documentation for

Developing and Extending
AEM Workflows, including
the following:

Transient Workflows

Creating Workflow
Models

Extending Workflow
Functionality

REST API Guide for
Workflows

Workflow Step
Reference

Workflow Process
Reference

Community Article This article provides step-by-step

instructions on Integrating

Adobe Experience Manager and

Adobe Campaign Standard to

create newsletters .
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Title Description

IMMERSE IMMERSE is a global virtual
developer conference for AEM.

Our inaugural conference was
held this past April. It was so well
received that Adobe Systems
decided to make this an annual
event with more great content.
Our expanded agenda includes
an exhibit hall, Birds-of-a-feather
round table discussions, and
networking lounges. IMMERSE17
occurs May 15-19, 2017. You can
attend from the comfort of your
office or your home depending

on your location. Learn more..

Share your expertise with the
community. The IMMERSE Call
for Presentations is open. Check
out the requirements and submit
your session here . Presenters
get a free pass and access to all
75 sessions.

Are you actively involved with
the AEM Developer Community?
Does your company want to be
seen as a leading supporter of
the community? Check out our
IMMERSET17 Sponsorship
Prospectus to get involved in

this vibrant community.
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Title Description
Ask the AEM Community November session is "Best
Experts Practices for using Experience

Manager and Adobe Campaign".

Adobe Technical Trainer for
Adobe Worldwide Field
Enablement, Abhishek Dwevedi
provides instructions on using
Adobe Experience Manager and
Adobe Campaign together.

November 29, 2016 08:00-09:00
(Pacific Standard Time).

Session information is here.

AEM GEMS
e "Introduction to AEM

Screens"

AEM Screens is the new
digital signage solution
integrated into Adobe
Experience Manager. In this
AEM Gems session, we will
present the main features of
AEM Screens and how to
set up a simple Project with
a slide show and an
interactive experience. We
then give an overview of
how to develop AEM
Screens optimized
components and how to set
up Channels for offline use.
Finally, we will explore the
AEM Screens REST API and
explain how to integrate
custom Cordova plugins.
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Title Description

You can choose from the
following two sessions to
attend:

e November 16, 2016,
08:00-09:00 (Pacific
Standard Time). Join
Julien Ramboz and
Tobias Reiss for this
live session. RSVP here

for this session .

e November 22, 2016,
14:30-15:30 (India
Standard Time). Join
Julien Ramboz and
Tobias Reiss for this
live session. RSVP here

for this session .

¢ "From unit testing to
integration test of an
Experience Manager
application”

Automated testing is
indispensable for
developing any application.
This AEM GEMS
presentation walks you
through various tools that
you can use to test Java
code starting with the
basics of unit testing up to
functional and integration
testing. Learn how to add
tests in the most effective
way to your code base,
regardless of whether you
want to test a simple utility
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Recent on-demand technical
training

Release Notes - November 2016

Description

method, some OSGi service,
or an HTTP endpoint.

December 14, 2016, 08:00-
09:00 (Pacific Standard
Time). Join Carsten Ziegeler
(Project Lead, Software
Development), and Robert
Munteanu (Senior
Developer) for this live
session. RSVP here for this

session .

"Best Practices for
Experience Manager and
AEM Assets"

Adobe Technical Trainer for
Adobe Worldwide Field
Enablement, Abhishek
Dwevedi, discusses using
AEM Assets. Watch this pre-
recorded session to learn
best practices for using
assets in Experience
Manager.

Replay Adobe Connect

version .

Replay MP4 version .

"Configuring the DAM for
Enterprise"

This session is designed to
help you improve success
in leveraging AEM Assets.
The session focuses on the
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Title Description

use cases of real DAM
Enterprise customers, their
challenges, and the
solutions that were created
to support them and
increase the success they
see with DAM.

Topics discussed during the
session include the
following;:

e Enterprise customer
business challenges
such as large scale
ingestion, desktop app,
performance tuning
and sizing.

¢ Information about
feature improvements
that support the
Enterprise customer,
customer use cases
aligned to business
challenges, and
product roadmap.

By viewing this session you
will better understand how
to use DAM in your
environments. Through
seeing case studies from
real customers, and
attendees working with an
existing DAM, you will
understand how the new
solutions provided through
this offering can help your
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Title Description

existing workflows and
understanding of the
technology.

Replay Adobe Connect

version .

Replay MP4 version .

¢ "Comparative architecture
analysis of large scale
Experience Manager
installations”

This session covers large
scale architectures from the
presenter's experience with
Cisco and Symantec. They
compare and contrast the
architecture across
infrastructure architecture
scaling, Ecommerce
integrations, and migration
approach from legacy into
Adobe Experience Manager,
Digital Marketing Cloud
Integrations such as
personalization, analytics,
and DMP.

Replay Adobe Connect

version .

Replay MP4 version .

Advertising Cloud
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Feature Description

Search Bulksheets (Google AdWords) New bulksheet columns are
available for mobile app install ads: &nbsp;"Mobile
App Platform, "Mobile App ID," "Mobile App Name,"
and "Exclude Tablet."

If the advertiser uses the EF Redirect, then you can
optionally add tracking code to the ad URLs when
you upload or post a bulksheet. The portfolio
setting to "Auto-upload during sync" setting is also
applicable for ads in a portfolio. Tracking settings
are based on the mobile measurement partner
specified for the advertiser.

Search Campaigns Beta You can now manage settings for Yahoo! Japan ad
groups.

You also can configure negative websites for
Google AdWords and Yahoo Gemini campaigns
and Google ad groups.

Display Managed Campaigns Facebook deprecated Facebook Exchange (FBX) on
1 November 2016, and your existing FBX ads no
longer run. Any FBX creatives and ad strategies you
previously created remain paused in Advertising
Cloud for reporting purposes. You can delete them,
but you can't activate them nor edit them, nor
create new FBX creatives or ad strategies.

Dayparting All users can now set up dayparting for any ad
strategy. You must turn on the Daypart Scheduling
feature, available in the ad strategy Targeting
section, to activate a schedule.
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Feature Description

Display Audience For each segment list, you can now see the total
addressable audience (expected audience size) for
each segment, in addition to the number of unique

visitors for specific time increments.

Social Feed Console Beta You can now upload product feed files to an
existing FTP account from Social &gt; Feed Console
Beta.

Reports The Ad Variation Report has new fields applicable
to Google extended text ads: &nbsp;the default
"Description Line 2," optional "Display Path 1," and
optional "Display Path 2."

General You can now access the Advertising Cloud
Community forum from ? &gt; Community at the
top of any page.

More details are available in the product at ? > Help Contents.

Documentation Updates

Item Description Date Published / Last Updated
Administrative Changes - Fall The Fall 2016 release of Adobe October 20, 2016
2016 Analytics includes several

updates groups and permission
management. Please review the
following information.
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Item

Fall 2016 - What's New in
Analysis Workspace

Marketing Cloud Triggers

Adobe Experience Manager 6.2

Release Notes - November 2016

Description

New features include:

¢ Fallout Analysis in Analysis
Workspace

e Flow Visualization in

Analysis Workspace

* Intelligent Alerts in Analysis
Workspace

¢ Anomaly Detection and
Contribution Analysis in
Analysis Workspace

e Starter Projects in Analysis
Workspace

¢ Histogram Visualization in
Analysis Workspace

Identify, define, and monitor key
consumer behaviors, and then
generate cross-solution
communication to re-engage
visitors.

Adobe Experience Manager 6.2
is an upgrade release to the code
base of Adobe Experience
Manager 6.1. It provides new and
enhanced functionality, key
customer fixes, high priority
customer enhancements and
general bug fixes oriented
toward product stabilization. It
also includes Adobe Experience
Manager 6.1 feature pack, hot fix,
and service pack releases.

Date Published / Last Updated

October 20, 2016

September 15, 2016

May 19, 2016
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Item

Getting Started with Analytics

Marketing Cloud Integrations

Activity Map

Marketing Cloud Audiences in
Analytics

Analytics Product Comparison

Marketing Cloud Assets

Release Notes - November 2016

Description

A getting started guide for new May 15, 2016
Analytics administrators,
including implementation for

first-time users.

A round-up of available May 15, 2016

integration topics.

Activity Map product April 14,2016

documentation.

With the Marketing Cloud
Audiences for Analytics

April 14,2016

integration in place, you can
incorporate Marketing Cloud
audience data such as
demographic information (e.g.
gender or income level),
psychographic information (e.g.
interests and hobbies), CRM
data, and ad impression data
into any Analytics workflow.

Added a product comparison February 18, 2016

table for Analytics products.

In Marketing Cloud Assets, you February 11, 2016
can store, share, and synchronize

your digital assets from one

central location. Marketing

Cloud Assets leverages some of

the features available in Adobe

Experience Manager (AEM).
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Item

Analysis Workspace features

(Updated) Users and Groups

Analysis Workspace

Timestamps Optional

Release Notes - November 2016

Description

Added documentation for new
features in Analysis Workspace.

Analytics Administrators: If you
are an administrator in the
Marketing Cloud, see Users and
Groups for updated information
about mapping Analytics groups
to broader Adobe groups, and
adding or bulk-adding users via
the Enterprise Dashboard .

Updated Analysis Workspace
product documentation with
feature descriptions, tasks for
creating projects, videos, and use
cases.

Added product documentation
and best practices for
Timestamps Optional. This
feature lets you integrate both
timestamped and non-
timestamped data in a report
suite. All new report suites will
be Timestamps Optional by
default.

Date Published / Last Updated

January 21,2016

September 17, 2015

September 17,2015

September 17, 2015
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Item Description Date Published / Last Updated

Data Workbench 6.5 Update See Data Workbench 6.5 release September 17,2015
notes for instructions to upgrade
and a list of new features and
bug fixes, including a new
Associations table and chord
diagram and updates to
visualizations, user interface,
algorithms, and export features.

Select Report Suites and Updated the Classification Rule August 20, 2015

Variables Builder so that you add report
suites and variables to a rule set
when editing an existing rule set
(after creating the rule set).
Previously, you specified the
variable and report suite while
creating the rule set. This change
prevents reported issues
occurring with classification
variables.

Profile Link Profile Link works with cross- August 20, 2015
device data sources to identify
and collect traits for
authenticated site visitors. It
includes the Profile Merge Rules
feature, which lets you segment
and target users accurately
across multiple devices.

New Calculated Metric Builder Calculated Metrics now allow for  June 18, 2015
and Calculated Metric Manager segmented metrics, more

advanced math and the ability to

organize and share metrics.
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Item

Analysis Workspace (public
beta)

Data Workbench 6.4

Adobe Managed Certificate
Program

Mobile

Enabling Your Solutions for Core
Services

Customer Attributes

Release Notes - November 2016

Description

Build data tables and drag-and-
drop metrics, dimensions,
segments, and multiple
visualizations to a project panel.

Data Workbench 6.4 release
includes several new features
described here.

Added Adobe Managed
Certificate Program to the
revamped First-Party Cookies
product documentation.

The managed certificate
program lets you implement a
new first-party SSL certificate for
first-party cookies at no
additional cost.

Revamped the Adobe Mobile
product documentation.

A high-level round-up what you
need to do to modernize your
solution implementations for
core services.

If you capture enterprise
customer data in a customer
relationship management (CRM)
database, you can upload that
data into the Marketing Cloud.

Date Published / Last Updated

June 18, 2015

June 18, 2015

May 22, 2015

May 22, 2015

March 19, 2015

March 19, 2015
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Item

Analytics Spring Release

Analytics Classification Rules -
overwrite existing values

Release Notes - November 2016

Description

See the New Features section in March 19, 2015
Analytics for a round-up of new
documentation for the Spring

2015 Analytics release.

In Admin Tools > Classification February 19, 2015
Rule Builder > &lt;rule set

nameé&gt; , two new options

enable you to select an

overwrite mode:

¢ Rules overwrite any
existing values: (Default
setting) Always overwrite
existing classification keys,
including classifications
uploaded via the importer
(SAINT).

¢ Rules overwrite only unset
values: Only fill in blank
(unset) cells. Existing
classifications will not be
changed.

Previously, if a key was already
classified in any column or cell,
the rule would not run on that
key, and the row in the table was
skipped.
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